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CHAPTER 1: EMS Web App Installation Guide
The EMS Web App is a browser-based interface to EMS that helps you to find and book an available
workspace as well as schedule and managemeetings, events, services, and more.

With theWeb App (formerly known as Virtual EMS or VEMS), you can empower your employees to self-
serve for specific meeting or work spaces or give them the ability to request reservations for managed
spaces.

Concept: EMS Web App also runs on a mobile device such as a tablet or handheld
device
Due to the smaller screen size and resolution of tablets and smartphones, pages might display differently,
but most of the same functionality is still available.

EMS Mobile App, by contrast, is an app designed specifically for smartphones. It offers functionality
specifically for everyday users who need access to EMS while they're on the go. The EMS Mobile App also
runs on tablets that run iOS or Android, but the screen layout is optimized for smartphones and does not
take advantage of larger displays.

This guide provides information about the following topics:

l Introduction

l System Architecture

l Requirements and Prerequisites

l Obtain the Installation Files

l Install or Upgrade to the EMS Web App

o Upgrade Considerations

l Optional EMS Web App Features

l EMS MobileWeb Application

l Launch EMS Web App

l Windows Server 2008/2008 R2Web Server Setup Guide

o Best Practices: Setting Up YourWeb Server 2008 or 2008R2

o Install .NET Framework

o Install Internet Information Services (IIS)

n Add Role Services
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l Windows Server 2012/2012 R2Web Server Setup Guide

o Best Practices: Setting Up YourWeb Server 2012 or 2012R2

o Install .NET Framework

o Install Internet Information Services (IIS)

n Add Role Services

l VPAT for EMS Web App

Contact Customer Support

l Option 1 (Recommended): Search the Knowledge Base available at Accruent Access.

l Option 2: Submit a case directly via Accruent Access.

l Option 3: Email emssupport@accruent.com.

l Option 4: Phone (800) 288-4565.

Important!
If you do not have a customer login, register here.
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CHAPTER 2: EMS Web App (V44.1) Introduction
This topic will cover the following areas:

l Introduction to the EMS Web App

l Installation Requirements

l Upgrade Considerations

l Contact Customer Support

Introduction to the EMS Web App
The EMS Web App is a browser-based interface to EMS that helps you to find and book an available
workspace as well as schedule and managemeetings, events, services, and more.

With theWeb App (formerly known as Virtual EMS), you can empower your employees to self-serve for
specific meeting or work spaces or give them the ability to request reservations for managed spaces.

Concept: EMS Web App also runs on a mobile device such as a tablet or handheld
device
Due to the smaller screen size and resolution of tablets and smartphones, pages might display differently,
but most of the same functionality is still available.

EMS Mobile App, by contrast, is an app designed specifically for smartphones. It offers functionality
specifically for everyday users who need access to EMS while they're on the go. The EMS Mobile App also
runs on tablets that run iOS or Android, but the screen layout is optimized for smartphones and does not
take advantage of larger displays.

Installation Requirements
Before beginning the installation process, please install or upgrade your EMS databases as outlined in the
EMS Web App Installation Instructions.

Installation will prompt you to enter a web server. Special setup guides are available for Windows
2008/2008 R2Web Server and Windows 2012/2012 R2Web Server.

Existing versions of EMS Web App must bemanually uninstalled. Pleasemake sure to copy-off and save
any files that have been customized.

Please review the System Requirements for V44.1 here.

Upgrade Considerations
If you have deployed an older version of EMS Web App and are upgrading to the newest version, please
encourage users at your facility to reviewWhat's New before they begin working with the new version of
the software. Doing so will streamline the adoption of the new release and help your users benefit from
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new features and functions that they might not otherwise discover. Please see Upgrade Considerations for
more information.

Contact Customer Support

l Option 1 (Recommended): Search the Knowledge Base available at Accruent Access.

l Option 2: Submit a case directly via Accruent Access.

l Option 3: Email emssupport@accruent.com.

l Option 4: Phone (800) 288-4565.

Important!
If you do not have a customer login, register here.
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CHAPTER 3: System Architecture
EMS Web App is one of the Everyday User Applications that is controlled by configurations in EMS Desktop
Client.

The EMS Desktop Client is the foundation for a broad range of components, services, web applications,
APIs, add-ons, and integrations.

The diagram below shows how EMS Everyday Applications interact with EMS Desktop Clients, your web
and database servers, and Microsoft® Exchange.

Accruent Confidential and Proprietary © 2019 Page | 5

CHAPTER 3: System Architecture



Accruent Confidential and Proprietary © 2019 Page | 6

CHAPTER 3: System Architecture



CHAPTER 4: Prerequisites and Requirements

Important!
Existing versions of EMS Web App must bemanually uninstalled. Please make sure to
copy-off and save any files that have been customized.

The following information is necessary to successfully install the EMS Web App:

l Prerequisites

l EMS Database Server Requirements

l EMS Web Server Requirements

l EMS Web App Requirements

l EMS Web App (Mobile) Requirements

Prerequisites

Important!
Beginning with Update 31, EMS Platform Services is a prerequisite for installing and
using the EMS Web App. If EMS Platform Services has not yet been installed in your
environment, validate the hardware and software requirements for EMS Platform
Services.

If your organization uses the EMS Mobile App, EMS Kiosk App, Google Integration,
EMS for Outlook, or SAML authentication, then EMS Platform Services is already
running in your environment.

1. Before beginning the installation process, please install or upgrade your EMS databases as outlined in
the EMS Web App (V44.1) Installation Guide.

2. Installation will prompt you to enter a web server. Special setup guides are available for Windows
Server 2008/2008 R2Web Server Setup Guide and Windows Server 2012/2012 R2Web Server Setup
Guide.  

3. If using Update 31 or above, install EMS Platform Services and connect EMS Web App to
EMS Platform Services.
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EMS Database Server Requirements

Compatibility Level Version DB Compatibility

110 Microsoft SQL Server 2012 = 11.00.XXXX 110

120 Microsoft SQL Server 2014 = 12.00.XXXX 110 (avoid CL for 2014)

130 Microsoft SQL Server 2016 = 13.00.XXXX 130

Important!
2017 is not yet officially supported by EMS Software.

EMS Web Server Requirements

Operating System IIS VERSION

Windows Server 2016 10.0

Windows Server 2012 8.0

Windows Server 2012 R2 8.5

Windows Server 2016

Prerequisites

Application Pool Running  (2.0 or 4.0 depending on the EMS Software Application)

.NET Framework 4.6.1**

Minimum System Requirements

Processor: 2.0 GHz and 4 cores or faster
Memory: 8 GB or more**
Hard-Disk Space: 1 GB or more

*For up to 100 concurrent users. Increased specs required for 100+ concurrent users.

*Requires an update to Windows Management Framework to version 3.
**= varies per EMS Software Application
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EMS Web App Requirements 

Desktop Browser

Introduction to EMS for Outlook (please see Note below)

Microsoft Edge (latest)

Microsoft Internet Explorer (IE11)

Firefox (latest)

Chrome (latest)

Safari (Mac) (latest)

*= varies per application.

Note:
EMS Web App V44.1 has been optimized for Internet Explorer 11 and does not require
compatibility with previous versions of Internet Explorer.  EMS recommends disabling
compatibility modewhen using EMS Web App V44.1.

EMS Web App V44.1 no longer supports Internet Explorer 10 or older.

EMS Web App (Mobile)

Mobile Browser Platform

Internet Explorer for Mobile 8.1 Windows

Internet Explorer for Mobile 10 Windows

Chrome Android 4.4, 6.0, 7.0, 7.1 

iOS 9.x, iOS 10.x

Safari iOS 9.x, iOS 10.x
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CHAPTER 5: Obtain the Installation Files
The latest release of EMS Web App can be downloaded from the online Support Center.

1. Log into Accruent Access.

2. ClickMy Products.

3. Under EMS, click Downloads.

The downloads page opens in a new browser tab.

4. In the Software Downloads area, click the link for your version of software, for example, V44.1
Releases & Patches.

A new page opens listing the downloads available based on your license.
5. Download EMSWebApplication.msi. (Required for both first time installations and upgrades.) 
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CHAPTER 6: Install or Upgrade the EMS Web App
To install or upgrade the EMS Web App

1. Manually uninstall any previous versions of VEMS or EMS Web App on your web server. 

2. Verify that Requirements and Prerequisites have been met.

Important!
Beginning with Update 31, EMS Platform Services is a prerequisite for installing
and using the EMS Web App. If EMS Platform Services has not yet been installed
in your environment, validate the hardware and software requirements for
EMS Platform Services.

If your organization uses the EMS Mobile App, EMS Kiosk App, Google
Integration, EMS for Outlook, or SAML authentication, then EMS Platform
Services is already running in your environment.

3. Download the EMSWebApplication.msi file onto the web server that will be running EMS Web App.

4. Run EMSWebApplication.msi.

5. The first screen welcomes you to the EMS Web App Setup Wizard. Click Next to begin the installation
process.
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6. In the Destination Folder screen, select the destination folder.
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The installation process will create a new physical directory on your web server based on the
destination folder path you entered. Click Next.

Note:
Choosing a folder above other than the default will create a new physical
directory on your web server at that location. If your organization uses Internet
Information Services (IIS), make sure that the user account used for IIS
(IUSR and/or IIS_IUSRS) has access to this new installation directory. To learn
more, seeWindows Server 2008/2008 R2Web Server Setup Guide or Windows
Server 2012/2012 R2Web Server Setup Guide.

Note:
EMS Web App should not be installed in the same physical directory as other EMS
web-based products OR under a site running another version of VEMS or
EMS Web App.

7. In the SQL Server and database information screen that appears, enter your SQL Instance Name and
your Database Name and click Next.
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Note:
The database name is typically “EMS.”

8. In the Virtual Directory information screen that appears, the Virtual Directory Namewill default to the
destination folder you specified (in Step 6 above). It is recommended that you keep the default
setting. The installation process will create a virtual directory on your web server based on the virtual
directory entered (“EmsWebApp” in the example above). Click Next.

Note:
EMS Web App should not be installed in the same virtual directory as other EMS
web-based products OR under a site running another version of EMS Web App.

9. On the Ready to install EMS Web Application screen that appears, click Install.
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10. On the Completed the EMS Web App Setup Wizard screen that appears, click Finish.

11. EMS Platform Services is required for Update 31 or later; ensure that EMS Web App is connected to
EMS Platform Services as follows:

a. Navigate to the EMS Platform Services Admin Portal. 

b. Select Integrations. Under Clients, click on the EMS Web App link.

c. Click the Reset Secret button and copy the generated Secret.

d. In the web.config file located in the designated folder for your current version of EMS, insert the
copied Secret ID into the value field. 

<add key="platformServicesSecret" value="YourSecretID" />

Important!
EMS Cloud Services customers do not need to generate a Secret or insert it
into the web.config file (Steps c and d).

e. Clear the cache in EMS Platform Services. 

f. In the EMS Desktop Client, navigate to System Administration > Settings > Parameters
> Everyday User Applications. Configure the Platform Services API URL parameter and then
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click Close.

Everyday User Applications Tab, Platform Services API URL
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CHAPTER 7: Upgrade Considerations
When planning to upgrade from previous versions of VEMS to the new EMS Web App, you should take the
new features, functionality, and default settings into consideration. Please encourage users at your facility
to reviewWhat's New before they begin working with the new version of the software. Doing so will
streamline the adoption of the new release and help your users benefit from new features and functions
that they might not otherwise discover.

This topic provides information on the following:

l Time Zone Settings

l Best Practices

l Configuration and Parameter Settings

l Web Menus

l Functional Changes

l Help Text Records

l CSS (Style) Settings

l Language Translation

l All Other Customizations

Time Zone Settings
Web Users should be assigned to a time zone for an optimal experience.

Best Practices
Display settings and other environmental factors greatly affect the performance of EMS Floorplan. For an
optimal floorplan experience, please follow these Best Practices. 

Configuration and Parameter Settings

l Due to a change in product naming, you will need to update the name of the Exchange Integration
Web Service URL parameter. See Also: EMS Web App System Parameters.

l For an optimal user-interface experience, we recommend keeping text-based fields and notes
(e.g., Room Descriptions, Process Template Descriptions, Event Names, etc.) as brief as possible.
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l Newparameters have been introduced:

o For organizations who direct everyday users to manually create their own accounts:

n Sign Up Confirmation Email

n Sign Up Success Email

n Request Received Email

n Password Reset Email

n Password Reset Success Email

o Default Home Page of Site Home or My Home (My Home is the default).

o Show Infographics on My Home (No is the default).

o Default Cancel Reason

l Some parameters have been updated:

o Default Account Status for Newly-Created User (formerly Security Status for User) - Options
are Active or Pending. Inactive option has been removed.

o Browse Events - Display Format - Reduced to Daily, Weekly, and Monthly options.

o Setup Type Validation Rule - No longer affects room searching. Will still handle Setup
Type display and validating attendance against capacties.

o AllowAccess to System Check Pages from Any Machine? - No longer applies to EMS Web App
as SystemCheck.aspx has been removed for this application.

o Default Value for Attendance - Default is now "1." Existing configurations of this parameter for
any value other than "0" will not be affected upon upgrade.

l Some parameters have been removed for V44.1:

o Note Label on Account Management - Field is no longer exposed to the everyday user.

o Number of Hours to Show on Browse for Space - No longer applicable.

o Maximum Number of Events/Day to Display - No longer applicable. Maximums now set per
view (Daily, Weekly, or Monthly).

o Secondary Event Sort (After Date/Time) - No longer applicable. All columns are sortable.

o Devices to redirect to mobile site - No longer applicable as EMS Web App is nowmobile-respons-
ive.

o Display Areas as Filter - Areas are incorporated into Locations for searching.

o AllowUser to Change Setup Count in Selected Locations Area - Permanently enabled as part of
the newUX design.
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Web Menus

l All custom menus should be reviewed and updated/removed prior to updating in a live envir-
onment.

l Custom menus can be parented under the Links or Help icon (for organization-specific help pages).
Upgrading will re-parent all custom menus under Links.

l Process templates can be sequenced under Create a Reservation menu but can no longer bemoved
to different menus.

l Due to the newUI design, system-generated menus cannot be re-sequenced or relabeled, and you
cannot modify their URLs.

Functional Changes
The following changes will show in your new installation due to the newUI design:

l The EMS Web App has been mademobile-responsive. Therefore, mobile-specific pages such
as MobileLogin.aspx have been removed. Everyday users can instead access mobile-responsive ver-
sions of the same pages used when accessing the EMS Web App on a desktop machine.

l New Validated checkbox for everyday users:

o Only applies to manual authentication creation and approval process, but checkbox appears
for all users regardless.

o Will be automatically selected for new users created in the EMS desktop client and via EMS
Human Resources Toolkit.

o New EMS Human Resources Toolkit installations will have the Validated checkbox included in
update logic.

l For tighter security, the SystemCheck.aspx page and the Ctrl+Shift+U keystroke shortcut to
access SystemCheck.aspx have been removed for the EMS Web App. Some information previously
included on SystemCheck.aspx has been relocated to options within the Web Administrator menu of
the EMS Web App:

o Clear Cache option

o License information

o Server and database connection string

o Error Log Files

o Application version and information (relocated to the About page)

l Services, video conferencing, and reservation management will not be available on themobile ver-
sion of the EMS Web App nor on the EMS Mobile App.
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l Template personalization will be automatically enabled for all process templates, which means that
users will be able to set favorite templates to streamline navigation during the booking process.
Favorite templates, for example, will be listed in a drop-down list when the user begins booking
space.

Help Text Records

l All help text records should be reviewed and updated/removed prior to updating in a live envir-
onment.

l Home page web text records will now belong under Site Home and can differ for unauthenticated
users vs. authenticated users.  

l For organizations who direct everyday users to manually create their own accounts, a new text
record for Terms of Use has been introduced.

l Some help text records have been removed (listed alphabetically by the database
value LookupKey for tblWebText):

o MenuItem

o VEMSAccountManagementHelp

o VEMSAddBookingHelpPopup

o VEMS_BadBrowserHelp

o VEMSBillingReferenceLookupHelp

o VEMSClassicRequestPopup

o VEMSEditAccountHelp

o VEMSEditBookingHelpPopup

o VEMSGroupLookupOnPage

o VEMSLdapConfigurationHelp

o VEMSLoginHelp

o VEMSLoginPageMainContent

o VEMSLogoutPageMainContent

o VEMSLogoutScreenMessage

o VEMSMissingOrInvalidExpectedQuerystring

o VEMSPONumberLookupHelp

o VEMSReservationDetailsHelp

o VEMSReservationRecurrenceHelp
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o VEMSReservationSummaryCheckInSuccess

o VEMSReservationSummaryCheckInUnavailable

o VEMSRoomRequestHelpPopup

o VEMSUDFDetailsHelp

o VEMSUserPersonalizationHelp

l Application title help record only applies to Default.aspx (HTML not recommended for this page).

CSS (Style) Settings

l All custom CSS should be reviewed and updated/removed prior to upgrading in a live envir-
onment.

l Custom.CSS now saved under EMSWebApp/Content/Custom/Custom.CSS instead of
the Styles folder.

Language Translation

l Language translation is still supported, but administrators should review the new site design to apply
new translations where necessary.

All Other Customizations

l Any custom logos, custom JavaScript, and all other customizations should be reviewed and
updated/removed prior to updating in a live environment.
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CHAPTER 8: Optional EMS Web App Features
If you currently do not own one of optional, separately-licensed modules outlined below, but are
interested in more information, please contact your Account Executive.

Integrated Authentication
The Integrated Authentication module is a component for EMS Web App that provides single-sign-on
capability using Integrated Windows Authentication, your organization’s portal or LDAP. See Also: EMS
Authentication Methods.

Integration to Microsoft® Exchange
Integration with Exchange is a component for EMS Web App that integrates with Exchange. With this
module, web users can view the availability of both meeting rooms and attendees, and send Outlook-
compatible meeting invitations—all from within EMS Web App. See Also: Integration to Microsoft Exchange
for installation instructions.

Floor Plans
EMS Floor Plans allows web users to search for, view, and reserve available space from an interactive floor
plan within EMS Web App. Floor plans and associated available/unavailable indicator images are configured
in the EMS Desktop Client. See Also: Floor Plans Module Installation Instructions.
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CHAPTER 9: EMS Mobile Web Application
The EMS Web App also runs on a mobile device such as a tablet or handheld. Due to the smaller screen size
and resolution of tablets and smartphones, pages might display differently but most of the same
functionality is still available.

EMS Mobile App, by contrast, is an app designed specifically for smartphones. It offers functionality
specifically for everyday users who need access to EMS while they're on the go. The EMS Mobile App also
runs on tablets that run iOS or Android, but the screen layout is optimized for smartphones and does not
take advantage of larger displays.

See Also: Web App Installation Guide and Web App Configuration Guide.
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CHAPTER 10: Launch EMS Web App
1. After obtaining the latest version of EMS Web App, verify your installation by opening a browser and

entering the EMS Web App address:

http://[ServerName]/WebApp/

(replace [ServerName]with the name of your web server)

The format above assumes you used the default values at installation.

2. The first time you launch EMS Web App, it might take a few extra moments for the website to display.
If you encounter any issues, please contact Customer Support for assistance.

3. For information on how to configure EMS Web App, please refer to EMS Desktop Client Configuration
Guide.
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CHAPTER 11: Windows Server 2008/2008 R2 Web Server Setup
Guide
Follow this guide to install EMS on a newweb server, to support EMS web applications such as EMS Web
App, VEMS, EMS for Outlook, and EMS Mobile App.

l Best Practices: Setting Up YourWeb Server 2008 or 2008 R2

l Install .NET Framework 2008

l Install Internet Information Services (IIS)

o Add Role Services
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CHAPTER 12: Best Practices: Setting Up Your Web Server 2008 or
2008 R2
This section guides you in best practices in setting up aWeb Server for installation of EMS web-based
products and is intended for experienced System Administrators.  Please be aware that we can only provide
instructions for modifying your web server as tested in our facilities, and cannot guarantee results for your
configuration. Lastly, after completing thesemodifications, you will need to perform your own adjustments
to system security etc. 

For information on Web Server 2012, see Best Practices: Setting Up YourWeb Server 2012 or 2012 R2.

Note:
Before beginning the installation process, please review EMS System
Requirements before proceeding. Theminimum hardware requirements must bemet
to continue with the configuration below. Administrative rights will be necessary to
enable the roles and features listed for each Windows Server. 

This topic provides information on the following: 

l To Install .NET Framework 3.5

l To Install .NET Framework 4.5: Regics Only

l To Install Internet Information Services (IIS)

o To Add Role Services

To Install .NET Framework 3.5

1. Navigate to Start > All Programs > Administrative Tools > Server Manager.

2. In the Server Manager interface, click Features to view all the installed Features in the right pane.

3. In the Server Manager interface, select Add Features to lists possible features.

4. In the Select Features interface, expand .NET Framework 3.5.1 Features.

5. Once expanded, select .NET Framework 3.5.1 and click Next.

6. In the Confirm Installation Selections interface, review the selections, then click Install.

7. Once the installation process completes, click Close.
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To Install .NET Framework 4.5: Regics Only
Windows Server 2008/2008 R2 does not have a built-in option to install .NET Framework 4.5. In order to
install .NET Framework 4.5, the Server Administrator will need to download the following redistributable to
the server and install it following the instructions.

Microsoft® .NET Framework 4.5

To Install Internet Information Services (IIS) 
To install IIS on aWindows Server 2008, follow the instructions below.

1. Navigate to Start > All Programs > Administrative Tools > Server Manager.

2. In the Server Manager window, scroll down to Roles Summary, and then click Add Roles.

3. Select Web Server (IIS) on the Select Server Roles page. An introductory page will open with links for
further information.

a. TheWeb Server (IIS) role in Windows Server 2012 provides a secure, easy-to-manage, modular
and extensible platform for reliably hosting websites, services, and applications.
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To Add Role Services 
When adding IIS using the Add Roles Wizard, only the default installation is executed, which has a
minimum set of role services. For EMS products, it is necessary to add role services for the programs to
function properly. If role services are added after installing IIS, the Server Administrator will need to
navigate to the Role Services page by following the above directions and then clicking Next.

Select the following IIS Role Services to be installed:

l Common HTTP Features

l Application Development

l Health and Diagnostics

l Security

l Performance

l Management Tools
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Common HTTP Features

1. Static Content – Static Content lets theWeb server publish static Web file formats, such as HTML
pages and image files. Use Static Content to publish files on aWeb server that users can then view
using aWeb browser.

2. Default Document – Default Document lets organizations configure a default file for theWeb server to
return when users do not specify a file in a URL. Default documents make it easier and more con-
venient for users to reach an organizations Web site.

3. Directory Browsing – Directory Browsing lets users see the contents of a directory on aWeb server.
Use Directory Browsing to enable an automatically generated list of all directories and files available in
a directory when users do not specify a file in a URL and default documents are either disabled or not
configured.

4. HTTP Errors – HTTP Errors lets organizations customize the error messages returned to users’
browsers when theWeb server detects a fault condition. Use HTTP errors to give users a better user
experience when they run up against an error message. Consider providing users with an e-mail
address for staff who can help them resolve the error.

Application Development

1. ASP.NET – ASP.NET provides a server side object-oriented programming environment for building
Web sites and Web applications that usemanaged code. ASP.NET is not just a new version of ASP.
ASP.NET provides a robust infrastructure for building Web applications, and it has been completely
re-architected to provide a highly productive programming experience based on the .NET Framework.

2. .NET Extensibility – .NET Extensibility lets managed code developers change, add, and extend Web
server functionality in the request pipeline, the configuration, and the UI. Developers can use the
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familiar ASP.NET extensibility model and rich .NET APIs to build Web Server features that are just as
powerful as those written using the native C++ APIs.

3. ISAPI Extensions – Internet Server Application Programming Interface (ISAPI) Extensions provides
support for dynamicWeb content development using ISAPI extensions. An ISAPI extension runs
when requested, just like any other static HTML file or dynamic ASP file. Since ISAPI applications are
compiled code, they are processed much faster than ASP files or files that call COM+ components.

4. ISAPI Filters – Internet Server Application Programming Interface (ISAPI) Filters provides support for
Web applications that use ISAPI filters. ISAPI filters are files that can extend or change the func-
tionality provided by IIS. An ISAPI filter reviews every request made to theWeb server, until the filter
finds one that it needs to process.

Health and Diagnostics

1. HTTP Logging – HTTP Logging provides logs site activity for this server. When a loggable event (usu-
ally an HTTP transaction) occurs, IIS calls the selected logging module, which then writes to one of the
logs stored in the file system of theWeb server. These logs are kept in addition to those provided by
the operating system.

2. Request Monitoring – Request Monitor provides infrastructure to monitor Web application health
by capturing information about HTTP requests in an IIS worker process. Administrators and
developers can use Request Monitor to understand which HTTP requests are executing in a worker
process when the worker process has become unresponsive or very slow.
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Security

1. Windows Authentication –Windows Authentication is a low cost authentication solution for internal
Web sites. This authentication scheme allows administrators in a Windows domain to take advantage
of the domain infrastructure for authenticating users. Do not useWindows authentication if users
who must be authenticated access an organization's website from behind firewalls and proxy servers.

2. Request Filtering – Request Filtering screens all incoming requests to the server and filters these
requests based on rules set by the administrator. Many malicious attacks share common char-
acteristics, such as very long URLs, or requests for an unusual action. Filtering requests, can attempt
to reduce the impact of these types of attacks.

Performance

3. Static Content Compression – Static Content Compression provides infrastructure to configure HTTP
compression of static content. This provides more efficient use of bandwidth. Unlike dynamic
responses, compressed static responses can be cached without degrading CPU resources.

Accruent Confidential and Proprietary © 2019 Page | 31

CHAPTER 12: Best Practices: Setting Up Your Web Server 2008 or 2008 R2



Management Tools

4. IIS Management Console – IIS Manager provides infrastructure to manage IIS by using a graphical
user interface. IIS Manager can be used to manage a local or remoteWeb server that runs IIS.
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CHAPTER 13: Install .NET Framework 2008

Install .NET Framework 3.5 

1. Navigate to Start > All Programs > Administrative Tools > Server Manager. 

2. In the Server Manager interface, click Features to display all the installed Features in the right pane.

3. In the Server Manager interface, select Add Features to displays a list of possible features.

4. In the Select Features interface, expand .NET Framework 3.5.1 Features.

5. Check the box next to .NET Framework 3.5.1 and click Next.

6. In the Confirm Installation Selections interface, review the selections and then click Install.

7. Allow the installation process to complete and then click Close.

Install .NET Framework 4.5: Regics Only 
Windows Server 2008/2008 R2 does not have a built in way to install .NET Framework 4.5. To install .NET
Framework 4.5, the server admin will need to download the following redistributable to the server and
install it following the instructions.

Download Link: .NET Framework 4.5.
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CHAPTER 14: Install Internet Information Services (IIS)
To install IIS on aWindows Server 2008 follow the instructions below.

1. Navigate to Start > All Programs > Administrative Tools > Server Manager.

2. In the Server Manager window, scroll down to Roles Summary, and then click Add Roles.

3. Select Web Server (IIS) on the Select Server Roles page. An introductory page will open with links for
further information. TheWeb Server (IIS) role in Windows Server 2012 provides a secure, easy-to-
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manage, modular and extensible platform for reliably hosting websites, services, and applications.

See Also: Add Roles
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CHAPTER 15: Add Role Services 
When adding IIS using the Add Roles Wizard, only the default installation is executed, which has a
minimum set of role services. For EMS products, it is necessary to add role services for the programs to
function properly. If role services are added after installing IIS, the Server Administrator will need to
navigate to the Role Services page by following the Install Internet Information Services (IIS) directions and
then clicking Next.

Select the following IIS Role Services to be installed:

l Common HTTP Features

l Application Development

l Health and Diagnostics

l Security

l Performance

l Management Tools

Common HTTP Features

1. Static Content – Static Content lets theWeb server publish static Web file formats, such as HTML
pages and image files. Use Static Content to publish files on aWeb server that users can then view
using aWeb browser.

2. Default Document – Default Document lets organizations configure a default file for theWeb server
to return when users do not specify a file in a URL. Default documents make it easier and more con-
venient for users to reach an organizations Web site.

3. Directory Browsing – Directory Browsing lets users see the contents of a directory on aWeb server.
Use Directory Browsing to enable an automatically generated list of all directories and files available in
a directory when users do not specify a file in a URL and default documents are either disabled or not
configured.

4. HTTP Errors – HTTP Errors lets organizations customize the error messages returned to users’
browsers when theWeb server detects a fault condition. Use HTTP errors to give users a better user
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experience when they run up against an error message. Consider providing users with an e-mail
address for staff who can help them resolve the error.

Application Development

1. ASP.NET – ASP.NET provides a server side object-oriented programming environment for building
Web sites and Web applications that usemanaged code. ASP.NET is not just a new version of ASP.
ASP.NET provides a robust infrastructure for building Web applications, and it has been completely
re-architected to provide a highly productive programming experience based on the .NET Framework.

2. .NET Extensibility – .NET Extensibility lets managed code developers change, add, and extend Web
server functionality in the request pipeline, the configuration, and the UI. Developers can use the
familiar ASP.NET extensibility model and rich .NET APIs to build Web Server features that are just as
powerful as those written using the native C++ APIs.

3. ISAPI Extensions – Internet Server Application Programming Interface (ISAPI) Extensions provides
support for dynamicWeb content development using ISAPI extensions. An ISAPI extension runs
when requested, just like any other static HTML file or dynamic ASP file. Since ISAPI applications are
compiled code, they are processed much faster than ASP files or files that call COM+ components.

4. ISAPI Filters – Internet Server Application Programming Interface (ISAPI) Filters provides support for
Web applications that use ISAPI filters. ISAPI filters are files that can extend or change the func-
tionality provided by IIS. An ISAPI filter reviews every request made to theWeb server, until the filter
finds one that it needs to process.

Health and Diagnostics
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1. HTTP Logging—HTTP Logging provides logs site activity for this server. When a loggable event (usu-
ally an HTTP transaction) occurs, IIS calls the selected logging module, which then writes to one of the
logs stored in the file system of theWeb server. These logs are kept in addition to those provided by
the operating system.

2. Request Monitoring—Request Monitor provides infrastructure to monitor Web application health
by capturing information about HTTP requests in an IIS worker process. Administrators and
developers can use Request Monitor to understand which HTTP requests are executing in a worker
process when the worker process has become unresponsive or very slow.

Security

1. Windows Authentication –Windows Authentication is a low-cost authentication solution for internal
websites. This authentication scheme allows administrators in a Windows domain to take advantage
of the domain infrastructure for authenticating users. Do not useWindows authentication if users
who must be authenticated access an organization's website from behind firewalls and proxy servers.

2. Request Filtering – Request Filtering screens all incoming requests to the server and filters these
requests based on rules set by the administrator. Many malicious attacks share common char-
acteristics, such as very long URLs, or requests for an unusual action. Filtering requests, can attempt
to reduce the impact of these types of attacks.

Performance
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Static Content Compression – Static Content Compression provides infrastructure to configure HTTP
compression of static content. This provides more efficient use of bandwidth. Unlike dynamic responses,
compressed static responses can be cached without degrading CPU resources.

Management Tools

IIS Management Console – IIS Manager provides infrastructure to manage IIS by using a graphical user
interface. IIS Manager can be used to manage a local or remoteWeb server that runs IIS.
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CHAPTER 16: Windows Server 2012/2012 R2 Web Server Setup
Guide
Follow this guide to install EMS on a newweb server, to support EMS web applications such as EMS Web
App, VEMS, EMS for Outlook, and EMS Mobile App.

l Best Practices: Setting Up YourWeb Server 2012 or 2012R2

l Install .NET Framework

l Install Internet Information Services (IIS)

o Add Role Services
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CHAPTER 17: Best Practices: Setting Up Your Web Server 2012 or
2012 R2
This section guides you in best practices in setting up aWeb Server for installation of EMS web-based
products and is intended for experienced System Administrators.  Please be aware that we can only provide
instructions for modifying your web server as tested in our facilities, and cannot guarantee results for your
configuration. Lastly, after completing thesemodifications, you will need to perform your own adjustments
to system security etc.

Note:
Before beginning the installation process, please review EMS System
Requirements before proceeding. Theminimum hardware requirements must bemet
to continue with the configuration below. Administrative rights will be necessary to
enable the roles and features listed for each Windows Server.

This topic provides information on the following: 

l To Install .NET Framework 3.5

l To Install .NET Framework 4.5: Regics Only

l To Install Internet Information Services (IIS)

o To Add Role Services

l Windows Server 2012/2012 R2

o To Add Role Services

To Install .NET Framework 3.5 

1. Navigate to Start > All Programs > Administrative Tools > Server Manager

2. In the Server Manager interface, click Features to view all the installed Features in the right pane.

3. In the Server Manager interface, select Add Features to lists possible features.

4. In the Select Features interface, expand .NET Framework 3.5.1 Features.

5. Once expanded, select .NET Framework 3.5.1 and click Next.
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6. In the Confirm Installation Selections interface, review the selections, then click Install.

7. Once the installation process completes, click Close.

To Install .NET Framework 4.5: Regics Only 
Windows Server 2008/2008 R2 does not have a built-in option to install .NET Framework 4.5. In order to
install .NET Framework 4.5, the Server Administrator will need to download the following redistributable to
the server and install it following the instructions.

See Also: .NET Framework 4.5.

To Install Internet Information Services (IIS) 
To install IIS on aWindows Server 2008, follow the instructions below.

1. Navigate to Start > All Programs > Administrative Tools > Server Manager.

2. In the Server Manager window, scroll down to Roles Summary, and then click Add Roles.

3. Select Web Server (IIS) on the Select Server Roles page. An introductory page will open with links for
further information.

a. TheWeb Server (IIS) role in Windows Server 2012 provides a secure, easy-to-manage, modular
and extensible platform for reliably hosting websites, services, and applications.
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To Add Role Services 
When adding IIS using the Add Roles Wizard, only the default installation is executed, which has a
minimum set of role services. For EMS products, it is necessary to add role services for the programs to
function properly. If role services are added after installing IIS, the Server Administrator will need to
navigate to the Role Services page by following the above directions and then clicking Next.

Select the following IIS Role Services to be installed:

l Common HTTP Features

l Application Development

l Health and Diagnostics

l Security

l Performance

l Management Tools
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Common HTTP Features

1. Static Content—Static Content lets theWeb server publish static Web file formats, such as HTML
pages and image files. Use Static Content to publish files on aWeb server that users can then view
using aWeb browser.

2. Default Document—Default Document lets organizations configure a default file for theWeb server
to return when users do not specify a file in a URL. Default documents make it easier and more con-
venient for users to reach an organizations Web site.

3. HTTP Errors—HTTP Errors lets organizations customize the error messages returned to users’
browsers when theWeb server detects a fault condition. Use HTTP errors to give users a better user
experience when they run up against an error message. Consider providing users with an e-mail
address for staff who can help them resolve the error.

Application Development

1. ASP.NET—ASP.NET provides a server side object-oriented programming environment for building
Web sites and Web applications that usemanaged code. ASP.NET is not just a new version of ASP.
ASP.NET provides a robust infrastructure for building Web applications, and it has been completely
re-architected to provide a highly productive programming experience based on the .NET Framework.

2. .NET Extensibility—.NET Extensibility lets managed code developers change, add, and extend Web
server functionality in the request pipeline, the configuration, and the UI. Developers can use the
familiar ASP.NET extensibility model and rich .NET APIs to build Web Server features that are just as
powerful as those written using the native C++ APIs.

3. ISAPI Extensions—Internet Server Application Programming Interface (ISAPI) Extensions provides
support for dynamicWeb content development using ISAPI extensions. An ISAPI extension runs
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when requested, just like any other static HTML file or dynamic ASP file. Since ISAPI applications are
compiled code, they are processed much faster than ASP files or files that call COM+ components.

4. ISAPI Filters—Internet Server Application Programming Interface (ISAPI) Filters provides support for
Web applications that use ISAPI filters. ISAPI filters are files that can extend or change the func-
tionality provided by IIS. An ISAPI filter reviews every request made to theWeb server, until the filter
finds one that it needs to process.

Health and Diagnostics

1. HTTP Logging—HTTP Logging provides logs site activity for this server. When a loggable event (usu-
ally an HTTP transaction) occurs, IIS calls the selected logging module, which then writes to one of the
logs stored in the file system of theWeb server. These logs are kept in addition to those provided by
the operating system.

2. Request Monitoring—Request Monitor provides infrastructure to monitor Web application health
by capturing information about HTTP requests in an IIS worker process. Administrators and
developers can use Request Monitor to understand which HTTP requests are executing in a worker
process when the worker process has become unresponsive or very slow.

Security
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1. Windows Authentication—Windows Authentication is a low cost authentication solution for internal
Web sites. This authentication scheme allows administrators in a Windows domain to take advantage
of the domain infrastructure for authenticating users. Do not useWindows authentication if users
who must be authenticated access an organization's website from behind firewalls and proxy servers.

2. Request Filtering—Request Filtering screens all incoming requests to the server and filters these
requests based on rules set by the administrator. Many malicious attacks share common char-
acteristics, such as very long URLs, or requests for an unusual action. Filtering requests, can attempt
to reduce the impact of these types of attacks.

Performance

Static Content Compression—Static Content Compression provides infrastructure to configure HTTP
compression of static content. This provides more efficient use of bandwidth. Unlike dynamic responses,
compressed static responses can be cached without degrading CPU resources.

Management Tools

IIS Management Console—IIS Manager provides infrastructure to manage IIS by using a graphical user
interface. IIS Manager can be used to manage a local or remoteWeb server that runs IIS.
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Windows Server 2012/2012 R2 

Important!
Before beginning the installation process, please see our system requirements. The
minimum hardware requirements must bemet to continue with the below
configuration. Administrative rights will be necessary to enable the roles and features
listed for each Windows Server.

1. In Server Manager, click Manage and then select Add Roles and Features to start the Add Roles and
Features Wizard.

2. On the Select installation type screen, select Add roles and Features.

3. Select the target server. The wizard presents a Before you Begin prompt.
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4. Click Next. The wizard advances to the Installation Type prompt.
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5. Select Role-based or feature-based installation.

6. Click Next. The wizard advances you to the Server Selection prompt.

7. Select your server and click Next. The wizard advances you to the Server Roles prompt.
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8. Select Web Server (IIS) and click Next. The wizard advances you to the Features prompt.
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9. Select the .NET Framework Framework 3.5 and .NET Framework 4.5 options. The wizard prompts
you to confirm for each option.

10. Click Next. Repeat this confirmation step for the .NET 4.5 server role. TheWizard advances you to the
Select Role Services prompt.
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11. Select both ASP .NET 3.5 and ASP .NET 4.5 options. The wizard advances you to the Confirmation
Prompt.

12. Review the selections and then click Install.

13. Allow the installation process to complete, review the results that display, and then click Close.

To Install .NET Framework 4.5: Regics Only 

1. Repeat Steps 1-10 from theWindows Server 2012/2012 R2 section.

2. Once expanded, select both the .NET Framework 4.5 and ASP.NET 4.5 options and click Next. 
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3. Review the selections and then click Install.

4. Allow the installation process to complete, review the results that display, and then click Close.

To Add Role Services 
When adding IIS using the Add Roles Wizard, only the default installation is executed, which has a
minimum set of role services. For EMS products, it is necessary to add role services for the programs to
function properly. If role services are added after installing IIS, the Server Administrator will need to
navigate to the Role Services page by following the above directions then clicking Next.

Select the following IIS Role Services to be installed:

l Common HTTP Features

l Application Development

l Health and Diagnostics

l Security

l Performance

l Management Tools
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Common HTTP Features

1. Static Content – Static Content lets theWeb server publish static Web file formats, such as HTML
pages and image files. Use Static Content to publish files on aWeb server that users can then view
using aWeb browser.

2. Default Document – Default Document lets organizations configure a default file for theWeb server
to return when users do not specify a file in a URL. Default documents make it easier and more con-
venient for users to reach an organizations Web site.

3. Directory Browsing – Directory Browsing lets users see the contents of a directory on aWeb server.
Use Directory Browsing to enable an automatically generated list of all directories and files available in
a directory when users do not specify a file in a URL and default documents are either disabled or not
configured.

4. HTTP Errors – HTTP Errors lets organizations customize the error messages returned to users’
browsers when theWeb server detects a fault condition. Use HTTP errors to give users a better user
experience when they run up against an error message. Consider providing users with an e-mail
address for staff who can help them resolve the error.

Application Development

1. ASP.NET – ASP.NET provides a server side object-oriented programming environment for building
Web sites and Web applications that usemanaged code. ASP.NET is not just a new version of ASP.
ASP.NET provides a robust infrastructure for building Web applications, and it has been completely
re-architected to provide a highly productive programming experience based on the .NET Framework.

2. .NET Extensibility – .NET Extensibility lets managed code developers change, add, and extend Web
server functionality in the request pipeline, the configuration, and the UI. Developers can use the
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familiar ASP.NET extensibility model and rich .NET APIs to build Web Server features that are just as
powerful as those written using the native C++ APIs.

3. ISAPI Extensions – Internet Server Application Programming Interface (ISAPI) Extensions provides
support for dynamicWeb content development using ISAPI extensions. An ISAPI extension runs
when requested, just like any other static HTML file or dynamic ASP file. Since ISAPI applications are
compiled code, they are processed much faster than ASP files or files that call COM+ components.

4. ISAPI Filters – Internet Server Application Programming Interface (ISAPI) Filters provides support for
Web applications that use ISAPI filters. ISAPI filters are files that can extend or change the func-
tionality provided by IIS. An ISAPI filter reviews every request made to theWeb server, until the filter
finds one that it needs to process.

Health and Diagnostics

1. HTTP Logging – HTTP Logging provides logs site activity for this server. When a loggable event (usu-
ally an HTTP transaction) occurs, IIS calls the selected logging module, which then writes to one of the
logs stored in the file system of theWeb server. These logs are kept in addition to those provided by
the operating system.

2. Request Monitoring – Request Monitor provides infrastructure to monitor Web application health
by capturing information about HTTP requests in an IIS worker process. Administrators and
developers can use Request Monitor to understand which HTTP requests are executing in a worker
process when the worker process has become unresponsive or very slow.
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Security

1. Windows Authentication –Windows Authentication is a low cost authentication solution for internal
Web sites. This authentication scheme allows administrators in a Windows domain to take advantage
of the domain infrastructure for authenticating users. Do not useWindows authentication if users
who must be authenticated access an organization's website from behind firewalls and proxy servers.

2. Request Filtering – Request Filtering screens all incoming requests to the server and filters these
requests based on rules set by the administrator. Many malicious attacks share common char-
acteristics, such as very long URLs, or requests for an unusual action. Filtering requests, can attempt
to reduce the impact of these types of attacks.

Performance

Static Content Compression—Static Content Compression provides infrastructure to configure HTTP
compression of static content. This provides more efficient use of bandwidth. Unlike dynamic responses,
compressed static responses can be cached without degrading CPU resources.

Accruent Confidential and Proprietary © 2019 Page | 56

CHAPTER 17: Best Practices: Setting Up Your Web Server 2012 or 2012 R2



Management Tools

IIS Management Console—IIS Manager provides infrastructure to manage IIS by using a graphical user
interface. IIS Manager can be used to manage a local or remoteWeb server that runs IIS.
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CHAPTER 18: Install .NET Framework for Windows Server
2012/2012 R2
This topic provides information on the following:

l Install .NET Framework 3.5 and .NET Framework 4.5

l Install .NET Framework 4.5: Regics Only

Install .NET Framework 3.5 and .NET Framework 4.5

1. In Server Manager, clickManage and then select Add Roles and Features to start the Add Roles and
Features Wizard.

2. In the Confirm Installation Selections interface, review the selections and then click Install.

3. Allow the installation process to complete and then click Close.

4. On the Select installation type screen, select Role-based or feature-based installation.

5. Select the target server.

6. On the Select Features screen, check the box next to .Net Framework 3.5 Features.

7. In the Select Features interface, expand .NET Framework 3.5 Features.
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8. Once expanded, there will be three check boxes. One for .NET Framework 3.5 and the other two for
HTTP Activation and Non-HTTP Activation. Check the box next to .NET Framework 3.5 and click Next.

Install .NET Framework 4.5: Regics Only

1. In Server Manager, clickManage and then select Add Roles and Features to start the Add Roles and
Features Wizard.

2. On the Select installation type screen, select Role-based or feature-based installation.

3. Select the target server.

4. On the Select Features screen, check the box next to .Net Framework 4.5 Features.

5. In the Select Features interface, expand .NET Framework 4.5 Features.

6. Once expanded, there will be three check boxes. These will be .NET Framework 4.5, APS.NET 4.5 and
WCF Services. Check the boxes next to .NET Framework 4.5 and ASP.NET 4.5 then click Next.

7. In the Confirm Installation Selections interface, review the selections and then click Install.

8. Allow the installation process to complete and then click Close.
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CHAPTER 19: Install Internet Information Services (IIS)
To install IIS on aWindows Server 2012, do the following: 

1. In Server Manager, click Manage and then select Add Roles and Features to start the Add Roles and
Features Wizard.

2. On the Select installation type screen, select role-based or feature-based installation.

3. Select the target server.

4. On the Select Roles screen, check the box next to Web Server (IIS). TheWeb Server (IIS) role in Win-
dows Server 2012 provides a secure, easy-to-manage, modular and extensible platform for reliably
hosting websites, services, and applications.

5. No additional features are needed for IIS, so click Next.

6. Customize your installation of IIS by verifying the Role Services are selected and then click Next:

7. In the Confirm Installation Selections interface, review the selections and then click Install.

8. Allow the installation process to complete and then click Close.
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CHAPTER 20: Add Role Services
1. In Server Manager, clickManage and then select Add Roles and Features to start the Add Roles and

Features Wizard.

2. On the Select installation type screen, select Role-based or feature-based installation.

3. Select the target server.

4. On the Select Roles screen, expandWeb Server (IIS).

Select the following IIS Role Services to be installed:

l Common HTTP Features

l Application Development

l Health and Diagnostics

l Security

l Performance

l Management Tools

Common HTTP Features

1. Static Content – Static Content lets theWeb server publish static Web file formats, such as HTML
pages and image files. Use Static Content to publish files on aWeb server that users can then view
using aWeb browser.

2. Default Document – Default Document lets organizations configure a default file for theWeb server
to return when users do not specify a file in a URL. Default documents make it easier and more con-
venient for users to reach an organizations Web site.

3. Directory Browsing – Directory Browsing lets users see the contents of a directory on aWeb server.
Use Directory Browsing to enable an automatically generated list of all directories and files available in
a directory when users do not specify a file in a URL and default documents are either disabled or not
configured.

Accruent Confidential and Proprietary © 2019 Page | 61

CHAPTER 20: Add Role Services



4. HTTP Errors – HTTP Errors lets organizations customize the error messages returned to users’
browsers when theWeb server detects a fault condition. Use HTTP errors to give users a better user
experience when they run up against an error message. Consider providing users with an e-mail
address for staff who can help them resolve the error.

Application Development

1. ASP.NET – ASP.NET provides a server side object-oriented programming environment for building
Web sites and Web applications that usemanaged code. ASP.NET is not just a new version of ASP.
ASP.NET provides a robust infrastructure for building Web applications, and it has been completely
re-architected to provide a highly productive programming experience based on the .NET Framework.

2. .NET Extensibility – .NET Extensibility lets managed code developers change, add, and extend Web
server functionality in the request pipeline, the configuration, and the UI. Developers can use the
familiar ASP.NET extensibility model and rich .NET APIs to build Web Server features that are just as
powerful as those written using the native C++ APIs.

3. ISAPI Extensions – Internet Server Application Programming Interface (ISAPI) Extensions provides
support for dynamicWeb content development using ISAPI extensions. An ISAPI extension runs
when requested, just like any other static HTML file or dynamic ASP file. Since ISAPI applications are
compiled code, they are processed much faster than ASP files or files that call COM+ components.

4. ISAPI Filters – Internet Server Application Programming Interface (ISAPI) Filters provides support for
Web applications that use ISAPI filters. ISAPI filters are files that can extend or change the func-
tionality provided by IIS. An ISAPI filter reviews every request made to theWeb server, until the filter
finds one that it needs to process.
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Health and Diagnostics

1. HTTP Logging – HTTP Logging provides logs site activity for this server. When a loggable event (usu-
ally an HTTP transaction) occurs, IIS calls the selected logging module, which then writes to one of the
logs stored in the file system of theWeb server. These logs are kept in addition to those provided by
the operating system.

2. Request Monitoring – Request Monitor provides infrastructure to monitor Web application health
by capturing information about HTTP requests in an IIS worker process. Administrators and
developers can use Request Monitor to understand which HTTP requests are executing in a worker
process when the worker process has become unresponsive or very slow.

Security

1. Windows Authentication –Windows Authentication is a low cost authentication solution for internal
Web sites. This authentication scheme allows administrators in a Windows domain to take advantage
of the domain infrastructure for authenticating users. Do not useWindows authentication if users
who must be authenticated access an organization's website from behind firewalls and proxy servers.

2. Request Filtering – Request Filtering screens all incoming requests to the server and filters these
requests based on rules set by the administrator. Many malicious attacks share common char-
acteristics, such as very long URLs, or requests for an unusual action. Filtering requests, can attempt
to reduce the impact of these types of attacks.
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Performance

Static Content Compression – Static Content Compression provides infrastructure to configure HTTP
compression of static content. This provides more efficient use of bandwidth. Unlike dynamic responses,
compressed static responses can be cached without degrading CPU resources.

Management Tools

IIS Management Console – IIS Manager provides infrastructure to manage IIS by using a graphical user
interface. IIS Manager can be used to manage a local or remoteWeb server that runs IIS.
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CHAPTER 21: Introduction to EMS Integrated Authentication
The EMS Integrated Authentication component provides single-sign-on capability using Integrated
Windows Authentication, your organization’s portal, or LDAP. The Integrated Authentication Setup
Guide lists the steps you must take to configure these Integrated Authentication options. If you are unsure
whether your organization is licensed for Integrated Authentication or you would like to learn more about
it, please contact your Account Executive. 

The diagram below shows how your organizations' existing security software and systems integrate with
EMS software applications through configurations you set in EMS Desktop Client.

Integration Diagram

When configuring integrated authentication using this component, you can use the following methods:

l Integrated Windows Authentication

l Portal or Federated Authentication

l LDAP Authentication
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What is Integrated Windows Authentication?  
Integrated Windows Authentication (IWA) is a built-in Microsoft Internet Information Services (IIS)
authentication protocol that can be used to automatically authenticate and sign-in a user to EMS Web
App. Integrated Windows Authentication works only with Internet Explorer and is best used on intranets
where all clients accessing EMS Web App are within a single domain. When a domain user who is logged on
to a networked PC accesses an EMS Everyday User application, such as EMS Web App, EMS Mobile App, or
EMS for Outlook, their Active Directory credentials (Domain\User ID) are compared against corresponding
Domain\User ID information recorded in the Network ID and\or External Reference fields of your EMS
Everyday User records. If a match exists, the Everyday User will be automatically logged in.

For a more detailed explanation of the authentication methods outlined above, see Integrated Windows
Authentication.

What is Portal or Federated Authentication? 
The Portal Authentication method provides EMS Web App single sign-on capability using your
organization’s portal (e.g., CAS, Shibboleth, SiteMinder, Plumtree, uPortal, etc.). When a user logged into
your portal accesses EMS Web App, a predefined user-specific variable (e.g., email address,
employee/student ID, network ID, etc.) captured by your portal/sign-on page is compared against
corresponding information recorded in the Network ID and/or External Reference fields of your EMS
Everyday User records. If a match exists, the Everyday User will be automatically logged-into EMS Web App.

Note:
The Field Used to Authenticate Everyday User parameter (within System
Administration > Settings > Parameters > Everyday User Applications tab) is used by
EMS Web App to determine which value should be used for authentication.

Several built-in authentication methods to pass-in credentials are available including:

l Server Variable (Header Variable)

l Session

l Form

l Cookie

l Query String

l Federated (SAML)

For a more detailed explanation of the authentication methods outlined above, see Portal Authentication
Methods. 
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What is LDAP Authentication? 
Lightweight Directory Access Protocol (LDAP) is an application protocol for querying directory information.
The LDAP Authentication method provides single-sign-on capability using your organization’s LDAP
environment and can be used in both intranet and internet deployments of EMS Everyday applications
such as EMS Web App and EMS Mobile App. 

The LDAP Authentication topic covers the following information related to LDAP configuration:

l Configure EMS Web App to Use LDAP Authentication

l Configure EMS Web App Security

l Configure Communication Options

l Core Properties

l Non-AD Config

l LDAP Queries

l Save Your Configuration

l Test Your Configuration

l Configure Authentication for EMS Mobile App

When a user logs into EMS Web App or EMS Mobile App with their User ID and Password, their credentials
are authenticated against LDAP and compared against corresponding user information recorded in
the Network ID and/or External Reference fields of your EMS Everyday User records. If a match exists, the
Everyday User will be logged in to the application, inheriting any Everyday User Process Template rights to
which their LDAP Group has been assigned.
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Note:
l The EMS Web App LDAP-Process Template assignment process requires that your

implementation of LDAP stores group information (e.g., staff, student, depart-
ment, etc.) as a Directory Service object containing a property (i.e., member) that
contains the users that belong to your various groups. 

l The Field Used to Authenticate Everyday User parameter (within System Admin-
istration > Settings > Parameters > Everyday User Applications tab) is used by
the applications to determine which value should be used for authentication.

Contact Customer Support

l Option 1 (Recommended): Search the Knowledge Base available at Accruent Access.

l Option 2: Submit a case directly via Accruent Access.

l Option 3: Email emssupport@accruent.com.

l Option 4: Phone (800) 288-4565.

Important!
If you do not have a customer login, register here.

Accruent Confidential and Proprietary © 2019 Page | 68

CHAPTER 21: Introduction to EMS Integrated Authentication

https://access.accruent.com/
https://access.accruent.com/
mailto:emssupport@accruent.com
https://access.accruent.com/s/login/


CHAPTER 22: Integrated Authentication Considerations
When you purchase the Integrated Authentication Service, you are able to use LDAP Integration,
Integrated Authentication (IA), or Portal Authentication. Integrated and Portal Authentications are true
Single Sign-On (SSO) solutions; LDAP is not. Thesemethods are not typically used together. This section
explains how each one works, along with pros and cons for each method.

LDAP Integration
LDAP integration allows you to bypass creating individual web users for your organization. By configuring
EMS to query your LDAP groups, you can use LDAP groups to assign web template permissions. Your users
would just use their windows credentials to login to the site. After creating a web user account (most data is
pre-populated from their LDAP account), they receive the template permissions granted to their LDAP
group.

Pros

l No need to create/maintain individual accounts for web users. Mass assign process templates.

Cons

l Requires LDAP groups to be precisely defined and maintained to ensure proper access. EMS does not
create or update LDAP groups, so product may require assistance from LDAP/Exchange
administrators.

l NOT Single Sign-on: users must enter windows credentials on each visit.

Integrated Authentication
IA is SSO. For this to work, every user must have a web user account created (manually through
client/virtual piece or using our HRToolkit module). In each web account, a network ID is added. When a
user visits VEMS or EMS Web App, a call is made to themachine to retrieve the windows account signed in.
It compares that value to the network ID field in existing accounts, logging in users automatically.
Permissions are assigned to the individual web user accounts.

Pros

l Can be true SSO – the account creation and maintenance can be completely invisible to the end user.
Not reliant on Exchange/LDAP administrators.
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Cons

l Requires active web user creation and maintenance: manually on the client side, manually through
end-user input, or automatically through an HR feed.

Portal Authentication
With Portal Authentication, user information is passed from your existing portal to records in EMS by
cookie, session string or similar. Portal Authentication is true SSO when used with our supported methods.

Note:
When you implement Integrated Authentication, your consultant will assist you with
creating templates and web users during onsite training. If you are adding this module
separately and need assistance with virtual configuration contact your account
manager about purchasing training. This document is intended to explain the different
authentication options available, so you can anticipate any configuration needs. If you
choose LDAP Integration, you will need to create an administrator account and admin
web template to access the configuration page. See the EMS Configuration Guide for
questions with creating that template. Using LDAP with IA or Portal Authentication
requires each user be responsible for creating/verifying their account on the first visit;
SSO isn’t immediate. Portal authentication can be used with LDAP, but this is atypical in
most portal environments since other credentialing is available.
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CHAPTER 23: Integrated Windows Authentication
Integrated Windows Authentication (IWA) is a built-in Microsoft Internet Information Services (IIS)
authentication protocol that can be used to automatically authenticate and sign-in a user to EMS Web App.
Integrated Windows Authentication works only with Internet Explorer and is best used on intranets where
all clients accessing EMS Web App are within a single domain. 

This topic provides information on the following:

l Activate Integrated Windows Authentication for IIS 6.0

l Activate Integrated Windows Authentication for IIS 7.x/8.x

Note:
Integrated Windows Authentication is supported for EMS Floor Plan (V44.1 Update 11).

See Also:

l Integrated Authentication Overview

l For more information, please review the following Microsoft TechNet articles on IWA for IIS 6.0, 7.0,
and 8.0. 

l Connect Your Database Using Active Directory

When a domain user who is logged on to a networked PC accesses an EMS Everyday User application, such
as EMS Web App, EMS Mobile App, or EMS for Outlook, their Active Directory credentials (Domain\User ID)
are compared against corresponding Domain\User ID information recorded in the Network
ID and\or External Reference fields of your EMS Everyday User records. If a match exists, the Everyday User
will be automatically logged in.

Note:
The Field Used to AuthenticateWeb User parameter (within System Administration >
Settings > Parameters > Everyday User Applications tab is used to determine which
value should be used for authentication.

Activate Integrated Windows Authentication for IIS 6.0

1. On the web server that hosts your EMS application's site, open IIS Manager.

2. Locate your EMS application's site.

3. Right-click your EMS application's site and choose Properties. The Properties screen will open.
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4. Go to the Directory Security tab and click the Edit button under the Authentication and access
control section. The Authentication Methods screen will open.

5. Uncheck the Enable anonymous access option. The Integrated Windows authentication option
should be the only option checked.

6. Click OK to exit the Authentication Methods screen. Click OK again to exit the Properties screen. You
have completed the necessary IIS configuration steps for IIS 6.0.
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Activate Integrated Windows Authentication for IIS 7.x/8.x

1. On the web server that hosts your EMS application's site, open IIS Manager.

2. Locate and highlight your EMS application's site. 

3. Double-click the Authentication option in the IIS section.

4. Right-click the Windows Authentication option and select Enable.

5. Right-click the Anonymous Authentication option and select Disable.

6. You have completed the necessary IIS configuration steps for IIS 7.
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CHAPTER 24: Manage Everyday Users For Integrated Authentic-
ation
In order to make a reservation in EMS Everyday User Applications, such as EMS Web App, EMS Mobile App,
and EMS for Outlook, a user must have an active Everyday User account with appropriate security and
process templates. 

In EMS, you can create Everyday User accounts as follows:

l Manually Create Everyday User Accounts

l Automatically Create Everyday User Accounts

l Modify Existing Everyday User Accounts

Manually Create Everyday User Accounts
Everyday User accounts can be created manually by EMS Administrators within EMS Desktop Client or by
anonymous Everyday Users on their respective EMS Everyday Applications. 

To create Everyday User accounts in the EMS Desktop Client, see Configure Everyday Users.

To configure EMS Web App to allow anonymous Everyday Users to request an account, you adjust
parameters. See also: EMS Web App System Parameters.

Important!
When manually creating an Everyday User account in an Integrated Authentication
environment, you must specify a value in the Everyday User Network ID field or
the External Reference field. The Field Used to Authenticate Everyday User parameter
(within System Administration > Settings > Parameters> Everyday User Applications
tab) is used to determine which value should be used for authentication.

Automatically Create Everyday User Accounts 
Various configuration settings are available to automatically create Everyday User records (and assign the
appropriate Security and Process Template(s) if applicable) when a user accesses an EMS Everyday User
Application (such as EMS Web App for the first time. 

EMS Web App Parameters 
Within the Everyday User Applications parameters area of the EMS desktop client (System Administration
> Settings > Parameters> Everyday User Applications tab), the following parameters must be set
accordingly:
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Area Description Value

Account
Management

Auto Create Everyday User Account (for Integrated
Authentication)

Yes

Account
Management

Default Security Template for User Must be
specified

Account
Management

Default Account Status for Newly-Created User Active

Portal/Federated Authentication Parameters
For organizations using Portal or Federated authentication, EMS supports a simple account provisioning
strategy. When using Auto Create, EMS requires that a Everyday User account is provisioned with a name,
an email address and a NetworkId (some authentication key). Otherwise, the user will be redirected to the
Account Management page and be asked to manually enter the required information. In addition to the
required fields, EMS also supports collecting phone, fax, and an external reference value. The parameters
below aremeant to help create a more complete Everyday User. The values for each of the parameters are
to be determined by the information populated by your portal.

Area Description Value

Authentication Portal Authentication Email Variable Must be specified

Authentication Portal Authentication External Reference Variable Must be specified

Authentication Portal Authentication Fax Variable Must be specified

Authentication Portal Authentication Name Variable Must be specified

Authentication Portal Authentication Phone Variable Must be specified

HR Toolkit (for EMS Workplace, EMS Campus, EMS Enterprise, EMS Dis-
trict, and EMS Legal only) 
The HR Toolkit is an optional component that allows you to automate the creation and maintenance of
Everyday User records in EMS using an outside employee data source like your HR system or another data
store within your organization. Please refer to the HR Toolkit Installation Instructions for information. If
you are not licensed for the HR Toolkit, but would like to learn more about it, please contact your Account
Executive.
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Automatic Template Assignment to Users 
The Default Security Template for User parameter shown above is used to automatically assign the correct
Everyday User Security Template to new Everyday User records.

You can automatically assign default Everyday User Process Templates when a new Everyday User account
is created. To automatically assign a Everyday User Process Template to new Everyday Users, select
the Available to New Everyday Users option within your Everyday User Process Template(s) (Configuration
> Everyday User Applications > Everyday User Process Templates (Edit the template > Process
Templates tab)).

EMS customers using the LDAP Authentication method can use an alternatemethod to assign a Everyday
User Process Template to a Everyday User based on the LDAP Group(s) to which the user belongs. This
approach can be used in addition to or in lieu of the Everyday User Process Template assignment approach
discussed above. Please see the LDAP Authentication section for configuration instructions.

Modify Existing Everyday User Accounts 

Important!
EXISTING EMS CUSTOMERS

Before activating any Integrated Authentication option, the Network ID field
or External Reference field must be populated on all existing Everyday User records.
Ignoring this step may result in duplicate Everyday User records.
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CHAPTER 25: Configure EMS Web App to Use LDAP Authentic-
ation

Overview 
Lightweight Directory Access Protocol (LDAP) is an application protocol for querying directory information.
The LDAP Authentication method provides single-sign-on capability using your organization’s LDAP
environment and can be used in both intranet and internet deployments of EMS Everyday applications
such as EMS Web App and EMS Mobile App. 

This topic provides information on the following:

l Configure EMS Web App to Use LDAP Authentication

l Configure EMS Web App Security

l Configure Communication Options

l Core Properties

l Non-AD Config

l LDAP Queries

l Save Your Configuration
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l Test Your Configuration

l Configure Authentication for EMS Mobile App

When a user logs into EMS Web App or EMS Mobile App with their User ID and Password, their credentials
are authenticated against LDAP and compared against corresponding user information recorded in
the Network ID and/or External Reference fields of your EMS Everyday User records. If a match exists, the
Everyday User will be logged in to the application, inheriting any Everyday User Process Template rights to
which their LDAP Group has been assigned.

Note:
l The EMS Web App LDAP-Process Template assignment process requires that your

implementation of LDAP stores group information (e.g., staff, student, depart-
ment, etc.) as a Directory Service object containing a property (i.e., member) that
contains the users that belong to your various groups. 

l The Field Used to Authenticate Everyday User parameter (within System Admin-
istration > Settings > Parameters > Everyday User Applications tab) is used by
the applications to determine which value should be used for authentication.

Configure EMS Web App to Use LDAP Authentication

1. Log into EMS Web App with a User that belongs to an Everyday User Security Template containing
the Web Administrator role (controlled in the EMS Desktop Client under Configuration > Everyday
User Applications > Everyday User Security Templates).
See Also: Configure Security Templates.

2. From the User Options, select Admin Functions.
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3. Then click the LDAP Configuration tab. 

4. The LDAP Configuration window appears, presenting multiple tabs for various settings. 

Configure EMS Web App Security
On the Security tab:

1. Select the Authenticate users via LDAP checkbox to enable LDAP authentication.

2. If LDAP will be used to assign Everyday User Process Templates to yourWeb Users, select the Use
LDAP to assign Process Templates checkbox.
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3. Use advanced communication options: Skip this step for Active Directory environments. Enabling
this checkbox requires that you complete the settings on the Communication Options tab.

4. In the Path for LDAP Query field, specify a valid LDAP path (example – LDAP://YourCompany.com)

5. List of Domains: Skip this step if your organization uses a single domain. Otherwise, provide a
comma separated list of your domains.

6. In the LDAP Domain\User field, enter a Domain User account that has rights to query LDAP (example
– YourDomain\User)

7. In the Password field, enter a valid Password for the User Account entered in the previous step.

8. Specify the appropriate LDAP Authentication Type for your environment.

Note:
The other tabs (Communication Options, Core Properties, Non-AD Config and LDAP
Queries) should only be edited with assistance from our Support Department when
special circumstances arise with unique configurations of LDAP.

Configure Communication Options

Important!
It is recommended that this tab only be edited with assistance from our Support
Department when special circumstances arise with unique configurations of LDAP. If
you’re not familiar with the LDAP settings, it is highly recommended to get the
assistance of a System Admin in your organization who is familiar with the LDAP
settings.

The Communication Options tab includes fields that define how to fetch a Group or a User when sending
communications from the EMS Desktop Client. You can also set the SSL configurations, including the
Security Certificate Path. Checking theUse SSL box will force communication to use SSL. 

l Certificate Path: If there is a specific certification that you want to use to validate your authen-
tication.

l Authentication Type: Type of authentication that your LDAP server will use during the binding pro-
cess. Basic is the default because it is themost common. 

l Search Root: The root is the level at which your search will begin. 

l User Search Filter: Specifies the filter to use when performing the user search. 
Example: (&(objectClass=Person)(SAMAccountName={0})) or (&(objectClass=Person)(uid={0}))

l Group Search Filter: Specifies the filter to use when performing the group search. 
Example: (&(objectClass=Person)(objectClass=user))
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l Protocol Version: Insert the current version number here. The default is 3, as the current version
should be 3. 

Core Properties

Important!
It is recommended that this tab only be edited with assistance from our Support
Department when special circumstances arise with unique configurations of LDAP. If
you’re not familiar with the LDAP settings, it is highly recommended to get the
assistance of a System Admin in your organization who is familiar with the LDAP
settings.

Indicate whether your LDAP implementation is Active Directory. These properties are set to the common
defaults, but can be changed here if the LDAP properties differ from the defaults displayed.

l LDAP Name Property: The property for user name on the user record in LDAP that will be displayed.
Displayname is the default, as it is themost common. 

l LDAP Phone Property: The property for the phone number on the user record in LDAP that will be
displayed. Telephonenumber is the default, as it is themost common.

l Domain to append to users: This field is unnecessary unless the domain of your user is different from
the domain returned from the query. 

l Field for LDAP Group Lookup: This identifies the EMS property that should be utilized when per-
forming the search. For example, if you use LDAP solely to assign templates and you want the EMS
Web App to look up group membership using a field other than the login name, then you must enter
that field's name here. 

Non-AD Configuration

Important!
It is recommended that this tab only be edited with assistance from our Support
Department when special circumstances arise with unique configurations of LDAP. If
you’re not familiar with the LDAP settings, it is highly recommended to get the
assistance of a System Admin in your organization who is familiar with the LDAP
settings.

If your LDAP implementation is not Active Directory, use these fields to redefine the LDAP property names
used when searching directory information.
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l LDAP Account/User ID Property: The property in your LDAP store that contains the user name. 
Example: If sameaccountname=xxxx, then enter sameaccountname

l Full LDAP User ID Format: Leave blank unless authentication requires a full path. 
Example: cn={0},ou=staff,o=yourdomain

l LDAP Group Category: The property in your LDAP store that contains the group category. 
Example: If filter should be objectClass=groupOfNames, then property should be groupOfNames

l LDAP Group Name: The property in your LDAP store that contains the group name. 

l LDAP Group Member Name: The property in your LDAP store that contains the name of a single
member in the group. 
Example: If member property is member=jdoe, then property should be member

l LDAP Group Member User Name Attribute: The property of the user record that corresponds to
the group's member property to determine group membership. 

LDAP Queries

Important!
It is recommended that this tab only be edited with assistance from our Support
Department when special circumstances arise with unique configurations of LDAP. If
you’re not familiar with the LDAP settings, it is highly recommended to get the
assistance of a System Admin in your organization who is familiar with the LDAP
settings.

These are LDAP query overrides to fetch Groups and Users from the domain. These settings rarely need to
overridden, but can be used to customize queries.

l LDAP query for security groups:Query used to search for security groups in your LDAP store. 

l LDAP query to find users: Query used to search for users in your LDAP store.

l LDAP query for find users with space: Query used to search for users that have spaces surrounding
their user names in your LDAP store. 
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Save Your Configuration

1. Click Save. 

Note:
If you want Everyday Users to inherit Everyday User Process Templates based on
the LDAP Group(s) with which they belong, see LDAP Groups Tab. Otherwise, you
have completed the configuration process.

2. Within EMS Desktop Client, go to the Everyday User Process Templates area (Configuration >Web
> Everyday User Process Templates).

3. Within an Everyday User Process Template, locate the LDAP Groups tab and select the appropriate
LDAP Group(s) to map to that Everyday User Process Template.

4. Click OK.

Test Your Configuration

1. After completing configuration, navigate to the Test Configuration tab in the EMS Web App under
LDAP Configuration. 

2. Enter your Network UserId Without Domain Name.

3. Enter your Password.

4. Click Test.

a. If your configuration was successful, you will receive a message in a green box at the top that
includes domain information and the words "Authentication successful" (please see example
below).

b. If the configuration was unsuccessful, you will receive a prompt stating that LDAP could not be
accessed. Check your logs to determine the reason for the failure. 

Configure Authentication for EMS Mobile App

1. If your organization uses EMS Mobile App, click theMobile App tab.

2. Choose the LDAP option.
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CHAPTER 26: Portal or Federated Authentication
This topic provides information on the following:

l Portal Authentication Overview

l Installation/Configuration

o Redirect User Log In to Your SSO Provider

o Specify a Different Default Home Page for Guest Users

Portal Authentication Overview 
The Portal Authentication method provides EMS Web App single sign-on capability using your
organization’s portal (e.g., CAS, Shibboleth, SiteMinder, Plumtree, uPortal, etc.). When a user who is
logged into your portal accesses EMS Web App, a predefined user-specific variable (e.g., email address,
employee/student ID, network ID, etc.) captured by your portal/sign-on page is compared against
corresponding information recorded in the Network ID and/or External Reference fields of your EMS
Everyday User records. If a match exists, the Everyday User will be automatically logged-into EMS Web App.

Note:
The Field Used to Authenticate Everyday User parameter (within System
Administration > Settings > Parameters > Everyday User Applications tab) is used by
EMS Web App to determine which value should be used for authentication.

Several built-in authentication methods to pass-in credentials are available including:

l Server Variable (Header Variable)

l Session

l Form

l Cookie

l Query String

l Federated (SAML)

For a more detailed explanation of the authentication methods outlined above, see Portal Authentication
Methods. 
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Installation/Configuration 

1. Within the Everyday User Applications parameters area of EMS (System Administration > Settings
> Parameters (Everyday User Applications tab), the following parameters must be set accordingly:

Area Description Value

Authentication Portal
Authentication
Cookie Key

Required if Portal Authentication Method = Cookie

Authentication Portal
Authentication
Method

Server Variable

Session

Form

Cookie

Query String

Authentication Portal
Authentication
Variable

User variable to be compared against the EMS Everyday
User External Reference/Network ID field

2. Direct users to the default EMS Web App page. If the default installation settings were used, the
default page is:
(http://[ServerName]/EMSWebApp/Default.aspx)
(replace [ServerName]with the name of your web server)

Redirect User Log In to Your SSO Provider
Administrators can hide the login form on theMy Home page and instead, present a single Sign In button
that links to the override URL. Open the web.config file and locate the following code to customize the
redirect:

<!--<add key="loginOverrideUrl" value=""/>-->

Additionally, you can do the same for user log out:

<!--<add key="logoutOverrideUrl" value=""/>-->

Changing the URL in these areas means that when users log in
or out, they will pass through your SSO provider.
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Specify a Different Default Home Page for Guest Users
Additionally, you can now specify a different site home page for unauthenticated users.
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CHAPTER 27: Portal Authentication Methods
This topic provides information about the following:

l Server VariableMethod (Header Variable)

l Server VariableMethod – Federated (SAML)

o Method 1: Locally installed service provider

o Method 2

l EMS Desktop Client Configuration

o Session Method

o Form Method

o CookieMethod

o Query String Method

Note:
EMS applications do not natively support SAML. You must use our Portal
Authentication to use SAML.

Server Variable Method (Header Variable)
Server Variable/Header Variable is a collection of variables that are set by Internet Information Server (IIS). 

Applications like SiteMinder create custom server variables for portal site use.

Set the Portal Authentication Method parameter to Server Variable and type the appropriate variable for
the Portal Authentication Variable parameter. Direct users to your EMS Web App Default.aspx page.

Server Variable Method – Federated (SAML)

Note:
As of Update 23 (March 2018), SAML authentication for the EMS Web App is supported
through EMS Platform Services. This is now the recommended method for configuring
SAML. See Also: SAML Authentication.

SAML can be leveraged for authentication with your EMS applications by leveraging our portal
authentication method and a service provider of your choosing.
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Method 1: Locally installed Service Provider
Using this method, you install a service provider of choice on the webserver hosting the EMS web
applications. All traffic is routed through that service provider (typically via an ISAPI filter). This service
provider will manage all of the authentication for the user. Once the user has successfully authenticated, it
will pass an identifier for the user to the EMS application using one of our portal methods. In this scenario
typically the Server Variable (Header)method is used.

Method 1 Configuration Steps

1. Install and configure a service provider on the EMS web server

2. Set the service provider to protect the specified EMS web applications

3. Configure the service provider to pass the required user attributes

4. In EMS Desktop Client, configure the EMS Web App parameter “Portal Authentication Method”

5. In EMS Desktop Client configure the applicable Portal Authentication Variables.

Method 2
This method can be common if there is already a server configured with a service provider in your
environment, handling authentication for other applications. In EMS Desktop Client, you can configure
your application to re-direct any login requests to the other server to be authenticated. Once the user is
authenticated, the server with your service provider installed sends the user back to the EMS Desktop
Client with an identifier for the user in the header, or within a cookie. The EMS application reads this
header, or cookie value, and leverages portal authentication to sign the user in with thematched
credentials.

Method 2 Configuration Steps

1. Install and configure a service provider on the EMS web server

2. Set the service provider to protect the specified EMS web applications

3. Configure the service provider to pass the required user attributes

4. In EMS Desktop Client configure the EMS Web App parameter “Portal Authentication Method”

5. In EMS EMS Desktop Client, configure the applicable Portal Authentication Variables.

6. In EMS EMS Desktop Client, change the Login URL under Configuration > Everyday User Applic-
ations >Web App Menus.

a. Select Login.aspx and click Edit

b. Enter in the URL to your Remote Service Provider
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7. Configure your remote Service provider to send the user back to the default.aspx page of the web
application that the request originated from.

EMS Desktop Client Configuration
Please reference our Portal Authentication section for further details around the configuration required
within EMS. There are a number of different options available. You will need to know themethod that the
user identifying value will be passed and the name of that value. Other values can also be passed (ie: email
address and phone number) to aid in automatic web user account provisioning as well.

Session Method
A session is a way to provide/maintain user state information in an inherently stateless environment.  It
provides access to a session-wide cache you can use to store information.

In order to use the session method, set the Portal Authentication Method parameter to Session and type
the appropriate variable for the Portal Authentication Variable parameter.  Then you must create an
asp.net web page and name it with the .aspx extension similar to the example below.  The asp.net web
page created must be copied into the EMS Web App root web directory.  It must be copied there in order
for EMS Web App to read the session variable.

You will need to pass through the user’s email address or external reference to your asp.net web page.

Code example in vb.net:

<%@ Import Namespace="System" %>

<script runat="server" language="vb">

Sub Page_Load(ByVal sender As System.Object,
ByVal e As System.EventArgs)

Session.Item("EMS Web AppSession") =
"test@emssoftware.com"

Response.Redirect("Default.aspx")

End Sub

</script>

Form Method
Forms enable client-side users to submit data to a server in a standardized format via HTML. The creator of
a form designs the form to collect the required data using a variety of controls, such as INPUT or SELECT.
Users viewing the form fill in the data and then click Submit to send the data to the server.
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To use the form method, set the Portal Authentication Method parameter to Form and type the
appropriate variable for the Portal Authentication Variable parameter.  To create portals through a form,
create a web page with a form similar to below.  Once the user logs on through the portal, the form below
can be submitted to log the user on to EMS Web App.

Code example in HTML:

<Form name="form1" method="Post" action=" http://[ServerName]/
EMSWebApp/Default.aspx ">

<input type="hidden" id="EMS Web AppFORM" name="EMS Web AppFORM"
value="test@emssoftware.com>

<input type="submit" value="submit">

</form>

Cookie Method
A cookie is a small piece of information stored by the browser. Each cookie is stored in a name/value pair
called a crumb—that is, if the cookie name is "id" and you want to save the id's value as "this", the cookie
would be saved as id=this.

You can store up to 20 name/value pairs in a cookie, and the cookie is always returned as a string of all the
cookies that apply to the page. This means that you must parse the string returned to find the values of
individual cookies.  Cookies accumulate each time the property is set. If you try to set more than one
cookie with a single call to the property, only the first cookie in the list will be retained.

To use the cookie method, set the Portal Authentication Method parameter to Cookie and type the
appropriate variable for the Portal Authentication Cookie Key parameter.  Then create a web page with
code similar to below.  Once the user logs on through the portal, take their user logon information and
create a cookie.  After the cookie is created send the user to your EMS Web App Default.aspx page.

Code example in Active Server Pages 2.0:

<%@LANGUAGE="VBSCRIPT" %>

<%

Response.Expires = -1

Response.Cookies("EMS Web AppCookie")("CookVal") = "test@emssoftware.com"

Response.Cookies("EMS Web AppCookie").Path = "/"

Response.Cookies("EMS Web AppCookie").Expires = DateAdd("m", 3, Now)

Response.Redirect("http://[ServerName]/ EMSWebApp/Default.aspx ")

%>
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Query String Method
A query string is information appended to the end of a page's URL. An example using portal authentication
is below.

Code example:

  http://[ServerName]/ EMSWe-
bApp/Default.aspx?MCQS=test@emssoftware.com

To use the query string method, set the Portal Authentication Method parameter to Query String and type
the appropriate variable for the Portal Authentication Variable parameter.
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CHAPTER 28: Authentication Options for EMS Web App
Authentication options for the EMS Web App include:

l Integrated Windows Authentication

l LDAP

l Portal Authentication

l SAML Authentication

l EMS Native Authentication

Authentication is controlled by three factors.  They all must be configured correctly for the authentication
to work:

1. Login Credentials: This is the location where external LDAP/Windows/Portal credentials need to be
entered in our software for each user.

2. Enabled by: This is either a parameter or checkbox that needs to be enabled for the authentication to
work.

3. Configuration Page: This is where configuration and options are set for the authentication.

Integrated Windows Authentication
Integrated Windows Authentication (IWA) is a built-in Microsoft Internet Information Services (IIS)
authentication protocol that can be used to automatically authenticate and sign-in a user to EMS Web App.
Integrated Windows Authentication works only with Internet Explorer and is best used on intranets where
all clients accessing EMS Web App are within a single domain. See Also: Integrated Windows
Authentication.

l Login Credentials: Network ID / External Reference in web user account settings (Either of these
work).

l Enabled by: Within IIS on the VEMS site, "Authentication" options, Windows Authentication enabled,
Anonymous Authentication disabled.

l Configuration Page: IIS "Authentication" options.

LDAP
Lightweight Directory Access Protocol (LDAP) is an application protocol for querying directory information.
The LDAP Authentication method provides single-sign-on capability using your organization’s LDAP
environment and can be used in both intranet and internet deployments of EMS Everyday applications,
such as EMS Web App and EMS Mobile App. See Also: LDAP Authentication.
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l Login Credentials: Network ID / External Reference in web user account settings (This is specified by
the "Field Used to AuthenticateWeb User" on the VEMS/EMS Web App Parameters tab).

l Enabled by: ldapconfiguration.aspx page, "Authenticate users via LDAP?" checkbox (must be logged
in with Web Admin security role and have Integrated Authentication in license).

l Configuration Page: ldapconfiguration.aspx page (there aremultiple tabs).

l Other Notes: EMS LDAP License is required for this to work.  The web server will need access to dir-
ectory server for this to work.

Portal
The Portal Authentication method provides EMS Web App single sign-on capability using your
organization’s portal (e.g., CAS, Shibboleth, SiteMinder, Plumtree, uPortal, etc.). When a user who is
logged into your portal accesses EMS Web App, a predefined user-specific variable (e.g., email address,
employee/student ID, network ID, etc.) captured by your portal/sign-on page is compared against
corresponding information recorded in the Network ID and/or External Reference fields of your EMS
Everyday User records. If a match exists, the Everyday User will be automatically logged-into EMS Web App.
See Also: Portal Federated Authentication.

l Login Credentials: Network ID / External Reference in web user account settings (this is specified by
the "Field Used to AuthenticateWeb User" on the VEMS/EMS Web App parameters tab).

l Enabled by: Always enabled; select the appropriate entry from the "Portal Authentication Method"
on the VEMS/EMS Web App Parameters page.

l Configuration Page: There aremultiple different setup items in the VEMS/EMS Web App parameters
under the "Authentication" area.

SAML

Note:
As of Update 23 (March 2018), SAML authentication for the EMS Web App is supported
through EMS Platform Services. This is now the recommended method for configuring
SAML. See Also: SAML Authentication.

l Login Credentials:

l Enabled by:

l Configuration Page:

l Other Notes: 
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CHAPTER 29: EMS Web App Configuration Guide
EMS Web App is an optional web-based application that EMS users can use to view EMS events, and if
allowed, to submit and manage reservations. As the EMS administrator, you are responsible for setting up
and maintaining the necessary components for this module, including defining users, security templates,
process templates, menus and links, and help text.

An EMS Desktop Client administrative setup and configuration for the EMS Web App is done in the
EMS Desktop Client. You must have this application installed and administrator credentials to follow the
instructions in this section.

This Configuration Guide provides information on the following:

l Administrative Functions in the EMS Web App

l Configure Everyday Users

o Configure Groups and Contacts From an Everyday User

o Licensing for Everyday Users

l Configure Everyday User Templates

o Assign Process Templates to Everyday Users

o Configure Everyday User Process Templates

o Configure Confirmation Behavior for Everyday User Applications

o ConfigureManaged Space

o Everyday User Process Template Field Definitions

l Security Templates

o Configure Security Templates

o Assign Security Templates to Multiple Everyday Users

o Everyday User Security Template Field Definitions

l Email an Everyday User

l ConfigureWeb Menus

l Configure Help Text

l Configure Language Translations for Everyday User Applications

l Customize EMS Web App

l EMS Web App System Parameters

l Authentication Options

o Configure EMS Web App to Use LDAP Authentication
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Contact Customer Support

l Option 1 (Recommended): Search the Knowledge Base available at Accruent Access.

l Option 2: Submit a case directly via Accruent Access.

l Option 3: Email emssupport@accruent.com.

l Option 4: Phone (800) 288-4565.

Important!
If you do not have a customer login, register here.
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CHAPTER 30: Administrative Functions in the EMS Web App
From the Admin Portal in the EMS Web App, Administrators can access error logs, view license information,
and enabling help text.

This topic provides information that will allow you to do the following:

l Admin Functions

o Clear your Cache

o Enable Help Text Edit

o Enable Detailed Errors

o Disable Custom JavaScript

l Error Logs

l License Information

l LDAP Configuration

Administrative Functions
This screen allows Administrators to perform the administrative functions listed below:

l Clear Cache—Click the Clear Cache button to empty your cache of parameters, tool tip options, and
web text. This is an important function that must be performed when parameter changes aremade in
the EMS Desktop Client.

Note:
If you havemultiple servers that host the EMS Web App, you must Clear the Cache on
each server.

l Enable Help Text Edit—This option allows you to edit help text. To edit help text, click the link next to
the help text. See Also: Configure Help Text. To disable help text edit, click theDisable Help Text Edit
button.

l Enable Detailed Errors—This function allows you to view error details when troubleshooting issues.
To disable this function, click theDisable Detailed Errors button.

l Disable Custom JavaScript—Click this button to disable custom JavaScript for the session while
troubleshooting. Click the Enable Custom JavaScript to enable this function.
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Error Logs

1. To view error logs, navigate to the Error Logs tab in the Admin Portal.

2. Click on the .txt file of the log you want to view.

Error Logs Tab in the EMS Web App

License Information

1. To view licensing information, navigate to the License Information tab in the Admin Portal.

2. Click the Read License button.

3. You will receive information on the Application Version, what EMS components your organization is
License For, the Expiration Date of your license, the number ofAllowed Web Users for your license,
and the number of Current Active Users.

Accruent Confidential and Proprietary © 2019 Page | 97

CHAPTER 30: Administrative Functions in the EMS Web App



License Information in the EMS Web App

LDAP Configuration
Lightweight Directory Access Protocol (LDAP) is an application protocol for querying directory information.
The LDAP Authentication method provides single-sign-on capability using your organization’s LDAP
environment and can be used in both intranet and internet deployments of EMS Everyday applications,
such as the EMS Web App. See Also: Configure the EMS Web App to Use LDAP Authentication.
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CHAPTER 31: Configure Everyday Users
This section guides you in configuring one Everyday User at a time. Once you have configured these users,
you might need to assign them to security templates and one or more process templates. 

l To assign users to Everyday User process templates, see Assign Templates to an Everyday User.

l To assign multiple templates to multiple users in a single step, see Assign Templates to Multiple
Users.

Note:
You configure EMS Desktop Client user accounts in a different area (under the System
Administration > Security menu). For instructions, see Configure EMS Desktop Client
User Accounts.

Additionally, if your organization uses EMS Human Resources Toolkit to manage Everyday User
accounts, See Also: EMS HR Toolkit.

Lastly, a set of Account Management parameters control account management behavior. To see these
parameters, refer to EMS Web App System Parameters.

Concept: EMS classifies users into two categories: Guests or Visitors and Everyday Users.
"Guests" or "Visitors" (unauthenticated or anonymous users) can browse events, see details about your
organization’s space, and/or submit requests. These users can register themselves through EMS Web App
and create a user account. To enable this, you need to set certain account management parameters
(see EMS Web App System Parameters) and select the Credit\Edit an Account role for the unauthenticated
user (see the Roles tab definition in Configuring a security template).

"Guests" or "Visitors" (authenticated users) can also submit and manage reservations if you enable them.
You can configure these users through the EMS Desktop Client or the optional Integrated Authentication
module. See Also: Creating a User from a Group and Creating a User from a Contact. Before you configure a
user, check that the user has not already been created.

Note:
Everyday User process templates control access and behavior in EMS
Software's Everyday User Applications. If you are upgrading from an older release of
EMS, you might recognize Everyday Users as "Web Users" and "Everyday User Process
Templates" as "Web Process Templates."

1. On the EMS Desktop Client menu bar, click Configuration > Everyday User Applications > Everyday
Users. The Everyday Users window opens. The number of configured users for EMS Web App shows
in the upper left corner. The number of users for which your organization is licensed shows in the top
center.
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2. Check that the user you want to configure does not already exist. Enter the user name or email
address in the Find field. 

Note:
This search string is not case-sensitive, but your entries must be in the correct
order. For example, if searching by Email Address, a search string
of bob returns bobworth@emssoftware.com but
not dbobbett@emssoftware.com.

You can narrow your search results by:

l Group Type

l City

l Status

l Process Template

Then Click Display; search results show in the lower pane of the window. If your user does not
already exist in EMS, proceed to the next step. 

Note:
If the EMS system parameter Users linked to Groups via External Reference is
set to Yes, then you will also see a Group column and a City column.
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3. Create a new user. Click the New button. A dialog box opens.   

Note:
If the user has confirmed membership (by responding to an email containing an
activation link), the Validated checkbox highlighted belowwill be selected. If the
user had to answer questions when requesting an account, you can view the
user's responses on the User Defined Fields tab.

Everyday User Dialog
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Note:
When you configure a user, you can also specify one or more delegates for the
user. A delegate is a user who can create and view reservations on behalf of
another user.

4. Enter information for the new user. User name and email address are required; password is only
required if not using the optional Integrated Authentication module. All other information is optional
and can be added later as needed.
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Everyday User Tab Field Descriptions

Field Description

Name The name of the user. (Maximum of 30 characters, including spaces).

Password The password that the user must enter to log in to EMS Web App. If using the optional
Integrated Authentication module, Password can be left blank since the network
password is used instead.

Email
Address

Enter the full email address for the user as the user must enter this address to log in to
EMS Web App.

Phone 1
/Phone 2

Optional fields.

Notes Optional field. Read-only.

External
Reference

Optional field. Links the user to an outside program such as EMS Human Resources
Toolkit if needed.

Network
ID

The user’s network ID.

Email
Opt Out

Optional field. Select this option if you do not want the user to receive automatic emails
(such as reservation summary emails) from EMS Web App. The user can still receive
manually sent emails.

Status Required field. Select the status for the user:

l Active—The user can log in to EMS Web App, EMS Mobile App, and EMS for
Outlook.

l Pending—The user cannot log in to EMS Web App, EMS Mobile App, and EMS for
Outlook and is informed that he/shemust check back at a later time.

l Inactive—The user cannot log in to EMS Web App, EMS Mobile App, and EMS for
Outlook and is instructed to contact the EMS administrator.

Security
Template

Required field. This determines the user's access to the system (i.e., themenu items the
user can see and the event information that the user can view).

Time
Zone

Optional field. The time zone in which the user is located. Beginning in version 44.1, it is
strongly recommended that users are assigned to a time zone for an optimal experience
on all Everyday User Applications.
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Field Description

Validated When checked, users who created their own accounts have confirmed membership (by
responding to an email containing an activation link). When unchecked, the user will not
be able to use EMS Web App. 

5. Assign process templates to the new user. Open the Process Templates tab. The process templates
you assign here will appear as menu items to the user in EMS Web App, EMS Mobile App, and EMS
for Outlook.

6. Specify Groups on whose behalf the user can create and manage reservations. Open the Groups tab.
To filter the list of active groups displayed, use the Find and Type fields and then click Display. Select
one or more Groups (use CTRL-click for multiple groups), and then click Move (>) to move the selec-
ted groups to the Selected list.

7. Specify Delegates the user can impersonate. Open the Delegates tab; to see all available users,
click Display. To narrow the search results, use the Search by dropdown list to search by User Name
or Email Address. Select one or more delegates (using CTRL-click for multiple delegates), and then
click Move (>) to move the selected users to the Selected list. 

Note:
Click Spelling to spell-check any information that you manually entered for the
user.

8. Click OK. The dialog box closes and returns you to the users windowwith the newly configured user
automatically selected.
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CHAPTER 32: Configure Groups and Contacts from an Everyday
User
This topic provides information on the following: 

l Create Groups and Contacts from the Everyday User

o Configure a Group from a User

o Configure a Contact from a User

Create Groups and Contacts from the Everyday User
After you have configured a new user, you can create groups and contacts from the user.

1. On the EMS menu bar, click Configuration > Everyday User Applications > Everyday Users. The
Everyday Users window opens. The number of configured users for EMS Web App shows in the upper
left corner. The number of users for which your organization is licensed shows in the top center.

Everyday Users Window

2. Locate the user you want to work with. Specify any combination of search criteria, and then click Dis-
play to see all users that meet the criteria.

Note:
If you leave the Find field blank, a list of all currently active users appears. This
field is not case-sensitive, but entries must be in the correct order. For example, a
search string of Bar returns Barry Jones, but not Amanda Barry.
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3. Continue to one of the following:

l Configure a Group from a User

l Configure a Contact from a User

Configure a Group from a User

1. Select the user from which you are creating a Group, and then clickMore > Create Group. The Group
dialog box opens. TheName field is automatically populated with the name of the selected user, but
you can edit this value if needed.

Group Tab

2. Configure the newGroup as needed. See Configuring Groups.

Configure a Contact from a User

1. Select the user from which you are creating a contact, and then clickMore > Create Contact. The
Groups window opens.
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Groups Window, Results Tab

2. Search for the Group for which you are creating the Contact. See Also: Searching for a group and/or
contact.

3. Select the Group on the Results tab, and then click Select. The Contact dialog box opens.

Contact Dialog Box

4. Enter the information for the new contact.
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Note:
You can click Spelling to spell-check before saving.
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Contact Tab Field Descriptions

Field Description

Contact By default, the Contact field is populated with the name of the user that you selected,
but you can edit this value if needed.

Note:
The name can be a maximum of 50 characters, including spaces.

Title The job title of the Contact.

Group Populated with the name of the Group that you selected. You cannot change this
value.

Address Populated with the address of the Group that you selected. If the Contact address is
not the same as the Group address, then clear Use Group Address and enter the
appropriate values in the Address fields.

International Select this option to drop the State and Zip fields for an international group.

Phone and
Fax

The phone number and fax number for the group.

Note:
The Phone and Fax fields have a dropdown list available on which
you can select a different value (Fax, Mobile, Other, or Phone) for
the field label, or you can enter a user-defined value. To enter a
user-defined value, double-click the current field label to select it,
and then enter the user-defined value over the selected label.

Email
Address

The email address for the contact.

Note:
If your computer is connected to a network, click the Search icon
to open a Global Address Lookup dialog box and search for the
email address.

External
Reference

Links the contact to an outside program or another EMS record if needed.
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Field Description

Notes Any other information that is pertinent for the contact. This information only displays
within the EMS Desktop Client.

Set as
Default

Select this option if the contact is to be the default Contact for the selected Group.

Note: If a default Contact has been defined for a Group,
then when you specify the Group information for a
reservation, the Contact field is automatically populated
with the name of the default Contact.

You can always specify a Contact as the default contact for a selected Group at a later
date. To do so, select the Contact in the right pane of the Group-specific window, click
Set Default, and then click Yes at the prompt to set the selected user as the default
contact.

Inactive Leave this option blank to add the Contact as an active Contact. Select this option to
de-activate the Contact.

5. Click OK. The Contact dialog box closes and the Contact is created from the user and added to the
Group. The Group-specific window opens with the Contact selected.

Accruent Confidential and Proprietary © 2019 Page | 110

CHAPTER 32: Configure Groups and Contacts from an Everyday User



CHAPTER 33: Licensing for Everyday Users
If your organization has reached your limit of licensed everyday users, you will no longer be able to create
additional users. To get back under your maximum number of users, you can either deactivate or delete
users from EMS Desktop Client.

Note:
If you have previously used older versions of EMS, you might know these templates as
"Web Process Templates." These templates are now called "Everyday User Process
Templates."

1. Select the Configuration > Everyday User Applications > Everyday Usersmenu.

2. To delete users, select them and click the Delete button.

3. To deactivate users, select them, click the Edit button and set the Status field to Inactive.

Everyday Users Menu

Note:
If you use HR Toolkit, users that are no longer part of the feed or part of your
organization will automatically be deactivated.

A License Notification message will display when opening the Desktop Client if the user
license has been exceeded.
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CHAPTER 34: Configure Everyday User Templates
This topic explains the process of assigning your users to security profiles and booking templates. 

Note:
If you have previously used older versions of EMS, you might know these templates as
"Web Process Templates." These templates are now called "Everyday User Process
Templates."

Concepts: Everyday User, Everyday User Template, Security Template, and Process Template
Explained. Click for more...

l Everyday User—Someonewho can request or reserve space and services in any EMS Software applic-
ation other than EMS Desktop Client. You assign these users to templates.

l Everyday User Template—Defines and controls what a user can do. EMS uses two types of everyday
user templates:

l Security template—This is essentially a security profile: it controls which menu items are available to
the users assigned to the template, which booking information fields display to them, and other
information.

l Process template—This is essentially a booking template: it controls what users can do for different
types of reservations (conference room, workspace, study room, and so on). This type of template
also controls users' date/time restrictions, room security (reserve, request only, no access), and ser-
vice availability (A/V, catering, and so on).

To configure Everyday User templates, you will need to do the following:

l Configure Everyday Users

l Configure Everyday User Process Templates
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CHAPTER 35: Assign Process Templates to an Everyday User

Note:
This section guides you in assigning Everyday User process templates to a single user.
To assign these templates to multiple Everyday users in a single step, see Assign Web
Templates to Multiple Everyday Users.

1. On the EMS menu bar, click Configuration > Everyday Applications > Everyday Users. The Everyday
Users window opens. 

2. In the Find field (in the upper portion of the screen), search for the user to whom you want to assign
Everyday User process templates by entering at least the first three characters of their user name or
email.

Note:
You can further narrow your search results by: 

l Group Type

l City

l Status

l Process Template

3. Click Display.

4. Select the user and click the Edit button on the right.
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5. In the Everyday User editing window, click the Process Templates tab.

Process Templates Tab

6. To assign process templates to an Everyday User, move them to the right side using the arrow but-
ton. Your selections here will present to the user in EMS Web App as available booking options under
"My Templates."

7. Click OK. The Everyday Users dialog box closes and returns you to the Everyday Users window.
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CHAPTER 36: Configure Everyday User Process Templates
Concept: "Web Process Templates" Are Now Called "Everyday User Process Templates"
If you have previously used older versions of EMS, you might know booking templates as "Web Process
Templates." These templates are now called "Everyday User Process Templates." These templates define
user access and booking behavior in EMS Web App, EMS Mobile App, and EMS for Outlook. Similarly, you
might know permissions templates, which control what an Everyday User is able to do, as "Web Security
Templates." These are now called "Everyday User Security Templates."

See Also: Configure Security Templates.

Note:
In EMS Enterprise, the guest (unauthenticated user) everyday user process template is
always available and you can have an unlimited number of other everyday user process
templates. In EMS Professional, the (unauthenticated user) everyday user process
template is always available, but you can have only two additional everyday user
process templates.

To configure Everyday User process templates, complete the following steps:

1. On the EMS menu bar, click Configuration > Everyday Applications > Everyday User Process
Templates. The Everyday User Process Templates window opens on the Everyday User Template
tab.
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Everyday User Process Templates Window

This window lists the process templates that have been defined for your EMS Web App
implementation. The pre-defined user called "unauthenticated user" is included in all EMS
implementations; you use this template to manage settings for anonymous or “guest” users. For a
user to be able to view and use this template, you must assign the user to the template. See Also:
Configure Everyday Users.

Note:
To view all everyday user process templates in your EMS database, regardless of
status, under Show, click Inactive.

2. Click New. The Book a Meeting Room configuration dialog box displays. Enter the information for the
new everyday user process template as needed. See Everyday User Process Template Field
Definitions for more information on the tabs in the Book a Meeting Room configuration dialog.
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Book aMeeting Room Configuration Dialog

Important!
The cachemust be cleared in the EMS Web App whenever parameter changes aremade
in the EMS Desktop Client.

Note:
The Request Status field is used to configure booking templates for the
"Request/Approval" booking model, in which everyday users request space and
administrative users approve those requests (using the Dashboard menu icon). For
example, if you set this field to Request, then the booking will not be finalized until an
administrator has approved it. If you are configuring a template for booking desks and
workspaces or "hoteling," see Create Templates for Desks and Workspaces.

Note: You can use the Request/Approval Model to Oversee "Managed
Space." For more information, see Configure Managed Space.
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Note:
In the Everyday User Application Settings section:

l Enable for Web Appmeans enable the template on EMS Web App.

l Enable for Mobilemeans enable the template for the EMS Mobile App.

l Enable for Outlookmeans enable the template for the EMS for Outlook add-in,
which can override booking rules such that users can book a room that is in con-
flict. For this situation, you can also configure a system-generated email to be
sent to the user if any rooms are not available for dates booked. An additional tab
becomes available if you create a template with the option enabled, Outlook Con-
flict Email.

l Enable Integration to Microsoft Exchange means enable the template for
Microsoft® Exchange when your organization does not use EMS for Outlook.
See Also: Everyday User Process Template Field Definitions.

You can continue configuring the booking template on additional tabs or just click OK to save your
changes.

Save Your Template Settings
When you have completed entries in all tabs as desired, click OK. Your changes to the everyday user
templates are saved.

Note:
Make sure that you have defined your everyday users so you can assign them to your
everyday templates. See Also: Configure Everyday Users
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CHAPTER 37: Configure Confirmation Behavior for Everyday User
Applications
When working with Everyday User Process Templates, you can set automated confirmations that generate
when Everyday Users initiate reservations or bookings with specific templates. For example, you might
want Everyday Users to always receive an email to confirm that a request for a room has been received and
will be processed.

1. To customize the behavior of this type of confirmation, from  the Everyday User Process Templates
window, select the template for which you want to customize a confirmation.

2. Click Confirmation.

Everyday User Process Templates Window

3. The Confirmation Settings window appears for this template. Click through the tabs specifying your
Confirmation Settings.

l Use theOptions tab to set an email header and email footer for pre-configured messages
(which you set under Configuration >Other >Messages).
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Setting Email Header and Footer in the Options Tab

l Use the Web App Options tab to specify if and where a URL to theWeb App should be included
in the confirmation. You can also include a Message to include with the URL in the confirmation.
See Also: Configure the Confirmation Email Subject Line.​​​​​​
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Specifying EMS Web App Link Settings in the Web App Options Tab

EMS Web App Link Settings Fields

Option Description

Display Web App
Link

Indicate whether a URL to theWeb App will display in the confirmation as a
Header, Footer, or at all.

Web App Link
Message

Indicate which Message, if any, to include with the URL to the EMS Web App in
the confirmation. 

Note:
To understand how the Desktop Client user encounters these confirmations, see
Confirmations.
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CHAPTER 38: Configure Managed Space
Once you have configured facilities (rooms, categories, services, resources, and so on), you can configure
special process templates for "managed space," which is meeting space that might require additional
oversight and an approval process to finalize a reservation. For example, you can configure a large banquet
hall as managed space to ensure that any request to use it is approved by a supervisor. That supervisor
would use the Dashboard from the EMS Desktop Client menu bar to view requests for space.

Typically, managed space involves services, expenses, and invoicing that affect multiple stakeholders and
departments, and templates designed for this model are typically assigned to Everyday Users of EMS Web
App. By contrast, such templates are not recommended for assignment to EMS for Outlook users since
Microsoft®Outlook does not show the request status of such a reservation.

To configure a process template to require supervisory approval:

l When defining an Everyday User Process template for a specialized type of space or room, you set
the Request Status field to Request (so it will show as pending in the Dashboard).

l Assign that template to the appropriate everyday users (typically, EMS Web App users so they can
only Request reservations for that specialized space.

l Designate users in EMS Desktop Client who will review and approve this type of space request in the
Dashboard.
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CHAPTER 39: Everyday User Process Template Field Definitions
This topic provides information on the following:

l Process Template Tab

l Additional Tabs for Booking Template Configuration

o Booking Rules Tab

n Booking Rules Tab: Booking Requirements Area

n Booking Rules Tab: Booking Days Area

l Defaults Tab

l Video Conference Tab

l Rooms Tab

l Categories Tab

l Event Types Tab

l LDAP Groups Tab

l User Defined Fields Tab

l Parameters Tab

l Help Text Tab

o Menu Text Translations Tab

o Terms and Conditions Tab
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Process Template Tab

Field Description

Description Read-only information.

Mode Determines how a user can make a reservation in EMS Web App.

Request—users can complete a simple online form requesting a room. Unlike the
Self Servemode, this mode does not allow the user to view real-time room
availability. In addition, requests must be reviewed, approved, and manually
processed into actual reservations by an EMS Desktop Client user. The room does
not show as Reserved until this step has occurred.

Note:
The "Request" mode is only for guest users. If you are
upgrading to EMS V44 from an older version, any roles that
were defined in Request modewill be set to inactive.

Self Serve—Registered users can see real-time room availability (in list or grid views). 
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Field Description

Note:
If users require video conferencing, you must choose this
option.

Service Only Request—Allows users to request a service (for example, catering, A/V
equipment, and so on) for a location that is not managed in EMS.

Menu Text Themenu text or link that a EMS Web App user sees when requesting a room using
this everyday user process template.

Available to
NewUsers

Select this option if this everyday user process template is to be automatically
assigned to newly registered users.

Reserve Status Available only for Self Servemode. The default status that is applied to reservations
that are booked in rooms identified as 'reservable' on the Rooms tab.

Request Status Available only for Self Servemode. The default status that is applied to reservations
that are booked in rooms identified as 'requestable' on the Rooms tab.

Conflict Status Available only for Self Servemode. The default status that is applied to bookings
made by users attached to this template that result in a conflict (the room is already
booked).

Cancel Status Available only for Self Servemode. The default status that is applied to bookings
that are canceled by users who are attached to this template.

Rule Violation
Status

Enabled only if Outlook is selected. Used in conjunction with the EMS for Outlook
module. If you carry out an action in the EMS for Outlook module that violates a
booking restriction, then the booking is changed to this status.

Default Setup
Type

The setup type that is selected by default for a room search when a user who is
attached to this template is reserving a room in EMS Web App. The user can always
select a different value.

Allow user
Personalization

Select this option if users must be able to use the Options feature to customize their
settings on EMS Web App pages.

Menu
Sequence

Enter a number that indicates the order in which this menu option is relative to
other menu items that fall under the same parent menu. Items are ordered from
lowest to highest sequence number, with the item with the lowest sequence
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Field Description

number appearing first.

Note:
If you leave the sequence set to the default value of zero for all
menu items, then by default, the items are displayed
alphabetically.

Video
Conference

Select this option if the users who are attached to this templatemust be able to
request rooms that have a video conferencing feature.

Note:
This option is available only for EMS Enterprise. It is not
available for EMS Professional. To use the Video Conference
option correctly with a everyday user process template, the
Self ServeModemust be selected for the template.

Enable for Web
App

Select this option if this process template should be available on EMS Web App.

Enable for
Mobile

Select this option if this everyday user process template is to be available (in an
appropriate format) on a mobile device browser.

Enable for
Outlook

Enables the everyday user process template for use with the EMS for Outlook
module.

Enable
Integration to
Microsoft
Exchange

Enables the integration of templates with your organization's Exchange server
(typically, when your organization does not use EMS for Outlook. Enabled only if
your organization has purchased the optional Integration to Microsoft
Exchange module. Select this option if users who are attached to this templatemust
be able to see the free/busy schedules of the attendees. The user can choose a date
and time that is convenient for all attendees and then send invitations through EMS
Web App, which attendees receive and can manage through Outlook.

Additional Tabs for Booking Template Configuration 
This section provides a conceptual overview of the additional tabs on the Booking Template
Configuration page.
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Booking Rules Tab
You can use the Booking Rules tab to control very specific timing on how users can book, cancel, or
end events.

The Booking Rules tab contains two areas:

l Booking Requirements Area

l Booking Days Area

Booking Rules Tab
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Booking Rules Tab: Booking Requirements Area 

Field Description

Max. No.
Bookings
Allowed Per
Reservation

Maximum number of bookings that a new reservation can contain.

Max. No.
Minutes
Allowed

Maximum number ofminutes for which a new reservation can be created (not enforced
when a user edits a booking).

Use
Cancellation
Cutoff Time

Whether the booking has a cutoff when cancellations can no longer bemade.

Cutoff Time and Number of Days control how far in advance the cutoff is set. For
example, if you enter 3 p.m. and one day, then cancellation must take place before 3
p.m. on the day before the event.

Cancellation
Cutoff
Hours

The number of hours before an event when cancellations can bemade.  For example, if
you enter 24, then bookings cannot be canceled less than 24 hours before they are to
take place, regardless of the time of day. If using this setting, clear the Use Cancellation
Cutoff Time field. 

Cancel
Booking in
Progress

Allows users to cancel events in progress. If selected, the Cancel Booking in Progress
Status option is enabled. Use this field to specify a status to display on this type of
cancellation (configured separately). See Configure Statuses.

Cancel
Booking in
Progress
Status

Sets the status for bookings that are canceled when in progress.

End
Booking in
Progress

Allows users to end in-progress bookings early, which makes the space available to
other users.

Booking Rules Tab: Booking Days Area 
You can use the Booking Days area to indicate how far into the future bookings can bemade and how
much lead time is required to make a booking.  

Fields change depending on your initial selections in Range of Days and Specific Date. The second
dropdown menu sets the lead time requirement and you must select a date in the Only Allow New
Bookings After This Date field.
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Field Description

Specific
Date

If you select Specific Date, then you must specify a value for Only Allow New Bookings
Prior to This Date to dictate the future range.

Only allow new bookings within Range of this Many Days—Set a date in this field if you
want bookings to only be allowed after this date.

Use New Booking Cutoff Time—Enter the cutoff time and number of days at which point
you want to require the Everyday User to submit bookings by that time and number of
days.

New Booking Cutoff Hours—Enter a value in this field if you want new bookings to only be
accepted after the number of hours indicated.

Range
of Days

Selecting this option from the first dropdown means the user will only be allowed to make
bookings within a range of days. You must also specify a value for Only Allow New
Bookings within Range of This Many Days, and you must also indicate a cutoff time or
cutoff hours as you did for cancellations

Only allow new bookings within Range of this Many Days – Set a number in this field to
allow bookings within the number of the days specified (e.g.: 365 would allow an everyday
user to create bookings within 365 days).

Max No. Bookings Per Day—Number of bookings allowed within 24-hour period.

Max No. Bookings Per Date Range—Number of bookings allowed within Range of Days.

New Booking Cutoff Hours—Enter a value in this field if you want new bookings to only be
accepted after the number of hours indicated.

Defaults Tab
You can use this tab to set the default values for Event Type, Event Name, Building, Event Time Start/End,
and Time Zone to automatically populate the Room Requests page when users make reservations; users
can edit them as needed. 

Event Type and Building values are pre-configured.

See Also: Configure Event Types, Configure Buildings, and Set Default Start and End Times.

Video Conference Tab
You can use this tab to control how users can make video conferencing reservations. This tab is available
only in EMS Enterprise and only if the Video Conference option was selected on the everyday template tab.
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For information on how to configure the information on this tab correctly so that assigned users make
video conferencing reservations, see Video Conferencing.

Rooms Tab
This tab enables you to associate the everyday template with specific space. To begin, specify Building (all
buildings, a specific building, an area, or a view) and Room Type search criteria. These are pre-configured.

See Also: 

l Configuring Buildings

l Configuring Areas

l Configuring Public Views

l Configuring Rooms and Configuring Room Types

You can move one or more rooms (CTRL-click) from the Available list to the Request or Reserve panes for
this template. This controls the space that users assigned to this everyday template can book.

l Reserve pane: rooms that can be reserved without approval (booked in the Reserve Status on the
everyday template tab).

l Request pane: rooms that require approval (booked in the Request Status on the everyday template
tab).

Categories Tab  
This tab enables you to set the pre-configured categories of services that users assigned to the template
can add to their bookings by moving them from the Available list to the Selected list. These are pre-
configured. See Configuring Categories. 

Note:
If your Administrator has configured an "Attendee" type category, and assigned it to
the booking template, users can invite or remove attendees on the Services page.

Event Types Tab 
This tab enables you to set which event types users of this template can choose from during the booking
process by moving them from the Available list to the Selected list, or to the Available To All everyday
process Templates list. 

LDAP Groups Tab 
You use this tab to assign Everyday User process templates to users based on LDAP Groups that are
defined in your directory service, for example, Active Directory. Everyday user process templates that are
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assigned via LDAP do not need to be explicitly assigned to user records. When users log in, they “inherit”
the everyday user process templates based on the LDAP groups to which they belong. To assign the one
or more LDAP group, select and move them from the Available list to the Selected list. See Also: LDAP
Authentication.

User Defined Fields Tab  
You can use this tab to control the behavior of your implementation's customized fields for this
template by moving one or more from the Available pane to the Required or Optional panes. These fields
are pre-configured. See Also: Configuring User Defined Fields (UDFs).

Parameters Tab  
This tab enables you to control how this everyday user process template is affected by parameter settings. 

l To edit the value for a parameter, select the parameter, and then click Edit.

l To reset the value for a parameter to its default global value, select the parameter, and then click Use
Global.

Note:
The billing parameter, Billing Reference Validation, includes a special option that affects
whether users are prompted to enter billing and PO information and whether they are
validated.

Users will see the Billing Reference field during the booking process parameters are set at either the
reservation, room, or category level. Whether the Billing Reference field displays is based on four settings:
global, template, room-level setting, category-level setting. The booking template setting overrides the
global setting. The room and category level settings can both override the template setting. After the
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Admin decides whether to display the field, user entries will be validated based on the value in the "Billing
Reference Validation" parameter set (above) on the template.

Billing Reference field options:

l Show (Prompt)

l Require

l Validate (Show and Require)

l Don't Show

Additionally, the Billing Reference Validation parameter will always determine whether it is optional,
required, or required and validated. 

See Also: 

l Configuring Rooms

l Configuring Categories

l Configuring Field Behavior for Billing Reference and PO Numbers

Help Text Tab  
This tab enables you to control the help text that displays to users when they are using this template. By
default, help text items inherit their settings from the global Help Text list. (See Configuring Help Text.) You
can use the list of help text items on the Help Text tab to override the settings for this particular template if
needed.

l To edit the value for a help text item, select the item, and then click Edit.

l To reset the value for an item to its default global value, select the item, and then click UseGlobal.

Menu Text Translations Tab  
This tab enables you to control how your EMS Web App translations appear to users of this template. You
only need to provide information on this tab if a foreign language translation has been defined for everyday
templates. See Configuring Language Translations. For each translation shown here, you can click in the
Text field and enter the appropriate translation for themenu text (themenu text or link that an EMS Web
App user sees when requesting a room using this everyday user process template).

Terms and Conditions Tab  
You can use this tab to set your template to require that its users agree to special Terms and Conditions
before submitting reservations. In the text area, you can create a Terms and Conditions message that
presents when a user selects a room.
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l Design (selected by default) means you use the standard Windows plain text formatting options to
format themessage (spacing, number of lines, capitalization, and so on).

l HTMLmeans you use HTML code to format themessage (spacing, number of lines, capitalization,
and so on) to format your Terms and Conditions.

Accruent Confidential and Proprietary © 2019 Page | 133

CHAPTER 39: Everyday User Process Template Field Definitions



CHAPTER 40: Security Templates
A security template specifies which menu items are available to the users who are assigned to the template,
which fields can be viewed in event tooltips, and other information.

In this section:

l Configure Security Templates

l Assign Security Templates to Multiple Everyday Users

l Everyday User Security Template Field Definitions
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CHAPTER 41: Configure Everyday User Security Templates
A security template specifies which menu items are available to the users who are assigned to the template,
which event information fields can be viewed, and other information.

This topic will provide information on the following steps:

l Enter Security Template Settings

l Assign Roles to Users

l Set Tooltip Display

l Finalize the Template

1. On the EMS menu bar, click Configuration > Everyday User Applications > Everyday User Security
Templates. 

The Everyday User Security Templates window opens. This window lists the one user role
(unauthenticated user) used in the EMS Web App and EMS Mobile App, as well as any other security
templates that have been defined.
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Everyday User Security Templates Window

Note:
The "(unauthenticated user)" role controls what happens when users do not have
a log in access an EMS Everyday User application such as EMS Web App and EMS
Mobile App.
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Note:
The remainder of this procedure describes how to configure a security template
“from scratch.” You can also configure a security template by copying an existing
rule. Select the security template that you want to Copy then skip to Step 3. To
assign an existing security template to multiple users, See Also: Assigning a
Security Template to Multiple Users.

2. Click New. 

The Security Template dialog box opens on the Security Template tab.

Security Template Tab
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Enter Security Template Settings

3. Enter the information for the new everyday user role.

Option Description

Description The description or name for the security template.

Note:
The description can be a maximum of 50 characters,
including spaces.

AllowUser
to Add
Groups

Selected by default. Users who are attached to this security template can select
from a list of existing Groups in your EMS database to add to the users' accounts
when submitting a request or making a reservation.

AllowUser
to Add
Contacts

Select this option if you want users who are attached to this security template to
be able to select from a list of existing Contacts in your EMS database when
submitting a request or making a reservation.

AllowUser
to Set
Default
Contact

Available only if AllowUser to Add Contacts is selected. Select this option if you
want users who are attached to this template to be able to specify a default
Contact for a selected Group when submitting a request or making a reservation.

Assign Roles to Users

4. Roles are the tasks that an assigned user can do. Open the Roles tab, and on the Available list, select
the role (CTRL-click to select multiple roles) for the user(s) are to be assigned to this template, and
then Move (>) to the Selected list.

Role Description

Allow Check
In

Allows a user to check in to a booking from EMS Web App, the EMS Kiosk, and
EMS Mobile App.

Browse
Events

Provides access to the Events calendar in EMS Web App.

Browse  Allows a user to browse for available rooms in a Schedule view.
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Role Description

Create\Edit
an Account

For the (unauthenticated user) template, allows a new user to create his/her
own EMS Web App user account. This new everyday user account is set to
active or pending based on your EMS Web App parameter settings. For the
authenticated users, this role determines if an existing everyday user can access
the Edit My Account area within EMS Web App.

Custom
Events

Provides access to any custom events calendars created.

Delegation Allows EMS Web App users to delegate control of their reservations (new and
existing) to other EMS Web App everyday users.

Browse
People

Allows an EMS Web App user to view a specific Group's reservations for today.

Location
Details

Allows a user to view details (room type, size, phone, features, setup types,
images and so on) about a room.

Login\Logout Allows an anonymous user or “guest” to log in to EMS Web App.

View Floor
Map

Requires the optional Floor Plan module. Allows a EMS Web App user to view
and book rooms on a floor plan.

View
Reservation
Summary

Allows an EMS Web App user to view the Reservation Summary page when the
user clicks on the link from notification/confirmation emails. Note that the
reservation owner, or delegate of the owner, can view the Reservation
Summary page through the email link even if the role has not been assigned.
Administrators can use the View Reservation Summary role to limit access to
reservation information from forwarded emails.

Web
Administrator

Provides access to various administrative functions within EMS Web App such
as clearing the cache, enabling help text edit mode, and enabling detailed
errors.

Expert User A security role that only pertains to EMS Platform Services. This role is required
to access Platform Services API routes for EMS Desktop Client functionality.

Kiosk
Provisioning

This role allows users to log into the EMS Kiosk App as an Administrator and
provision profiles.
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Set Tooltip Display

5. The Booking Details Display Fields tab houses the information that appears when a EMS Web App
user browses events in the Browse Events area or browses for space in the Browse for Space Area.
Open this tab, and on the Available list, select the information you want displayed (CTRL-click to
select multiple items), then Move (>) to the Selected list.

Finalize the Template

6. Click OK. The security Template dialog box closes. The changes are saved to the template and you
return to the security Templates window.

Note:
You can delete a security template by selecting it from the Everyday User Security
Template window and clicking Delete. If the template is assigned to a user, you
will be prompted to assign another template to that user before deleting it. 

You can also print a security template information with the Print button, which will print a list of your
templates or a list of user roles showing how they aremapped to security templates. 

See Also:

l Everyday User Security Template Field Definitions

l Assign Security Templates to Multiple Everyday Users

l Configure EMS Web App Menus

l Configure Intents

l Configure Help Text

l ConfigureWeb Text

l Configure Language Translations

l Configure Confirmation Behavior for Everyday User Applications

l Create Templates for Desks and Workspaces

l Everyday User Process Template Field Definitions

l HowDo I Allow Invitations on a Booking Template?
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CHAPTER 42: Assign Security Templates to Multiple Everyday
Users
When you configure an everyday user, you can assign one security template and multiple process template
to that user. Instead of assigning templates one at a time to individual everyday users, you can assign a
security template to multiple users in a single step.

1. On the EMS menu bar, click Configuration > Everyday User Applications > Everyday User Security
Templates. The Everyday User Security Templates window opens. The window lists security tem-
plates that have been defined for your implementation. The "(unauthenticated user)" template is
reserved for guest users.

Everyday User Security Templates Window

2. Select a security template other than "(unauthenticated user)" to assign to one or multiple users, and
then click the Assign button. The Assign Security Template window opens, first prompting you to
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filter everyday users by status.

Assign Security Template Window – Status

3. Select the user status and then click Next. The Assign Security Template window updates to list users
to whom you can assign the security template.

Assign Security Template Window – Everyday Users
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4. Narrow the selection of users you want to assign to the template using either of the following meth-
ods:

l To assign the selected security template to all the users you picked in Step 3, click the Apply to
All Everyday Users checkbox.

l To assign the security template to only a few of the users you picked in Step 3, search for them
in the Find field (using the other fields in this area to narrow your search), and click Display. The
users who meet your search criteria are displayed in the Available list.

5. On the Available list, select the user (CTRL-click to select multiple users) to whom you are assigning
the template, and then Move (>) to the Selected list.

6. Click Finish. Amessage confirms that the template was assigned successfully.

7. Click OK to close themessage and return to the Everyday User Security Templates window.
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CHAPTER 43: Everyday User Security Template Field Definitions

Security Template Tab

Option Description

Description The name for the web security template.

Note:
Maximum of 50 characters, including spaces.

AllowUser
to Add
Groups

Enables users to add existing Groups for which they book space to their accounts.
Selected by default. Users can add existing Groups for which they make reservations to
their accounts.

AllowUser
to Add
Contacts

Enables users to indicate if a Contact should appear by default when the Group is
selected for a reservation. Select this option if you want users to add existing Contacts
to existing Groups on their account.

AllowUser
to Set
Default
Contact

Available only if AllowUser to Add Contacts is selected. Select this option if you want
users to assign default contact for a Group when making reservations.

Roles Tab

Role Description

Allow Check In Allows a user to check in to an event in rooms requiring check-in.

Browse Events Allows the user to view a schedule of events at the organization as well as
more information about these events.

Browse Locations Allows the user to view a schedule view of rooms at the organization.

Create\Edit an
Account

Allows new unauthenticated users ("guests") to create user accounts (set to
Active or Pending based on your parameter settings). For authenticated
users, allows users to change their account information. 
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Role Description

Custom Events Allows users to view a customized schedule of events created by an
Administrator using the Generate Custom Link utility.

Delegation Allows users to assign other users as delegates for impersonation. 

Browse People Allows users to look up Groups at their organization to see where these
Groups aremeeting today.

Location Details Allows users to view details (room type, size, phone, features, setup types,
images and so on) about a room or a building. 

Login\Logout Allows unauthenticated users ("guests") to log in to EMS Web App.

View Floor Map Requires the optional Floor Plan module. Allows a Everyday User to view and
book rooms on a visual floor plan. If licensed for the additional Floor Map
module, users can view and request rooms from a floor map of a building. 

Web Administrator Enables the Admin Functions menu option for these users designated as
administrators. Themenu controls various administrative functions within
EMS Web App, such as clearing the cache, enabling help text edit mode,
displaying detailed error messages, and configuring optional integration
modules.

Expert User A security role that only pertains to EMS Platform Services. This role is
required to access Platform Services API routes for EMS Desktop Client
functionality.

View
ReservationSummary

This security role allows Administrators to configure unauthenticated access
for viewing reservation summary details.

For example, if a host forwards a confirmation with a View Reservation
Summary link, this security role allows the recipient to view the full details of
the reservation when clicking the summary link.
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CHAPTER 44: Email an Everyday User
Whether your organization uses Microsoft Outlook or SMTP, you can email an everyday user.

Note:
If your organization uses Microsoft Outlook, you can continue to use this email system
to send emails to users; otherwise, to email a user using the SMTP option, your EMS
Desktop Client user account must have an email address.

1. Search for the user whom you are emailing. See Also: Searching for a user.

2. On the user's window, make sure that the user is selected in the lower pane, and then clickMore >
Email.
Depending on how your system is configured, either a pre-addressed Outlook email form or a pre-
addressed SMTP email form opens. The To field is populated with the email address that is defined
for the user, but you can edit this value if needed.

3. Complete and send the email as you normally would.
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CHAPTER 45: Configure Web Menus
When EMS Web App is first installed, themain menu has a layout that determines the following:

l The default parent menu options.

l The order of the parent options in themain menu.

l The child options that appear under each parent menu option.

l The order of the child options under each parent menu option.

You can add customized menu items to the existing list of system menus. These custom items can be links
to EMS Web App pages or to websites outside EMS Web App.

1. On the EMS menu bar, click Configuration > Everyday User Applications >Web App Menus. The
Web App Menus window opens. This window lists all the current parent menu items and child
options in alphabetical order. Buttons to the right enable you to create newmenus, change existing
ones, delete, and print.
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Web App Menus Window

2. To configure a newmenu, click New. TheWeb App Menu dialog box opens. TheWeb App Menu tab
is the active tab.
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Menu Tab of the Web App Menu Dialog Box

3. Enter the information for the newweb menu item.
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Menu Tab Field Descriptions

Field Description

Menu Text The text for the item as it is to appear on the EMS Web App menu.

Sequence A number that indicates the order in which this menu option is to appear
relative to other menu items that fall under the same parent menu. Items are
ordered from lowest to highest sequence number, with the item with the
lowest sequence number appearing first.

Note:
If you leave the sequence set to the default value of zero
for all menu items, then by default, the items are
displayed alphabetically.

Link The URL or web address for themenu (for example, www.myorganization.com).

Parent Menu The primary menu under which this new menu item is found.

NewWindow Select this option if this newmenu item should open in a new browser window
or tab (with EMS Web App remaining open behind the newwindow or tab.

Authenticated
Users Only

Select this option if access to this newmenu item is restricted to only those
users who have logged in to EMS Web App.

4. If translations have been defined for web templates (see Configuring Language Translations), then
open the Translations tab, and for each translation, click in the Text field, and enter the appropriate
translation for themenu item.

5. Click OK. TheWeb App Menu dialog box closes and returns you to theWeb App Menus windowwith
the newly configured menu option displayed in the window.

Note:
If you have EMS Web App open, you might have to log out and then log back in to see
the newmenu item.
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CHAPTER 46: Configure Help Text
Since the EMS Desktop Client is the "backbone" for all editions of EMS, such as EMS Web App and EMS
Kiosk, it enables you to customize the text that appears to users of those applications in your organization.
This help text displays on various pages in EMS Web App, EMS Kiosk, EMS for Outlook, EMS Campus
Planning Interface, and the EMS Floor Plans Utility. As the EMS administrator, you can configure this help
text in EMS, or if you are assigned to an appropriate everyday user security template (which has
administrator access), you can configure it directly in EMS Web App.

This topic provides information about the following:

l Configure Help Text in EMS Desktop Client

l Configure Help Text in EMS Web App

o Enable the Custom Help Text Feature

o Navigate to Pages in EMS Web App and Customize Help Text

See Also: ConfigureWeb Text in EMS Desktop Client

Note:
Depending on your organization, configuration in the EMS Desktop Client might need
to be performed by a different type of System Administrator than configuration and
text customization in the EMS Web App.

Configure Help Text in EMS Desktop Client
Follow the instructions below to enable custom help text for EMS Web App and/or EMS Kiosk.

1. On the EMS menu bar, click Configuration > Everyday User Applications >Help Text. The Help Text
window opens. This window lists the name or description for all types of Help Text that is currently in
use in your EMS Web App and EMS Kiosk installations and the EMS Web App or EMS Kiosk page on
which it appears. To filter for only a specific type of help text, select a type on the Type dropdown list.

Accruent Confidential and Proprietary © 2019 Page | 151

CHAPTER 46: Configure Help Text



Help TextWindow

Note:
You can view all help text including the text not in use: select Obsolete. Obsolete
Help Text is displayed in red and italics in the Help Text window.

2. Select the Help Text that you are configuring, and then click Edit. The Help Text dialog box opens. The
Help Text tab is the active tab. The tab contains options for entering and configuring the help text.  
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Help Text Tab

3. Configure the needed help text.

l Design is selected by default. Use the standard Windows plain text formatting options to
format themessage (spacing, number of lines, capitalization, and so on) so that it is displayed
the way that you want in the help text.

l Select HTML and enter the necessary HTML code to format themessage (spacing, number of
lines, capitalization, and so on) so that it is displayed the way that you want in the help text.

4. If translations have been defined for everyday user templates (see Configure Language Translations),
then open the Translations tab, and for each translation, click in the Text field, and enter the appro-
priate translation for the Help Text item.

5. Click OK. The Help Text dialog box closes. You return to the Help Text windowwith the newly con-
figured Help Text item automatically selected in the window.

Configure Help Text in EMS Web App
Once Help Text customization is enabled in the EMS Desktop Client, System Administrators in the EMS Web
App can follow the instructions below to customize the applications help text. First, you enable the feature,
then you navigate to each page in EMS Web App that you want to customize and enter help text.
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Enable the Custom Help Text Feature

1. Log in to EMS Web App.

2. In the dropdown menu next to your name, click Admin Functions. 

3. The EMS Web App Administrator Function page opens.

Administrator Functions Page with Enable Help Text Edit Button Showing

4. Click Enable Help Text Edit. A confirmation message appears indicating that Help Text Mode is now
enabled.
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Administrator Functions Page with Disable Help Text Edit Button Showing

Navigate to Pages in EMS Web App and Customize Help Text

1. Navigate to the EMS Web App page where you want to customize Help text. The Edit option is avail-
able in the upper, right corner of the page.

Edit Option Available in Upper, Right Corner

2. Click the option. An edit window launches where you can customize the help text (click Edit to enter
your custom help text).
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Help Text Edit Window

3. If your help text should appear in another language, select a language option in the dropdown field.

Language Field of Help TextWindow (After Selecting Edit)

Note:
Options in the Language drop-down are controlled by another Administrator
setting, see Language Translations.
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4. After entering and configuring the Help text, click Save Changes to apply the text to the selected
page.
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CHAPTER 47: Configure Language Translations for Everyday User
Applications

Note:
Previous versions of EMS referred to this feature as "Web Cultures."

If you need to add language translation capability for your Everyday User templates or EMS Kiosk pages
(menu text, menu items, and help text items), then you must configure language translations.
Each translation you configure represents a language for which translations must be provided in your EMS
Everyday User Applications.  

Build Your Language Translation Spreadsheet (EMS Web App)

Note:
The EMS Kiosk App uses a JSON translation file instead of a translation spreadsheet. See
Configure Language Translations in EMS Kiosk App for more information.

1. EMS Software provides a Microsoft® Excel spreadsheet specific to EMS Web App that contains all of
the application labels, page titles, system messages and error messages with their English trans-
lations.

Note:
Values for data items (e.g. Event Types like “Meeting”, “Training”, etc. or Room
Types like “Workspace”, “Conference Room”, etc.) configured within EMS or
dynamic information that is inputted by an EMS user or Virtual EMS web user
(e.g. Event Name like “HRMeeting”, Comments, Special Instructions, etc.) are not
translated. 

2. The customer is responsible for providing the translated values for the information in the product
spreadsheet. Once the customer returns the fully translated product spreadsheet to EMS
Software, EMS Software development teams compile the spreadsheet into a product-specific lan-
guage folder containing a set of files. (Wemaintain a language folder for each language).

3. The customer saves the language files in the "App_GlobalResources" folder within the EMS Web App
physical directory on their web server. (The default path is C:\inetpub\wwwroot\emswebapp\App_
GlobalResources\). 

Important!
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For the translation to affect an Everyday Applications user, two conditions should
bemet:

a. The language setting should be set in Windows.

b. The end user’s browser Language Preference is set to that specific language
and set as the default.

Example Successful Installation

Reflected in EMS as follows (example is French-Canadian).

Configure Your Language Translations in EMS Desktop Client 

1. On the EMS Desktop Client menu bar, click Configuration > Everyday User Applications > Language
Translations. The Language Translations window opens, listing all the translations that are currently
configured in your EMS database.
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Language Translations Window

2. Click New. The Language Translation dialog box opens. By default, the language is set to English
(United States).
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Language Translation Tab

3. In the Description field, enter a name or description for the newweb culture (up to 50 characters,
including spaces).

4. On the Language dropdown list, select the language into which themenu text, menu items, and help
text items will be translated.

5. Click OK. The Language Translation dialog box closes, returning you to the Language
Translations windowwith the newly configured translations automatically selected.

Note:
After you configure a language translation, it is displayed on the Translations tab in
various configuration areas in EMS.
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CHAPTER 48: Customize EMS Web App
After you have installed the EMS Web App, you can customizemany aspects of it, such as the appearance
and security settings. For example, you can change the look and feel of the EMS Web App by inserting your
own logo. Experienced web developers can also modify the system’s style sheet to change fonts and colors.

Important!
Do not alter any of the EMS Web App web page files themselves. The maintenance
agreement for EMS Web App extends to the original page content only.

This topic provides information on the following: 

l Customize the Logo

l Customize Style Sheets

l Customize Links

l Customize JavaScript

l Customize Security

Customize the Logo
The logo that appears in the upper left corner of all pages within the EMS Web App comes from a file
named LOGO.GIF found in the \EMSWebApp\Images folder of the web server. If you choose to have the
system display a different logo, create a new file called CUSTOMLOGO in the same folder (any graphics file
type, such as .gif, .png, etc. will suffice). If the system detects CUSTOMLOGO, the system will use that file
rather than the default LOGO.GIF file. The advantage of creating the new file instead of simply replacing the
LOGO.GIF file is that, in an upgrade to a new version of EMS Web App, the LOGO.GIF file is overwritten
whereas CUSTOMLOGO is not. If you create a custom logo file, you might need clear your browser’s cache
before you see the new image.

Note:
Be sure to maintain the aspect ratio of 135 px wide X 40 px high. The system will accept
nearly any size logo image, but you should avoid images more than 200 pixels wide and
images that are too tall to avoid extra scrolling.

Customize Style Sheets
Experienced web developers are can modify the look and feel of EMS Web App using a custom style sheet,
which controls fonts and colors throughout the application. To do so:
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1. Create EMSWebApp/Content/Custom folder on your web server.

2. Name your custom style sheet CUSTOM.CSS and place it in the EMSWebApp/Content/Custom
folder. If the system detects this file, it will use the styles found there rather than those in the sys-
tem’s default style sheet, VEMS.CSS. The advantage of creating the new file instead of overwriting the
default file is that, in an upgrade to a new version of EMS Web App, VEMS.CSS is overwritten whereas
CUSTOM.CSS is not.

Customize Links
The EMS Web App Browse Events page allows users to view all events scheduled in EMS that display to
everyday users. You have the option to automatically filter this list of events by facility, room, event type,
event name or group name as part of a customized Browse Events page. This customized page is referred
to as a Custom Link.

Note:
A Custom Link enables you to build a link based on the Browse Events page that will
display only events meeting your specified criteria. For example, you can create a link
that only displays events in a specific Building or of a specific Event Type. Essentially, the
link pre-filters the event listing displayed to a specific building, event type, Group, etc.
Once you generate the link, then you can insert it in emails or websites.

To create a Custom Link, follow the steps outlined below.

1. Log into EMS Web App using a user ID that belongs to a Everyday User Security Template containing
theWeb Administrator Role. For information on how to configure a user and/or Everyday User Secur-
ity Template, see Configure Everyday Users and Configure Security Templates.

2. Under the dropdown menu next to your name, click Create Custom Link.
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3. Specify the pre-filters that will control what displays when users click your custom link.
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Note:
To display a custom logo other than the default logo used for your EMS Web App
site, enter the logo filename and server path in the Logo field. The logo needs to
be stored in the EMS Web App physical directory on your web server
(typically, C:\inetpub\wwwroot\EMSWebApp\).

Select the Ignore Everyday User Application Display Settings option if you want
all events within your criteria to display to users using this link regardless of
everyday user display settings (essentially, ignoring configuration rules that
would normally hide certain events from view).

Select the Collapse Bookings to Reservation-Level option to collapse booking
information so that only the reservation information shows. 

Collapse Bookings to Reservation Level
Enabled

Collapse Bookings to Reservation Level
Disabled

4. Click theGenerate Link button to display a friendly URL and HTML code that can be added to a web
page, email, etc.  The URL can also be used to test your Custom Link.
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Customize JavaScript
With custom JavaScript, you can extend the functionality of EMS Web App to suit your business needs.

Important!
Including custom JavaScript on EMS Web App pages can affect performance.

When EMS Web App receives a request for a page, it checks for the existence of a CustomJs folder. If the
folder exists, EMS Web App checks for any files that match the name of the page. For instance, on the
RoomRequest.aspx page, if there is a file called RoomRequest.js in the CustomJs folder, EMS Web App will
include the RoomRequest.js file on the page.

In addition to the name-matched file, EMS Web App will also check for and include the file named global.js
on EVERY page.

Perform the following steps to enable Custom JavaScript:

1. Enable Custom JavaScript.

2. Open the EMS Web App web.config file (typically, C:\inetpub\wwwroot\EMSWebApp\web.config).

Note:
EMS CLOUD CUSTOMERS:Modifications to the web.config file must be
performed by EMS Cloud Operations. To request these changes, please contact
EMS Support.

3. Locate the following node under the <appSettings> node:
<add key="allowCustomJs" value="false" />

4. Change the false value to true.

5. Save the file.
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6. Create the CustomJs folder within the root of your EMS Web App Install Directory (typically, C:\inet-
pub\wwwroot\EMSWebApp\CustomJs).

You are now ready to implement your Custom JavaScript using one of several options:

l In the newly-created CustomJs folder, create a file for each of the above pages you want to include
your custom JavaScript on (such as RoomRequest.js, EditReservation.js, or Default.js).

l In the newly-created CustomJs folder, create one file called global.js that will be included on every
page in the system.

Your custom JavaScript should be included on global.js or on each of the applicable page-specific JavaScript
files.

Important!
If you include the script in both places, it could cause problems.

Customize Security
There are settings in the web.config file that you can customize to enhance website security. For more
information regarding these security settings, contact EMS Support.

Contact Customer Support

l Option 1 (Recommended): Search the Knowledge Base available at Accruent Access.

l Option 2: Submit a case directly via Accruent Access.

l Option 3: Email emssupport@accruent.com.

l Option 4: Phone (800) 288-4565.

Important!
If you do not have a customer login, register here.
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CHAPTER 49: EMS Web App System Parameters
Parameters for the EMS Web App are configured in the EMS Desktop Client. As an EMS Administrator, you
can access these parameters by navigating to System Administration > Settings > Parameters > Everyday
User Applications tab.

Parameters for the EMS Web App
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CHAPTER 50: EMS Web App User Guide
EMS Web App is an optional web application to access online. EMS Web App lets you see your schedule,
create new reservations, and change existing reservations.

If you have deployed an older version of EMS Web App and are upgrading to the newest version, please
encourage users at your facility to review {seeWhat's New} before they begin working with the new version
of the software. Doing so will streamline the adoption of the new release and help your users benefit from
new features and functions that they might not otherwise discover.

The EMS Web App provides extensive spacemanagement functionality so that web users, including guests
and temporary visitors, can view and book space while on-the-go, using any web browser.

This User Guidewill provide the following information:

l Get Started with EMS Web App

l Browse Events, Locations, and People

l Create a Reservation in the EMS Web App

l Personalize Your Account

l MobileWeb App

l Learn About the EMS Web App

l Skype for Business in the EMS Web App
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CHAPTER 51: Get Started with the EMS Web App
EMS Web App is a web-based application that allows users to browse events in a calendar, view facility
information, and if allowed, submit and manage room reservations and service requests. To get started,
see the following topics: 

l Log In and Out

l Check In To Events

l Introduction to the Home Page

l Create Your Login or Get a New Password

Note:
Upgrading Users may know EMS Web App as VEMS. For details about the
enhancements in this new release, seeWhat's New.
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CHAPTER 52: Log In and Out
You can access EMS Web App through any standard Internet browser. This topic provides information on
the following:

l Log In

l Log Out

Log In

1. Open an Internet browser session and navigate to your EMS Web App URL. (Contact your EMS
Administrator if you need assistance.) The EMS Web App home page opens and prompts you to sign
in.

Note:
If your Administrator has enabled Guest Accounts, you can create a Guest
Account using the green buttons to the right. When logged in through a Guest
Account, you can request rooms; however, room requests must be approved by
designated users in your organization.

2. In the Email Address field, enter the email address and password for your EMS User Account. Click
for help with your password or contact your Administrator if you don't have one. 

3. Click Sign In. The window changes to show your MY HOME and offer more options for creating reser-
vations and for browsing events, locations, and people. For an overview, see Introduction to the
Home Page.
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Log Out

1. To log out, click the dropdown arrow under your name in the upper-right corner of the EMS Web App
window.

2. Click Sign Out.
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CHAPTER 53: Check In To Events
You can check in to your events in theMY EVENTS area on the EMS Web App main menu.

1. Click the Check In button next to the event (when available). Your Administrator sets a time limit
on how soon you can check in before an event.

2. Once you have checked in to confirm your attendance, the booking shows on your MY HOME tab as
Checked In.

Note:
The Booking Level Check-In Rolemust be enabled in EMS Web App by your
Administrator by adding the Check In/Check Out Role to aWeb Security
Template.
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Note:
In Version 44.1, several functions that were available in previous releases are no
longer available, including: Building level Check-in/Check-out, check in a group via
the Locate Group web menu, and the Check In/Check Out web menu.
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CHAPTER 54: Introduction to the Home Page
Once you have signed in to EMS, you will see a menu on the left and your home page on the right. To begin
making a reservation, click CREATE A RESERVATION. To explore events, locations, and people, use the
options under BROWSE.

Note:
If not all options display or you are logged in as a Guest, you may need a User Account
created by your Administrator.

Main Menu
Themenu on the left enables you to: 

l CREATE A RESERVATION

l MY EVENTS (shows your events in a calendar grid by Day, Month, or Date)

l BROWSE 

o EVENTS in a calendar grid

o LOCATIONS (Buildings, Facilities, Regions, and Rooms)

o PEOPLE

l LINKS (your favorite shortcuts)

My Home
Information on your home page varies depending on your Administrator's settings and User
Preferences. For most users, the page shows three regions:

l My Reservation Templates—different types of reservations you can make

l My Bookings—your reservations
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l My Infographics—a summary of your activity

Note:
Anywhere you see "..." on a room name, you can click to expand and see the full room
name.

Site Home
Clicking the SITE HOME tab will show your organization's customized EMS home page.
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CHAPTER 55: Create Your Login or Get a New Password
1. From EMS Web App Log In screen, if your Administrator has enabled it, you can create a newAccount

using the Create an Account button to the right.

Note:
If enabled, you can Request a Room as a Guest. These requests must be
approved by designated users in your organization.

2. Once the Create an Account dialog appears, complete the required fields (red outlines). 

l You can opt out of receiving automatic emails from EMS Web App such as event reminders, con-
firmations and summaries. Thesemight trigger when you make reservations and or view or
modify miscellaneous notes for your account.

l You will be prompted to enter an authentication code. The code is case-sensitive and must be
entered exactly as it is displayed. If you cannot read it, click Show another code.

l EMS Web App does not impose any rules on how to compose your account’s password; how-
ever, you might have to adhere to your organization’s standards for passwords.

3. Click the Save button to activate your new account or send it for approval to your Administrator,
depending on your implementation. 
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CHAPTER 56: Browse Events, Locations, and People
The BROWSE section of themain EMS Web App menu enables you to explore Events, Locations, and
People.

This section will provide information that will allow you to do the following:

l Browse Events

l Browse Locations

l View Floor Plans

l Locate People

l Event Details Page

Browse Section of the EMS Web App
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Updates to the Browse Section
The previous version of this application, Virtual EMS (VEMS), had different menu options. See the following
table for a comparison of VEMS and Web App menu options.

Menu in
VEMS

Menu in EMS
Web App

How Is This Better?

My
Requests

Events Expands the view to all events, instead of only those you
requested

Browse for
Space

Locations Expands the view to Facilities, Buildings, Views (custom collections
of space), and Room

Browse
Groups

People Expands the view to Groups, individual Users, and custom user
types
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CHAPTER 57: Browse Events
You might want to browse and explore existing events before you make a reservation in order to build
familiarity with facilities, related or adjacent events, and other users' reservations. The BROWSE EVENTS
page displays events in a daily (default), weekly, or monthly view.

Note:
To view and work with your own reservations and bookings, see View Your Events.

This topic provides information on the following: 

l Browse Events BeforeMaking a Reservation

l Browse Events Using Filters

Browse Events Before Making a Reservation

1. Click Browse > Events in themenu bar.

2. To browse existing events from BROWSE EVENTS, click on an event name. This shows Event Details in
a popup.
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3. To see Room information, click the room name.

Browse Events Using Filters
You can use filters along the top of the Browse Events window to narrow your results. These are
explained below.

Note:
Your Administrator might have set up special preset views and filters for you. If you
save your filter settings, they are remembered the next time you open the Browse
Events page.

View Description

Daily Events scheduled for the current day’s date in a list view.

Weekly Events scheduled for the current week (weeks always begin on a Sunday) in a list view.

Monthly Events that are scheduled for the current month in a calendar view.

To filter basic information, use the filters along the top of the window.
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Basic Filters How They Work

Date The date on which the viewwill focus. 

Time Zone The time zone in which to display the schedule.

To filter in more detail, click the drop-down option.

Detailed Filters How They Work

Locations Browse only events for the location you select.

Room Browse only events for the room you select.

Group Browse only events for the group you select. 

Event Name Browse for a specific event by name. 

Group Type Browse for all events for a type of group you specify.

Room Types Browse for events in a type of room you specify.
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CHAPTER 58: Browse Locations
The EMS Web App LOCATIONS menu option helps you explore facilities and booked space and is especially
useful when you knowwhich space you want and need to find time slots when the space is available. Once
you have located an available time slot, you can click CREATE A RESERVATION from themain menu to
book space.

1. From the left menu in EMS Web App, click BROWSE > LOCATIONS. The Browse Locations page
shows available rooms in a calendar view.
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Note:
Filters along the top of the Browse Locations page enable you to quickly focus
the view on rooms in a specific time frame and by room features, such as
equipment, room type, and geographic location. This helps you find available
space to quickly meet your requirements. To add and remove location filters, click
the Add/Remove Locations option, which presents a Locations filter popup
where you can select by building, area, and view.

2. To learn more about a location, click the location name. The Location Details window appears (if you
have permissions), showing details about the location. 

3. Click View All Building & Room Details to see details. Depending on how your Administrator has
configured your EMS Web App application, the window can show varying information about the loc-
ation, including the building details (name, description, and/or notes), photos and floorplans
(images), description, room type, setup type, and other features. (For detailed booking instructions,
see Create a Reservation in the EMS Web App.)
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Note:
The LINKED TEMPLATES tab might be available, depending on your
implementation. This option will allow you to make a reservation for this room.
Once you locate a room you want to book, use this shortcut to quickly begin the
process.

Anywhere you see "..." on a room name, you can click to expand and see the full
room name.
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CHAPTER 59: View Floor Plans
If your administrator has associated floor plans with spaces administrator has associated floor plans with
spaces (which requires your organization to license and install the EMS Floor Plan Utility) when you browse
for space by booking an event or viewing locations, you will see the floor plan icon next to the room. Click
the floor plan to view visual details about the space.
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CHAPTER 60: Locate People
You can click BROWSE > PEOPLE from themain EMS Web App menu to find a Group or Host who is
scheduled to have a meeting, event, or workspace reservation. You can locate space in close proximity to a
colleague with a workspace reservation or find the location of a meeting you are attending.

Note:
Previous releases of EMS called this "Locate a group."

To search for a reservation hosted by a specific person or group, enter at least the first three letters in
theName field (EMS Web App will suggest the closest match), and then click Search.

Note:
The Search field is not case-sensitive and you can search by any portion of the
Group/person's name.

While the default number of search characters is three, this number can be configured
by your EMS Administrator through theMinimum Characters to Initiate Type Ahead
Search parameter. See Also: Everyday User Application Parameters.

Note:
From the results, you can click the Event Name for more details, to add to your
personal calendar, or to share on social media. You can click the Location field for more
information about the location including properties, applicable set-up types and
corresponding capacities, and built-in features. You can click the Floor Plan icon to
reveal where the location is situated on a floor map (requires module purchase and
configuration).
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CHAPTER 61: Event Details Page
To browse existing events from BROWSE EVENTS, click on an event name. This shows Event Details in a pop
up.

Note:
To add the event to your Outlook calendar, select Add Event to Calendar from the
Event Details pop up.
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CHAPTER 62: Overview of Creating a Reservation in the
EMS Web App
This section provides all the information you need to create and manage reservations and bookings in the
EMS Web App.

l Creating a Reservation

l Different Ways to Create Reservations

l Viewing Your Events

l Searching for Available Rooms

l Booking Multiple Rooms

l Booking Recurring Meetings

l Booking a Video Conference Room

l Booking a Desk or Workspace

l Adding Reservation Details

l Adding Services to a Meeting

l Working with Services

l Canceling Your Reservations and Bookings

l Editing Reservations and Bookings

l Inviting Attendees with EMS for Outlook

l Notifications in the EMS Web App

Accruent Confidential and Proprietary © 2019 Page | 189

CHAPTER 62: Overview of Creating a Reservation in the EMS Web App



CHAPTER 63: Create a Reservation in the EMS Web App
This topic provides information on creating a reservation in the EMS Web App:

l Create a Reservation

o Specify When and Where

o Specify Who and What

n Choose Services (Optional)

o Finalize Reservation Details

o EMS for Outlook® (Optional Capability)

Note:
For a conceptual overview, be sure to review the following:

l Reservations, Bookings, and Booking Details

l Reservation vs. Booking

l Ways to Make Reservations

l Booking Templates

Create a Reservation

1. You can begin making a reservation by clicking the CREATE A RESERVATION option (on the left menu)
or the Book Now button next to one of your reservation templates (on the right).

2. Next, the Create a Reservation screen appears, where EMS Web App will lead you through the reser-
vation process. Enter information (including all required fields) using the Next Step button to
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advance through the process.

Specify When and Where

1. To specify When, select dates, times, recurrence (optional), and time zone for the reservation in the
upper left panel.

2. To specify Where, in lower left panel, select one of the following:

l Let Me Search for a Room
OR

l I Know What Room I Want

Note:
Filters in this lower left panel help you narrow your Room Search Results. When
you click Search, results appear on the right. From these results, you can view
expanded Room Details by clicking on the room name.

Locating space as part of the reservation process is different than browsing
locations. See Also: Search for Available Rooms.
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Note:
Once you have established favorites, EMS Web App uses these (plus the
parameters of the booking template in use) to filter your search results when you
use the Let Me Search For A Room option. To expand your search results
beyond your favorites, de-select the Favorite rooms only checkbox or click
Add/Remove next to Locations.

3. Once you have located a room to reserve, click the Add (+)icon to add the booking to your cart. You
can delete or change the room before finalizing your Reservation.

Note:
If you are booking video conferences or multiple rooms, see Book a Video
Conference Room and Book Multiple Rooms. Then, skip to Step 6.
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Specify Who and What

4. In the Attendees area (near the center of the screen), specify headcount and attendees.

l If your organization has installed and configured Integration to Microsoft® Exchange, you will
be able to add or remove attendees and view attendee availability in the calendar grid of the
Attendees section in the EMS Web App. Your attendees will also be sent invites after you finish
creating the reservation. Attendees can be individuals, mailing lists, or groups; however, you
cannot add attendees outside your domain. To see who is in a mailing list or group, add the list
or group and click the (+) symbol next to the list or group in the calendar grid.

l If your organization does not use Integration to Exchange, you will see a list of EMS Web App
users and groups, but you will not see a calendar grid showing their availability.

Note:
Adding attendees to an event is different than browsing people. For detailed
instructions on using the BROWSE PEOPLE option from themain menu. See Also:
Searching for People.

Note:
If available, select a Setup Type (if available) for the reservation; this associates
likely services and features with bookings.

5. Once you complete all required fields on this tab, click Next Step in the upper-right corner.

Accruent Confidential and Proprietary © 2019 Page | 193

CHAPTER 63: Create a Reservation in the EMS Web App



Choose Services (Optional)

Note:
Choose Services is an optional feature based on the booking template you use. Services
include room setup and teardown, equipment, and any other services you want to
associate with a room. Your Administrator sets which services can be associated with a
room and with an event type.

6. Under the Services tab in the Create Reservation screen, specify any services you want to associate
with the reservation (if available, you can click Skip Services). The example below showing a work-
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space booking may differ from your administrator settings, such as catering options and billing.

7. When complete, click Next Step in the upper right corner. 

Finalize Reservation Details 
The Reservation Details screen finalizes information about your reservation. Invitations to bookings and
attachments will be sent to all attendees. The example shown belowmay differ from your implementation.
For an in-depth overview of this part of the booking process, see Add Reservation Details.
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8. Complete all required information. Then click Save Reservation Details and Create Reservation.
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Note:
To add the reservation to your Outlook calendar, click the Add this reservation
to my calendar checkbox at the bottom of the window.

EMS for Outlook® (Optional Capability)
EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will
see the EMS add-in icon in your Outlook application. You will also see additional features and functionality
in EMS. Furthermore, anywhere that you see people or groups in EMS, you will have access to everyone in
your organization's email database (which is stored in Exchange Server). This means that you can see
people's availability (Out of Office, Busy, In a Meeting, etc.), send them email invitations or notices, and
add EMS events to your Outlook calendar.
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CHAPTER 64: Ways to Make Reservations
The EMS Web App provides several ways for you to make a new room request or event reservation:

Request a Reservation 
If you logged in as a guest, you can submit a reservation request that will be approved by an authorized
EMS Web App user. 

Create a Reservation 
Click CREATE A RESERVATION from themain menu. Then select a template to streamline the booking
process and browse for available time slots and rooms.

Book Now Using Your Template 
Click the Book Now button next to the template you prefer from your home page, and then browse for
available time slots and rooms.

Browse and Then Book 
Click BROWSE (main menu):

l Browse EVENTS. Then request a reservation or, if authorized, click CREATE A RESERVATION from the
main menu and select a template to streamline the booking process.
OR

l Browse LOCATIONS, find the room you want, and click on any blank slot in the room's calendar. Then
select a template to streamline the booking process.
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Note:
First Browse and Then Book. To familiarize yourself with the locations in your
organization, try Browse Events, Locations, and People before requesting rooms
or making reservations. Exploring the EMS Web App this way helps you explore
available space, view the schedule at a high level, and understand how other
users in your organization reserve rooms. You can also establish your own
naming conventions for your events and narrow down your searches to specific
room types, room features, event types, geographical areas, and so on.

Concepts: Booking Templates, Requests, and Reservations. Click for more...

l Templates: Your My Account settings contain reservation Templates created by you or your Admin-
istrator to streamline the process of booking events. Rooms and workspaces are individually set to
work with various types of booking templates by your Administrator.

l Requests vs. Reservations: Depending on your permissions, you may Request a Room orMake a
Reservation. Room requests require approval from a more supervisory user, and are visible to other
users so they know the space has been tentatively booked. The EMS Web App behaves differently for
each type of user, showing fewer options (and usually, less information) for those who can only
request rooms.

The Reservation Process: Who and What, Where and When
What's the difference between a "reservation" and a "booking?" A Reservation consists of one or more
Bookings. That's it.
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Every booking belongs to a reservation. EMS lets you have multiple bookings under a single reservation.
When you havemultiple bookings in a reservation, each booking can be independent of the other, such as
reserving a set of rooms for an event, or can be a series of bookings under a Recurring reservation.

Each booking can contain multiple Booking Details, which are the resources and services required to
support the booking, such as catering and room setup.

Reservations: Who and What
A reservation is the "who and what" of an event. For example, the Academic Planning Board (the who)may
reserve space for a Semester Kickoff event (the what). 
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Bookings: Where and When
A booking is the "where and when" of an event. For example, the Academic Planning Board schedules the
conference room (the where) for a staff meeting on the second Monday in January (the when). The
Academic Planning Board now has a single reservation with a single booking in EMS. If, however, they
schedule the conference room (the where) for a staff meeting on the second Monday of each month for a
year (the when), then the board now has a single reservation with 12 bookings.

Booking Details
A booking can have one or more booking details associated with it. Booking details are the resources
(items for themeeting) or services (people and their activities) that are needed for an event, the notes for
the event, the activities for the event, the room charges for the event, or any combination of these. For
example, for the Academic Planning Board’s staff meeting, the resources could include catering (coffee
service, bagels and muffins, and so on) and A/V equipment, plus the services of a person bringing in and
setting up a projector, moving a speaker’s podium, and so on).

Service Orders

System Administrators configure "buckets" of these details as "Categories," which streamlines the process
of adding details to bookings. 

Concept: Services, Categories, and Resources: What's the Difference? Click for more...
In EMS, you may hear these terms used interchangeably sometimes, however, they are different concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture,
Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of
six Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources
Without Service Orders. These types cause the service to behave slightly differently when added to a
booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it, and there is nothing for a person to “select” from these types of
services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource
without a Service Order Category, will require the Administrator to create items under it. For example,
an "AV Equipment" service category (configured as a Resource without a Service Order Category type)
might have items under it such as a flip chart or whiteboard (under AV Equipment). The person requesting
the service for this meeting would then select AV equipment; then flipchart and whiteboard would be
typical options to add to the event. 

Note:
The following Category Types allow Production Items: Catering, Resources with Service
Orders, and Resources Without Service Orders.
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Furthermore, a Category can be configured to "Use States" so that when a service is requested with a
meeting, it can bemanaged through a review and approval process in theManage Services toolbar
option in EMS Desktop Client. 

See Also: Add Booking Details Wizard
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CHAPTER 65: View Your Events

Important!
The VIEW EVENTS option is different than the BROWSE EVENTS option in themain
menu. To learn more, seeMY EVENTS vs. BROWSE EVENTS.

You can quickly view your events, reservations, and requests on both your MY HOME page as well as your
MY EVENTS page.

1. Click My Events to see your reservations and bookings. The default view for My Events is dependent
on the configuration done by your EMS Administrator. This configuration is done in the EMS Desktop
Client through theMy Events Default View parameter. See Also: EMS Everyday User Applications
Parameters.

2. To view or edit a reservation, click the name of the reservation. See Also: Create a Reservation in the
EMS Web App.
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Note:
EMS only returns search results that contain the exact order of the characters in
your search string, but EMS does not care about if your search string is uppercase
or lowercase. In addition, EMS will return search results that contain your search
string regardless of where those characters appear. For example, a search string
of ed returns the College of Education Seminar, Ed Smith fundraiser, Health
Center Education Training, and so on.

Note:
The BROWSE > EVENTSmenu option shows all of your reservations, as well as all
reservations that you are authorized to view. TheMY EVENTSmenu option
shows the reservations you have created. It will not display reservations to which
you have been invited.

3. To view reservation and booking details, click on an event name. Event details display—bookings
within the reservation show in the lower half of the screen.
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CHAPTER 66: Search for Available Rooms
During the booking process, you can search for available rooms on the Room Request page in two
ways: Let Me Search For A Room or I Know What Room I Want.

To search for available rooms, do the following:

1. From the Create a Reservation screen, in the Bookings area, select one of the following: 

l Let Me Search For A Room
OR

l I Know What Room I Want
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Note:
Filters in the left panel help you narrow your Room Search Results. When you
click Search, results appear on the right. From these results, you can view
expanded Room Details by clicking on the room name, and you can view any
available floor plans by clicking the floor plan icon next to it.

You can click the Add/Remove buttons next to Locations, Floors, Setup Types,
and Features to add or expand your filters. To set Favorite Rooms to use every
time, see Set Favorite Rooms.

Locating space as part of the reservation process is different than browsing
locations. For detailed instructions on using the BROWSE LOCATIONS option in
themain menu to view available and booked space, see Browse Locations.

2. To filter your search by Location, click Add/Remove next to Location. This presents a list of locations
by Building or view. Select the locations filters you want to apply (or search by keyword), and then
click Update Locations. This filters the results of your keyword search on the Add New Favorite Room
dialog (above). Your filter settings are saved, and you will have to go back in and remove them if you
want to expand search results beyond these locations.
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3. Once you have located a room to reserve, click the Add (+) icon to add it to your reservation. This
adds the booking to your cart. You can change your mind and delete or change the room for the
booking before you finalize your reservation.
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CHAPTER 67: Book Multiple Rooms
During the reservation process, you can select more than one room (if the template you areusing permits
it).

1. Once you have found available rooms, click the Add (+) icon to move each room into the Selected
Rooms area. You can repeat this for each room you want to add to your reservation.

2. As you book each room, EMS will prompt you to enter attendees and setup type as follows:

a. Enter the headcount in theNo. of Attendees field.

b. Select a setup type from the Setup Type dropdown list.

c. Click the Add Room button to book the room.
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3. Click Next Step to continue with the booking process.
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CHAPTER 68: Book Recurring Meetings
This topic provides information on booking recurring meetings in the EMS Web App.

l Create a Reservation for Recurring Meetings

o Specify When and Where

o Specify Who and What

n Choose Services (Optional)

n EMS for Outlook® (Optional Capability)

o Finalize Reservation Details

Note:
For a conceptual overview, be sure to review the following topics:

l Ways to Make Reservations

l Reservations, Bookings, and Booking Details

Create a Reservation for Recurring Meetings

1. You can begin making a reservation by clicking the CREATE A RESERVATION option (on the left menu)
or the Book Now button next to one of your reservation templates (on the right).

2. Next, the Create a Reservation screen launches, where EMS Web App will lead you through the reser-
vation process.

3. Enter your information (including all required fields) and click the Next Step button to advance
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through the process.

Specify When and Where 

1. To specify When, select dates and times.

2. Click the Recurrence button.

a. Follow the prompts to select the frequency, date range, day of the week, start and end times,
and time zone for the recurrence.
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b. Click Apply Recurrence to validate your entries and return to the NewBooking screen.

Note:
Once booked, each meeting will show as a single Booking in your My
Bookings area on MY HOME. Also, note that the Create Booking In field
specifies the time zone in which to book themeeting, which might differ
from your system time zone.

3. To specify Where, in lower left panel, select one of the following: 

l Let Me Search For A Room
OR

l I Know What Room I Want
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Note:
Filters in this lower left panel help you narrow your Room Search Results. When
you click Search, results appear on the right. From these results, you can view
expanded Room Details by clicking on the room name.

Locating space as part of the reservation process is different than simply browsing
locations. For detailed instructions on using the BROWSE LOCATIONS options in
themain menu, see Search for Available Rooms.

4. Once you have located a room to reserve, click the Add (+) icon to validate and add the booking to
your cart. You can delete or change the room before you finalize your reservation.

Specify Who and What

1. In the Attendance area (near the center of the screen), select a Setup Type (if available) for the
reservation from the dropdown. 

2. Specify headcount and attendees in the Attendance area.

l If your organization has implemented EMS for Outlook, you use the optional Attendees section
to add or remove attendees and send them invitations or notifications. Attendees can be indi-
viduals or mailing lists or groups. To see who is in a mailing list or group, simply expand it. This
optional feature enables you to view attendees' availability and add or subtract them from the
event.
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l If your organization has not implemented EMS for Outlook, you will see a list of EMS Web App
users and groups but you will not see availability.

Note:
Adding attendees to an event is different than browsing people. For detailed
instructions on using the BROWSE PEOPLE option from themain menu, see
Locate People.

3. Once you have completed all required fields, click Next Step in the upper right corner.

Choose Services​ (Optional)
This is an optional feature based on the booking template you use. Services include room setup and
teardown, equipment, and any other services you want to associate with a room. Your Administrator sets
which services can be associated with a room and with an event type.

1. Under the Services tab in the Create Reservation screen, specify any services you want to associate
with the reservation, or click Skip Services. 

2. When complete, click Next Step in the upper-right corner. 

EMS for Outlook® (Optional Capability)
EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will
see the EMS add-in icon in your Outlook application. You will also see additional features and functionality
in EMS. Furthermore, anywhere that you see people or groups in EMS, you will have access to everyone in
your organization's email database (which is stored in Exchange Server). This means that you can see
people's availability (Out of Office, Busy, In a Meeting, etc.), send them email invitations or notices, and
add EMS events to your Outlook calendar.

Finalize Reservation Details 
The Reservation Details screen finalizes information about your reservation. Invitations to bookings and
attachments will be sent to all attendees. 

Complete all required information and click Save Reservation Details, and then Create Reservation.

Note:
To add the reservation to your Outlook calendar, click the Add this reservation to my
calendar checkbox at the bottom of the window.
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CHAPTER 69: Book a Video Conference Room
Typically, video conference bookings involve at least two Rooms: the "host" Room where themeeting host
user is located and at least onemore additional Room where other attendees gather to participate. If you
begin a Reservation or Booking using a video conferencing process template, you will be prompted during
the booking process to confirm which one of your Rooms is the Host. The first Room you select will be
automatically selected as the Host, but you can change the Host to a different Room once that additional
Room is selected. You can select only one Room per Building. You can also specify a different headcount for
each Room.

Note:
You might need to add multiple meeting Rooms, including the Host, to the Reservation.
If all participants including the host gather in the same Room, however, you will only
need one Room. Simply designate this sole Room as the Host.
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CHAPTER 70: Book a Desk or Workspace in the EMS Web App
This topic provides information on booking a desk or workspace in the EMS Web App.

l Create a Reservation for a Desk or Workspace

o Specify When and Where

o Specify Who and What

n EMS for Outlook (Optional Capability)

o Finalize Reservation Details

Note:
For a conceptual overview, be sure to review:

l Ways to Make Reservations

l Reservations, Bookings, and Booking Details

Create a Reservation for a Desk or Workspace

1. You can begin making a reservation by clicking the CREATE A RESERVATION option (on the left menu)
or the Book Now button next to one of your reservation templates (on the right).

2. Next, the Create a Reservation screen launches, where EMS Web App will lead you through the reser-
vation process.

3. Enter your information (including all required fields) and click the Next Step button to advance
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through the process.

Specify When and Where 

1. To specify When, select dates and times.

a. If you want to book space for multiple time slots, click the Recurrence button.

b. Follow the prompts to select the frequency, date range, day of the week, start and end times,
and time zone for the recurrence.
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c. Click Apply Recurrence to validate your entries and return to the NewBooking screen.

Note:
Once booked, each meeting will show as a single Booking in your My
Bookings area on MY HOME. Also, note that the Create Booking In field
specifies the time zone in which to book themeeting, which might differ
from your system time zone.

2. To specify Where, in lower left panel, select one of the following:

l Let Me Search For A Room
OR

l I Know What Room I Want
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Note:
Filters in this lower left panel help you narrow your Search Results. When you
click Search, results appear on the right. From these results, you can view
expanded Room Details by clicking on the room name.

Locating space as part of the reservation process is different than simply browsing
locations. For detailed instructions on using the BROWSE LOCATIONS option on
themain menu to see available and booked space, see Browse Locations.

3. Once you have located space to reserve, click the Add (+) icon to validate and add the booking to
your cart. You can delete or change the room before you finalize your reservation.

Specify Who and What
To specify the setup type and attendees for your reservation, do the following:

1. In the Attendance area (near the center of the screen), select a Setup Type (if available) for the
reservation from the dropdown. 

2. Specify headcount and attendees in the Attendance area. If you are the only attendee, you might be
able to skip this step.

l If your organization has implemented EMS for Outlook, you use the optional Attendees section
to add or remove attendees and send them invitations or notifications. Attendees can be indi-
viduals or mailing lists or groups. To see who is in a mailing list or group, simply expand it. This
optional feature enables you to view attendees' availability and add or subtract them from the
event.
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l If your organization has not implemented EMS for Outlook, you will see a list of EMS Web App
users and groups but you will not see availability.

3. Once you have completed all required fields, click Next Step in the upper right corner.

EMS for Outlook® (Optional Capability)
EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will
see the EMS plug-in icon in your Outlook application. You will also see additional features and functionality
in EMS. Further, anywhere that you see people or groups in EMS, you will have access to everyone in your
organization's email database (which is stored in Exchange Server). This means that you can see people's
availability (Out of Office, Busy, In a Meeting, etc.), send them email invitations or notices, and add EMS
events to your Outlook calendar.

See Also: Checking In

Finalize Reservation Details 
The Reservation Details screen finalizes information about your reservation. Invitations to bookings and
attachments will be sent to any attendee you invites. The example shown belowmight differ from your
implementation.

1. To browse existing events from BROWSE EVENTS, click on an event name. This shows Event Details in
a popup.
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2. Complete all required information and click Save Reservation Details and then click Create Reser-
vation.

Note:
To add the reservation to your Outlook calendar, click Add Event To Calendar at the
bottom of the window.
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CHAPTER 71: Add Reservation Details
If you open an existing reservation or create a new one, the Reservation Summary page opens. This area
enables you to modify bookings within a reservation, such as requesting services and adding attendees.
This topic provides information about the following:

l Reservation Details

l Reservation vs. Booking

o Reservations: Who and What

o Bookings: Where and When

n Booking Details

n Service Orders

l Reservation Tasks

l Attachments

l Bookings for the Reservation

Reservation Details
The Reservation Details option displays detailed summary information (the Reservation ID, the Event
Name, the Event Type, and so on) for the selected reservation and all its bookings as well as attendees and
any services that were requested for the bookings.
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Reservation vs. Booking
What's the difference between a "reservation" and a "booking?" A Reservation consists of one or more
Bookings. That's it.

Every booking belongs to a reservation. EMS lets you have multiple bookings under a single reservation.
When you havemultiple bookings in a reservation, each booking can be independent of the other, such as
reserving a set of rooms for an event, or can be a series of bookings under a Recurring reservation.

Each booking can contain multiple Booking Details, which are the resources and services required to
support the booking, such as catering and room setup.
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Reservations: Who and What
A reservation is the "who and what" of an event. For example, the Academic Planning Board (the who) can
reserve space for a Semester Kickoff event (the what). 

Bookings: Where and When
A booking is the "where and when" of an event. For example, the Academic Planning Board schedules the
conference room (the where) for a staff meeting on the second Monday in January (the when). The
Academic Planning Board now has a single reservation with a single booking in EMS. If, however, they
schedule the conference room (the where) for a staff meeting on the second Monday of each month for a
year (the when), then the board now has a single reservation with 12 bookings.
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Booking Details
A booking can have one or more booking details associated with it. Booking details are the resources
(items for themeeting) or services (people and their activities) that are needed for an event, the notes for
the event, the activities for the event, the room charges for the event, or any combination of these. For
example, for the Academic Planning Board’s staff meeting, the resources could include catering (coffee
service, bagels and muffins, and so on) and A/V equipment, plus the services of a person bringing in and
setting up a projector, moving a speaker’s podium, and so on).

Service Orders

System Administrators configure "buckets" of these details as "Categories," which streamlines the process
of adding details to bookings. 

Concept: Services, Categories, and Resources: What's the Difference? Click for more...
In EMS, you might hear these terms used interchangeably sometimes, however, they are different
concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture,
Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of
six Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources
Without Service Orders. These types cause the service to behave slightly differently when added to a
booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it, and there is nothing for a person to “select” from these types of
services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource
without a Service Order Category, will require the Administrator to create items under it. For example,
an "AV Equipment" service category (configured as a Resource without a Service Order Category type)
might have items under it such as a flip chart or whiteboard (under AV Equipment). The person requesting
the service for this meeting would then select AV equipment; then flipchart and whiteboard would be
typical options to add to the event. 

Note:
The following Category Types allow Production Items: Catering, Resources with Service
Orders, and Resources Without Service Orders.

Furthermore, a Category can be configured to "Use States" so that when a service is requested with a
meeting, it can bemanaged through a review and approval process in theManage Services toolbar
option in EMS Desktop Client. 

See Also: Add Booking Details Wizard
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Note:
You might be able to see floorplans for rooms. See Also: View Floor Plans.

Reservation Tasks
Use the Reservation Tasks area to take available actions on this event:

Reservation Task What You Can Do

Booking Tools

Cancel
Reservation

Cancel the reservation.

View Service
Availability

Opens a Service Availability windowwhere you can choose from allowable booking
templates to add services.

Send Invitation Sends invitations to recipients you specify.

Add to my
Calendar

Adds the reservation and all its bookings to your personal (Outlook) calendar.

Attachments
The Attachments tab is available if the reservation type required attachments. It provides the attachment
description, file name, and notes about the attachment. You can:

l Delete an attachment from a reservation or request.

l Attach another file to the reservation or request, click Attach File. A dialog box opens where you
can select the attachment. Allowed formats are .csv, .doc, .gif, .pdf, .txt, .xls, .xlsx, and .tif.

Bookings for the Reservation
The lower portion of the Reservation Summary page shows bookings for this reservation and (if you have
permissions) enables you to add another booking, edit or delete existing bookings, and take other actions
on those bookings.

Action Result

Cancel
Booking

Cancel selected bookings for the reservation.
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Action Result

Attendance Booking headcount.

Setup Type Setup Types are defined by your Administrator, and define which services, resources,
and room types can be used for the booking.

Status Stage in the booking process for the booking, such as Requested, Reserved, Pending. 
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CHAPTER 72: Add Services to a Meeting
To add services to an existing event, follow these steps:

1. Click on My Events and open the reservation you want to edit.

2. Click Add Services to add details to themeeting.

The Add Services option is only available if your Administrator allows services for this type ofmeeting
and for your user profile.
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Note:
Once you have added services and reserved space, you can work with
services by clicking Manage Services.

3. The first screen shows attendees and any existing services for themeeting and click on services you
want to add from the list of available options.
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4. When you click on a service to add, a pop-up screen might prompt you to specify a quantity for the
item and prompt you to add notes, special instructions, and so on. Click OK to save your changes.

5. The right panel of the Select Services window updates to show your latest additions. When you have
added all services for themeeting, click the Next Step button.

Accruent Confidential and Proprietary © 2019 Page | 232

CHAPTER 72: Add Services to a Meeting



6. The next screen lists all bookings within the reservation you selected from My Events. Select the
booking to which you want to add services (if the reservation includes multiple booking, they are all
listed here for you to select), and click the Add Services button.

7. You return to the Reservation page and a confirmation appears briefly confirming your changes.
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CHAPTER 73: Work with Services
This topic provides information on the following: 

l Services, Categories, and Resources

l Add Services to a NewReservation

l Change or Cancel Services for an Existing Reservation

Services, Categories, and Resources
In EMS, you may sometimes hear the terms Services, Categories, and Resources used interchangeably;
however, they are different concepts.

Categories
A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture,
Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six
Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources
Without Service Orders. These types cause the service to behave slightly differently when added to a
booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it and there is nothing for a person to “select” from these types of
services.

Service Category
By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource
without a Service Order Category, will require the Administrator to create items under it. For example, an
"AV Equipment" service category (configured as a Resource without a Service Order Category type)might
have items under it such as a flip chart or whiteboard (under AV Equipment). The person requesting the
service for this meeting would then select AV equipment; then flipchart and whiteboard would be typical
options to add to the event.

Note:
The following Category Types allow Production Items: Catering, Resources with Service
Orders, and Resources Without Service Orders.

Furthermore, a Category can be configured to "Use States" so that when a service is requested with a
meeting, it can bemanaged through a review and approval process in theManage Services toolbar
option in EMS Desktop Client. 
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Note:
If you are using the EMS Web App on a mobile device, you will not have access to this
feature. See Also: Categories, Resources, and Services: What's the Difference?

Add Services to a New Reservation

1. While creating a new reservation, navigate to the Services tab. The services your administrator has
defined as available for the booking template and room(s) you selected are listed on the left panel.

Note:
If you are editing an existing reservation, click the Add Services option in the
Reservation Tasks menu on the right, or open the Reservation Details and select
the Services tab.

2. Click the Services dropdown to expand and pick a service. You can add resources with service orders,
catering (food) services, resources without service orders, setup notes and/or a room charge. You
can add multiple services to a reservation and to a booking.
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Note:
Options available in the Services drop-down field depend on several factors
leading up to this stage in the booking process: your booking template
parameters, setup type, and other rules set by your System Administrator.

3. Enter the necessary information for the services you are adding to the reservation.

Note:
Required fields aremarked with red. You may need to add information such as
the start and end times, the estimated count, and so on. You may also have to
answer service-specific questions, and/or have to agree to Terms and Conditions.

Note:
You can add notes for each services you add to a reservation. These will only
appear if you open the booking, and not in the Booking Summary.

4. At the bottom of the page, click Next Step. The Available Services tab closes. You advance to the
Reservation Details tab.

l If the reservation has only this single booking, a confirmation message displays. Click OK to
close themessage and return to the Booking Details tab. The newly added booking detail
shows on the Existing Services tab.

l If the reservation has multiple bookings, then choose whether to add services to just the one
booking, or several:

o To add the services to only this booking, click Do Not Apply to Additional Bookings. You
remain on the Booking Details tab. The newly added services show on the Existing Ser-
vices tab.

o To add the services to one or more of the other bookings in the reservation, select them
(you can select all using the checkbox in the Date column heading), and then click Save. A
confirmation message displays. Click OK to close and return to the Booking Details tab.
The newly added services now show on the Existing Services tab.

Change or Cancel Services for an Existing Reservation
From an existing booking within one of your reservations, click theManage Services option (if available)
under the Bookings list. This enables you to change or cancel (delete) services for a booking, individually,
per service item, or by service category.
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On theManage Services page that presents, you can subtract (-) services from the Services Summary view
(if enabled). Services are listed in the right panel by category.
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Note:
The event type and the booking status (as well as your Administrator settings) affect
whether theManage Services option is available.
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CHAPTER 74: Cancel Your Reservations and Bookings
This section guides you to work with bookings in the Reservation Details page on EMS Web App, where you
can view, add, change, or cancel services and attendees for a booking. For an overview, see Add
Reservation Details. A reservation might contain multiple bookings, so the procedures below guide you in
applying your changes to more than one booking within a reservation.

This topic provides information on the following: 

l Cancel Reservations

l Cancel Bookings

Cancel Reservations

1. Navigate to the reservation with which you want to work: click MY EVENTS on themain EMS Web
App menu (or from theMy Bookings area on MY HOME). Then click on a Reservation. 

Note:
When you click to edit a Reservation or Booking, the page that opens depends
upon the type of booking that you are editing—a booking for reserving a room, a
booking for requesting a room, or a booking for services only.
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2. From the Reservation Details page, click Cancel Reservation. 

Important!
Canceling a reservation will also cancel all bookings under the reservation.

3. In the Cancel Reservation popup that appears, select a Cancel Reason, add Cancel Notes, and
then confirm that you want to cancel.
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4. Your MY EVENTS pages refreshes, and the reservation is canceled.

Cancel Bookings

1. From the Reservation Details page in the Bookings area, to cancel a single booking, click the date of
the booking or the Remove (-) icon next to the booking. These options are available if your admin-
istrator has given you permission.
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Note:
To cancelmultiple bookings, click Cancel Bookings in the upper corner of your
My Events list.

2. In the Cancel Booking popup that appears, select a Cancel Reason, add Cancel Notes, and
then confirm that you want to cancel.

3. Your MY EVENTS page refreshes and the booking is canceled.
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CHAPTER 75: Edit Reservations and Bookings
This section guides you in working with bookings in the Reservation Details page on EMS Web App, where
you can view, add, change, or cancel services and attendees for a booking. For an overview, see Add
Reservation Details. A reservation may contain multiple bookings, so the procedures below guide you in
applying your changes to more than one booking within a reservation. 

The process for editing reservations and bookings for Exchange-enabled templates and non-Exchange-
enabled templates are different. This topic includes the following information:

l Edit Reservations

l Edit Booking (Exchange-enabled Template)

l Edit Bookings (Non-Exchange-enabled Template)

Edit Reservations  
Concept: Reservations and Bookings: What Is the Difference? (Click to Expand)
A Reservation is the purpose of the event. In EMS, a reservation is the who (themeeting organizer) and the
what of an event. A Reservation contains one or more Bookings. For example, you (the who) can reserve
some space for a staff meeting (the what).

A Booking is the where and the when of an event. For example, you can schedule the large auditorium 
(the where) for a staff meeting on the second Monday in January (the when). There are one or more
Bookings in a Reservation. 

To edit a reservation:

1. To navigate to the reservation you want to edit, click My Events on the side bar of the Home page.

Use the My Events Link to Find Your Reservations

2. Click on the reservation name you want to edit.
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3. To edit reservation details, navigate to Reservation Details > Reservation Details tab.

4. Click the Edit Reservation Details link. 

Edit Reservation Details Page

5. Edit any available field. 

6. Click the Save Reservation Details buttons at either the bottom or top right hand of the page.

Note:
When you click to edit a Reservation or Booking, the page that opens depends upon
the type of booking that you are editing—a booking for reserving a room, a booking for
requesting a room, or a booking for services only.

Note:
If there is Additional Information (e.g., user-defined fields) associated with your
reservation, you can edit this information by navigating to the Additional Information
Tab from the Reservation Details page. Click the Edit Additional Information button.

Edit Booking (Exchange-enabled Template) 

Important!
Users are unable to edit the date and time from the Room Request screen. The date
and time can be edited from the Manage Bookings screen.
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1. From the Home page, navigate to the My Events page. 

2. Click on the Reservation Name for the reservation you want to edit.

3. Click Edit icon next to the booking you want to edit. The Manage Bookings page appears.

4. From theManage Bookings page, you can:

I. Edit/replace the room:

a. Click on the Edit icon next to the room to change the location. The user is routed to
the Room Request screen.

b. Click Search to display the list of available rooms.

Note:
In the example below, Demo Room 03 does not have an Add (+)
button because it was the original room for this booking.

Room Request Screen

c. To choose a room, click the Add (+) button.

d. Click Update Booking to save that location to your booking.

e. When the Manage Bookings screen appears, click Update Bookings again on this page. 

f. You will receive a prompt to Notify Attendees. Click eitherNotify Change (this will send a
calendar update to added or removed attendees), Notify All (this will send a calendar
update to ALL attendees), or Cancel. 

g. Changes are applied, attendees are notified, and the calendars of both attendees and the
organizer are updated.
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II. Edit the time/date of the booking:

a. Click on the reservation Name for the reservation you want to edit.

b. Click Edit icon next to the booking you want to edit. The Manage Bookings page appears.

c. Edit the Date & Time of the booking in the left-hand column.

d. If the room is available for this new time, click Update Bookings.

e. If the room is not available for the new time, either select a new time or edit the room for
the booking (see above).

III. Add an additional location to the same booking:

a. Click on the reservation name for the reservation you want to edit.

b. Click Edit icon next to the booking you want to edit. The Manage Bookings page appears.

c. Click Add Location. The Room Request screen appears.

Add Additional Location

Note:
All locations within the same booking will have the same Start and
End time.

d. Click Search to display the list of available rooms.

e. Select a room(s) using the Add (+) button.

f. Click Done. TheManage Bookings page appears.

g. Click Update Bookings.
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h. A prompt will appear to Notify Attendees. Click either Notify Change (this will send a cal-
endar update to added or removed attendees), Notify All (this will send a calendar
update to ALL attendees), or Cancel.

i. Changes are applied, attendees are notified, and the calendars of both attendees and the
organizer are updated. 

IV. Modify attendees in this booking:

a. Click on the reservation Name for the reservation you want to edit.

b. Click the Edit icon next to the booking you want to edit. The Manage Bookings page
appears.

c. Navigate to the Attendee section.

d. Type in the attendee name in the text field. The system will create a dropdown list of
names that match the search. 

e. Select a name. This attendee will be added to your booking.

f. Click Update Subject/Message and Notify Attendees.

g. Click either Notify Change (this will send a calendar update to added or removed
attendees), Notify All (this will send a calendar update to ALL attendees), or Cancel. 

h. Changes are applied, attendees are notified, and the calendars of both attendees and the
organizer are updated.

Edit Bookings (Non-Exchange-enabled Template) 
From the Reservation Details page in the Bookings area, you can edit one booking or multiple bookings.

Edit the Date and Time on a Single or on Multiple Bookings 

1. Click the Booking Tools link under the Reservation Tasks section on the right hand side of this page.
You can also edit the date and time on multiple bookings by clicking on the Booking Tools link under
the Bookings section. 
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Use the Reservation Tasks and Bookings Sections to Edit Multiple Bookings

2. Make any necessary edits.

3. Click Update Bookings.

Edit the Location and/or Date and Time on a Single Booking 

1. To navigate to the reservation you want to edit, click My Events on the side bar of the Home page.

2. Click on the reservation name you want to edit.

3. Under the Bookings section, click the Edit icon next to the booking. These options are available if you
have permissions.

Editing a Booking in the Bookings Section of My Events

4. The Room Request window appears, where you can make changes to the booking.

5. If needed, you can edit the date and time of the booking under the Date & Time section. 

Accruent Confidential and Proprietary © 2019 Page | 248

CHAPTER 75: Edit Reservations and Bookings



6. Search for a new location under the Locations section in the left-hand column.

7. Click the Add/Remove link to select by Buildings or Views. Choose a Building or View. Click Update
Locations.

8. In the Locations section, click Search.

Note:
Under the Let Me Search for a Room section in the left-hand column, you can
select filters to apply to your search (e.g., Floors, Room Types, etc.).

9. Click the Add (+) icon to change the room in your booking.

10. Click Update Booking to save the changed location.
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CHAPTER 76: Invite Attendees with Outlook
If your organization has deployed EMS for Microsoft Outlook, you can check attendees' availability as
shown in Outlook. EMS automatically sends meeting invitations to attendees when you make a reservation
in EMS Web App.

Note:
Because EMS Web App is highly configurable, options that we show in the following
proceduremay not be present in your organization's implementation of EMS. Also,
your organization may have customized some labels; for example, “group” may be
“client,” “employee,” or “department”; "event" may be “Meeting,” and so on. Required
fields aremarked with a red asterisk (*).

1. Begin creating a reservation.

2. When you select attendees, the Create a Reservation windowwill show their availability in a calendar
grid.

Note:
Depending on how your Administrator has configured EMS Web App templates,
you might see different fields displayed, or you might not see some of these fields
displayed at all.

3. Once you have completed the reservation and clicked Create Reservation, attendees will receive invit-
ations based on the booking template you used. Changes you may make to the event will also trigger
email updates.
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Example of an automatically generated email
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CHAPTER 77: Notifications in the EMS Web App
The EMS Web App automatically sends out notifications based on the filters on the notification rule.

There are five types of notification rules:

1. Bookings

2. Service Orders

3. Anything on a VIP Event

4. NewWeb Users

5. User-Defined Fields

These aremostly sent out a predefined amount of days prior to a booking. They are triggered when a
change occurs on a booking, service order, etc., within that range of days.

Confirmations
Confirmations are either sent out automatically after a booking is made in EMS Web App, or manually from
the EMS Desktop Client.

Confirmations contain the date/time/resources for the booking that was created. These usually go to end
users so they knowwhen their event is and if they owe any money.

Notifications for Event Changes
Your Administrator can automate alerts to be sent to you (or groups of which you are a member) when
changes or additions have been made in EMS for bookings and reservations, service orders, room types,
setup types, user accounts, and so on. When you create a reservation or booking that has these
notifications turned on, users will receive these alerts without requiring additional effort from you. Review
these notification settings during the process of creating or modifying events.

If your EMS Web App implementation uses the Integration with Exchange, you can handle notifications
using Outlook.

Integration to Microsoft® Exchange Enables You to Use Outlook®

If your organization deploys our Integration to Microsoft® Exchange, you can view the availability of
meeting rooms and attendees, and send Microsoft®Outlook®meeting invitations, all from within EMS Web
App.

You must be licensed for EMS Desktop Client, EMS Web App, and Integration to Microsoft® Exchange in
order to configure and use this capability. If you are unsure if your organization is licensed for Integration
to Microsoft® Exchange, or if you would like to learn more about it, please contact your EMS Account
Executive.
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CHAPTER 78: Personalize Your Account
TheMy Account menu enables you to customize your user profile:

l Specify delegates. Delegates are web users who can act as you in EMS Web App and carry out
actions on your behalf.

l Create your own, time-saving booking templates, which set default values (Start Time, End Time, and
so on) for your most frequent types of reservations and room requests. These templates appear on
your personal Home Page after you save them.

l Set a list of favorite rooms to streamline your search for available space.

TheMy Account menu is available in the upper right corner of EMS Web App next to your name once you
log in.

This section will provide information that will allow you to:

l Change Account Information

l Establish Delegates

l Establish Booking Templates

l Set Favorite Rooms
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CHAPTER 79: Change Account Information
Under My Account, you can change your email address, name, phone number, fax number, time zone, and
password.

Note:
You can also personalize your EMS experience by setting default values for your
templates and choosing favorite rooms. To further customize your EMS Web App
account, refer to the following topics: 

l Create Delegate Accounts

l Set Default Values for Room Requests and Reservations

l Create a List of Favorite Rooms

1. Under the dropdown arrow next to your name in the upper right corner of EMS Web App, click My
Account. 

The User Options page opens, showing tabs along the top where you can customize your user profile.
The Account Details tab contains basic account information.

Accruent Confidential and Proprietary © 2019 Page | 254

CHAPTER 79: Change Account Information



2. To modify your basic user account information:

l Modify any account information as needed—your email address, name, phone number, and so
on.

Note:
If you log into EMS Web App and then change your email address, keep in
mind that this new email address the one you must now use for logging in.

l If you want to change your password, enter a new password in theNew Password field, and
then enter the same password again in the Re-Enter New Password field. Lastly, enter your Cur-
rent Password.

l You can click the I do not want to receive emails from EMS option (if available) to opt out of
automatic emails from EMS Web App, such as reminders, reservation summaries (which EMS
sends when you submit your reservation), and notices (which EMS sends when you modify
your account).
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3. Click Save Changes.

4. To further customize your EMS Web App account, refer to the following topics:

l Create Delegate Accounts

l Set Default Values for Room Requests and Reservations

l Create a List of Favorite Rooms
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CHAPTER 80: Establish Delegates
You may want to designate another EMS Web App user to make reservations and room requests and so
forth on your behalf. You may need to do this, for example, to get someone else to handle your EMS work
during your absence.

You begin by adding one or more EMS users to act as your delegate. Then they can log in and request to
"Act As" you. You can keep track of their actions on your behalf, and any event invitations, cancellations,
changes, room requests, service requests, and so on that they create on your behalf will appear to other
EMS users as yours.

Concept: Delegates Act As You. Click for more...
A delegate is another authorized user who can act as you in EMS Web App and carry out actions on your
behalf. To delegate users, first you add them to your account as delegates under My Account. Then they
can use the Act As option and select your name.

Add Delegates to Act As You

1. Open theMy Account option from the upper-right corner of EMS Web App.
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2. Click theDelegates tab and add your delegates.
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For the EMS Web App User Who Will Act on Behalf of Another 

1. From theMy Account dropdown, click Act As.

2. In the Act As popup, select which user you will be acting as and click OK to confirm.

Once activated, the user you are acting as will show in the upper-right corner of the EMS Web App,
like this:
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CHAPTER 81: Establish Booking Templates
You can personalize booking templates to streamline your process for requesting rooms and making
reservations (depending on your permissions). These templates appear on your personal EMS Web App
home page after you save them.

Note:
For more information about how booking templates work, see Booking Templates,
Requests, and Reservations.

1. In the upper-right corner of EMS Web App, click on the dropdown next to your name and select My
Account. 

2. From theMy Account page, click Personalization and then click the Templates button.
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3. You can change the default values for a template only if your administrator has set your permissions
accordingly: select the template you want to change. The lower section changes to show options for
the selected template.

Note:
Essentially, your settings here automatically populate field values and filter search
results when you make room requests. For example, setting a Start Time here will
set a start time for any room request you make using this template, and setting a
Setup Type will filter search results to only show rooms with that setup type.
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Note:
If you select theOverride location and time zone settings when I search for
available space option under Locations, this means that whenever you book
using this template, you can change the default location for this template during
the booking process. For example, if your template Location was Denver and
during booking you added Kansas, the template would be updated to Kansas
going forward.

4. When you have finished making changes, click Save Changes.
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CHAPTER 82: Set Favorite Rooms
Under My Account, you can create a list of favorite rooms. This streamlines the process of searching for
available space when you request or reserve rooms. 

1. Under the dropdown arrow next to your name in the upper-right corner of EMS Web App, clickMy
Account. 

The User Options page opens, showing tabs along the top where you can customize your user profile.

2. Click the Favorite Rooms tab to work with a list of your favorite rooms. Any rooms you have already
saved as favorites are listed under Your Saved Favorite Rooms.

3. In the Search field, you can search for room you want to favorite (your search string is not case-sens-
itive but characters must be in the correct order). Enter your search string. The dropdown updates to
show results (taking into account your Location filters).
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Note:
You can filter your search results by clicking Filter by Location, which presents a
list of locations by Building or view. Select the locations filters you want to apply
(or search by keyword), and then click Update Locations. This filters the results of
your keyword search on the Add New Favorite Room dialog (above). Your filter
settings are saved, and you will have to go back in and remove them if you want
to expand search results beyond these locations.

4. To add a favorite to the list, select it from the search results. The room is added to Your Saved Favor-
ite Rooms. When you book a room in EMS Web App, you can now choosemore quickly from your
Favorites list.

Note:
Once you have established favorites, EMS Web App uses these to filter your
search results when you search for available space during the reservation
process.

To remove a favorite, click X next to the room in Your Saved Favorite Rooms.
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CHAPTER 83: Mobile Web App
EMS Web App is available both in a desktop client version and in a mobile version. If you access EMS Web
App from a mobile device, you are redirected to themobile version of EMS Web App.

l Use the EMS Web App on Mobile Devices

l EMS Mobile App Versus EMS MobileWeb App: What Is the Difference?
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CHAPTER 84: Use the EMS Web App on Mobile Devices
If you access EMS Web App from a mobile device such as a tablet or smartphone, the application will look
slightly different because of the limitations of the device. In general, drop-downs and menu bars will be
reduced or abbreviated, and you will need to click to expand some regions and scroll to view some
information. 
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Examples of the EMS Web App on a Mobile Device

Home Screen
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Mobile Menu
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Create Booking
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Edit Booking

Quick Tasks

Click on Home at any time to return to theMobile EMS Web App Home page.

Click on an event name to see details.

Click on New Booking to begin making a new booking.

Icons to Remember

Icons on theMobile EMS Web App Home Page

Icon Description

Main menu for navigating EMS Web App.

Click to change information.

Click to see a calendar view.

 /  Click to add or remove an item.

What Is the Difference?
In general, themobile display focuses on "doing" rather than "viewing." For example, you can easily book a
room or check in to a meeting, but exploring reservations with hundreds of intricate bookings or locations
with numerous rooms and setups might be best done using a non-mobile browser, due to the volume of
information you may want to see in one window.

Note:
To see "My Bookings" from anywhere in themobile version of EMS Web App, simply
click Home.

Accruent Confidential and Proprietary © 2019 Page | 275

CHAPTER 84: Use the EMS Web App on Mobile Devices



Functional Limitations
The following features of the EMS Web App on mobile devices are different than on a standard computer
web browser and have limited functionality due to the parameters ofmobile browsers and display area and
data limitations:

l Available rooms display in a list view; schedule and Floor Plan views are not available.

l The Services tab is not available.

l You cannot book multiple rooms in Microsoft Outlook.

l You cannot book video conferences.

l Themain menu is always hidden and accessible by clicking theMenu icon in the upper-left corner.

l You can only book one room per booking.

l The home screen only contains bookings and ability to search, and does not show the "Site Home"
tab.

l When creating a new reservation, you type the name of the desired room rather than searching by
keyword.

l To edit reservations on your My Events page, you tap the Edit icon next to the reservation.

l To see a room's schedule from the Browse Events page, click the grid icon next to the room name.

Note:
EMS also produces a mobile application for use on devices like smartphones.

See Also: EMS Mobile App Versus EMS MobileWeb App: What Is the Difference?
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CHAPTER 85: EMS Mobile App Versus EMS Mobile Web App:
What Is the Difference?
Although their names are similar and they share the same databases, these products have very different
applications. 

EMS Mobile App = EMS Application for Mobile Devices 
This is a separate software application EMS produces specifically to run on mobile devices, such as
smartphones.

Features of EMS Mobile App (Which are Not in EMS Web App)  

l Ultra-compact display designed for smartphones

l Two factor authentication method

l QR Code functionality

EMS Mobile Web App = EMS Web App on a Mobile Browser 
This is the EMS Web App as it displays when running on a web browser on a mobile device, such as a tablet. 

Features of EMS Web App (Which are Not in EMS Mobile App)  

l Browse Events

l Browse People

l Act As (delegation feature)

l Edit Account Details

l Edit Delegates

l Edit Everyday User Process templates
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CHAPTER 86: Learn About EMS Web App
l How do I search for available space? What if I only want to make a reservation if a specific room

is available?
Use the BROWSE options from the main menu. For more guidance, see Browse Events, Locations,
and People.

l Why can't I make a reservation?
Several settings control your capabilities as a user. For a deeper understanding, see Create a
Reservation in the EMS Web App.

l Why are some options not available to me?
This is probably because of settings controlled by your Administrator. For more detail about these
settings, see Understand Everyday User Templates.

l Can I let someone else make reservations on my behalf?
If enabled by your Administrator, you can delegate to other users. They will then opt to act as you
from their My Account menu.

l How do I check if a room I want is available? How do I check a person's availability when making
a reservation?
Start at the My Home page and Browse Events, Locations, and People. If you have Outlook, you can
view people's availability in a calendar view during the booking process.

l How do I add Services to a booking?
You can add them during the initial booking process or by editing it later. Services, Resources, and
Categories interact as part of the booking details for an event.

EMS Web App FAQs 

l Booking Templates, Requests, and Reservations

l Delegates Act as You

l My Events vs. Browse Events

l Notifications Automatically Alert People to Changes in EMS

l EMS for Outlook® (Optional Capability)

l Integration with Exchange Enables You to Use Outlook®

l Reservations, Bookings, and Booking Details

l Troubleshoot Internal Server Error When Viewing My Events in EMS Web App

l Understand Everyday User Templates

Accruent Confidential and Proprietary © 2019 Page | 278

CHAPTER 86: Learn About EMS Web App



CHAPTER 87: Booking Templates, Requests, and Reservations

Booking Templates 
Your Administrator creates different Booking Templates for different purposes. For example, your
Administrator could make one template for individual workspaces, another template for meeting rooms
without services like catering, and yet another template for meetings with services.

For each template, your Administrator can enable some fields and disable others. For example, your
Administrator could set up a "meeting room with services" template that requires you to enter a purchase
order number to pay for the services.

You can set up default values of the templates that are available to you so that you can more quickly make
your reservations. For example, if you book a workspace every day from 8:30 am to 4:30 pm, you can set
up these times as default values so that you don't have to enter them every time. (You can override them
anytime you need to.)

To set up default values for your templates, go to My Account and then to the Personalization tab.

Requests vs. Reservations
Depending on your permissions, you can Request a Room or Make a Reservation. Room requests require
approval from a supervisor and are visible to other users so they know the space has been tentatively
booked. The EMS Web App behaves differently for each type of user, showing fewer options (and usually,
less information) for those who can only request rooms.
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CHAPTER 88: Delegates Act As You

Delegate
A delegate is another authorized user who can act as you in EMS Web App and carry out actions on your
behalf. To delegate users, first you add them to your account as delegates under My Account. Then they
can use the Act As option and select your name.

See Establish Delegates for instructions on adding delegates to act as you.
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CHAPTER 89: MY EVENTS vs. BROWSE EVENTS

Important!
If you logging in and out as a guest, you will only have permissions to request
reservations, therefore theMY EVENTS option will not be available.

What is the Difference Between MY EVENTS and BROWSE EVENTS?
These two menu options on the left side of the EMS Web App enable you to accomplish different tasks:

MY EVENTS = Reservation Management
ClickingMy Events displays all reservations and bookings linked to your profile and enables you to manage
your reservations, change details, and create new bookings.

BROWSE EVENTS = Explore the Schedule
Clicking Browse > Events provides a view of events on the calendar for you and all users in your
organization. This view helps you locate available time slots for space before requesting or making a
reservation.
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CHAPTER 90: Notifications Automatically Alert People to
Changes in EMS
In EMS, changing events can automatically notify users. Your Administrator can automate alerts to be sent
to you (or groups of which you are a member) when changes or additions have been made in EMS for
bookings and reservations, service orders, room types, setup types, user accounts, and so on. When you
create a reservation or booking that has these notifications turned on, users will receive these alerts
without requiring additional effort from you. Be sure to review these notification settings during the
process of creating or modifying events.

If your EMS Web App implementation uses the Integration with Exchange, you can handle notifications
using Outlook®.

Accruent Confidential and Proprietary © 2019 Page | 282

CHAPTER 90: Notifications Automatically Alert People to Changes in EMS



CHAPTER 91: EMS for Outlook® (Optional Capability)
EMS for Outlook® is an optional (extra cost) purchase. If your organization has purchased it, then you will
see the EMS plug-in icon in your Outlook application. You will also see additional features and functionality
in EMS. Furthermore, anywhere that you see people or groups in EMS, you will have access to everyone in
your organization's email database (which is stored in Exchange Server). This means that you can see
people's availability (Out of Office, Busy, In a Meeting, etc.), send them email invitations or notices, and
add EMS events to your Outlook calendar.
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CHAPTER 92: Integration with Exchange Enables You to Use
Outlook®
If your organization deploys our Integration to Microsoft® Exchange, you can view the availability of
meeting rooms and attendees and send Microsoft®Outlook®meeting invitations, all from within EMS Web
App.

You must be licensed for EMS Desktop Client, EMS Web App, and Integration to Microsoft® Exchange to
configure and use this capability. If you are unsure if your organization is licensed for Integration to
Microsoft® Exchange, or if you would like to learn more about it, please contact your EMS Account
Executive.

See Also: Integration to Microsoft® Exchange Guide
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CHAPTER 93: Reservations, Bookings, and Booking Details
The two essential EMS components for meeting and event scheduling are reservations and bookings. To
use the EMS Web Client efficiently and effectively, you must understand the structure of a reservation in
EMS, the concept of an event timeline for a reservation booking, and how to make a reservation. This
section covers the following topics:

l Reservation Structure

l Event Timeline

l Make a Reservation Using the Reservation Wizard

l View and Edit Reservations in the Reservation Book

Reservation Structure
An event in EMS Desktop Client is comprised of the following:

1. A Reservation

2. One or more Bookings

3. Booking details

These three components exist in a hierarchy—a reservation contains one or more bookings, and each
booking can have one or more details associated with it.

Reservations
A reservation is the who and the what of an event. For example, Group X (the who) can reserve some space
for an Event Y (the what). A booking is the where and the when of an event. For example, Group X can
schedule the conference room (the where) for a staff meeting on the second Monday in January (the
when). Group X now has a single reservation with a single booking in EMS. If, however, Group X schedules
the conference room (the where) for a staff meeting on the second Monday of each month for a calendar
year (the when), then Group X now has a single reservation with twelve bookings in EMS.

Booking Details
A booking can have one or more booking details associated with it. Booking details are the resources or
services that are needed for an event, the notes for the event, the activities for the event, the room charges
for the event, or any combination of these. For example, for Group X’s staff meeting, the resources could
include the requested catering (coffee service, bagels and muffins, and so on) and the A/V equipment (a
projector, a speaker’s podium, and so on).
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Event Timeline
The following time designators are used for an event in EMS Desktop Client:

l Event Time: The time period during which the event actually takes place.

l Setup/Teardown Hours: The hours, or fractions of hours, that you add to the event time to allow
staff to prepare a room for the event or to clean up after the event.

l Reserved Time: The total time for which the space (the where) is reserved. This time is the event time
plus the setup/teardown time.

Variable  Time

Reserved Start Time 8:00 a.m.

Setup Hours 1 hour

Event Start Time 9:00 a.m. 

Event End Time 4:00 p.m.

Teardown Hours 1.5 hours

Reserved End Time 5:30 p.m.

Reserved Time 9.5 hours

Make a Reservation Using the Reservation Wizard
The Reservation Wizard allows you to check for available space and make a reservation for an event. You
can search for rooms that are available for a particular time on one day (a simple reservation with one
booking) or on multiple days (a series reservation with multiple bookings). You can also create a series
reservation by selecting one date and time, but multiple rooms. To make a reservation using the wizard,
you must do the following:

l Specify the Event Date and Time Information

l Specify the Event Time and Status

l Select the Event Location

l Specify the Event Information
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Note:
The following procedure describes how to make a reservation by selecting values for
the required and optional fields.

l If your EMS administrator has configured reservation wizard templates, then a
Reservation Wizard Template dropdown list is displayed at the top of the Reser-
vation Wizard. You can facilitate themaking of a reservation in the Reservation
Wizard by selecting the appropriate template from the list, which automatically
sets the default values for many of the fields in the Reservation Wizard.

l If your job entails making multiple reservations that require the same inform-
ation, and you are not using reservation wizard templates, then you can set your
own default values for many of the fields in the Reservation Wizard.

Specify the Event Date and Time Information

1. On the EMS Desktop Client toolbar, click the Wizard icon. The Reservation Wizard page opens.

2. If needed, use the scroll features on the top of the Calendar to open the calendar for a different
month (< or >), or click a month at the top of the calendar to open a dropdown list from which you
can select a different month. You can also click a year at the top of the calendar to open a dropdown
list from which you can select a different year.

3. If the event dates do not follow a pattern, use one or more of the following options for entering a
date:

l Click on the dates on the calendar that the event is to take place.

l To select all five weekdays in a week, click in the blank space that is to the left of the week.

l To select all seven days in a week, double-click in the blank space that is to the left of the week.

l To select every occurrence of a specific day of the week for the displayed month (for example,
all Sundays in June, 2017), click the heading (S, M, T, and so on) for the day.

l To select every occurrence of a specific day of the week that is currently displayed onscreen
(regardless if the day falls within the samemonth), double-click the heading (S, M, T, and so on)
for the day.

4. If the event dates do follow a pattern, (for example, the third Friday of every month), click Date Pat-
tern at the bottom of the Calendar to open the Date Pattern dialog box and enter your event date
information. As you specify the event dates, the following occurs:

l The Selected Dates tab at the top of the Calendar is automatically updated with the selected
dates.

l If your EMS administrator has configured any of the dates as a holiday or closed, then holiday
dates are displayed in green on the Calendar tab and closed dates are displayed in red. For any
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date, after you select the date on the Calendar tab, you can:

o Toggle between the Calendar tab and the Selected Date tab. Open the Selected Dates
tab, select the date, and then click Go To Date.

o You can remove a date from the list of selected dates by opening the Selected Dates tab,
selecting the date (or CTRL-click to select multiple dates), and clicking Remove.

l For dates that are configured as a holiday or as closed, you can:

o Place your cursor on a holiday date to open a tooltip that shows the name of the holiday.

o View information about the date from the Selected Dates tab. Open the Selected
Dates tab, scroll to the date, and then click Holidays to open a Holidays dialog box that
displays information about the holiday.

o Place your cursor on a closed date to open a message that states that you cannot select
the date because the date is closed.

5. Continue to specify the event time and status.

Specify the Event Time and Status

1. Specify the start time and end time for the event in one of two ways:

l Click the Time Picker icon to open a dropdown list from which you can select a time for each
field.

l Under the Time section, manually enter the start and end times from the dropdowns. If applic-
able, select the appropriate Time Zone for the event.

2. Specify the Setup and Teardown times in one of two ways:

l To use the default setup and teardown times that your EMS administrator has assigned to the
rooms in your system, leave the Use Default checkbox selected.

l Override the default setup/teardown times by clearing the Use Default checkbox, and
selecting Minutes or Hours, and entering your own setup and teardown times.

3. Indicate the status for the event.

4. Continue to select the event location. 

Select the Event Location
You have three options for selecting the event location, which are indicated on the first page of the
Reservation Wizard:
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1. Standard: Use this option to display a list of all the available rooms that meet all the requested dates. 

2. Best Fit: Use this option if no one room can meet all the requested dates. The system lists rooms
along with the number of bookings for which you can reserve the room. You can piece together the
entire reservation using Best Fit, or just part of it.

3. Specific Room: Use this option to confirm the availability and reserve of one specific room for the
scheduled event.

I. Search for a Standard Room

1. Select Standard.

2. Choose one of the following for room specifications:

l Type is the class or category of the room, for example a meeting room, a workspace, and so on.
Leave Type set to the default of (all) to search for all pre-configured room types or select a spe-
cific room type from the Type dropdown list.

l Floor is optional information when you are searching for a room. Leave Floor set to the default
value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown
list.

l Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or
theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured
setup types or select the setup type from the Setup Type dropdown list.

l Setup Count is the anticipated attendance for the event. If you selected a specific setup type,
then you must enter the setup count.

3. To select a Feature, open the Features tab, select the Feature, or CTRL-click to select themultiple fea-
tures that the room must have.

4. Click Next. Up to two tabs are displayed:

l The Available tab, which is the active tab and is always displayed, lists all the rooms that meet
all your event criteria.

o If you have elected to show the Available All Day Indicator, the rooms that are available all
day aremarked with an asterisk (*).

o By default, the available rooms are sorted alphabetically by room code. If your EMS
administrator has configured the rooms for your EMS implementation with a book
sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms
from lowest to highest book sequence. (If two rooms have the same sequence, then the
rooms are sorted alphabetically by namewithin the sequence.)

l The Conflicts tab is displayed only if there are rooms that are not available for the requested
dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not
available for scheduling as well as list of the events that are scheduled for each room.
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5. Select the room, or CTRL-click to select themultiple rooms that you are scheduling for the event.

6. Click Room Info to open the Room Info dialog box and view information about the room properties,
notes, Room URL, Building URL, setup type and capacity, and features. Click Close.

7. Click Building Hours to open the Building Hours dialog box which displays the hours that the selected
room/building is open on the reserved date. Click Close.

8. Click theMove button (>) to move the rooms to the Selected list.

9. Click Next to specify the event Information.

II. Search for a Best Fit Room

1. Select Best Fit.

2. Leave Building set to the default value of (all), or select a specific Building, Area, or View in which to
search for a best fit room.

3. Choose one of the following for room specifications:

l Type is the class or category of the room, for example a meeting room, a workspace, and so on.
Leave Type set to the default of (all) to search for all pre-configured room types or select a spe-
cific room type from the Type dropdown list.

l Floor is optional information when you are searching for a room. Leave Floor set to the default
value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown
list.

l Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or
theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured
setup types or select the setup type from the Setup Type dropdown list.

l Setup Count is the anticipated attendance for the event. If you selected a specific setup type,
then you must enter the setup count.

4. Open the Features tab, and then select the feature, or CTRL-click to select themultiple features that
the room must have.

5. Click Next. Up to two tabs are displayed:

l The Available tab, which is the active tab and is always displayed, has two lists. The list in the
left pane is a list of all the rooms that meet some or all of your event criteria. The list in the right
pane is a list of all the event dates that must be fulfilled.

l The Conflicts tab is displayed only if there are rooms that are not available for the requested
dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not avail-
able for scheduling for the event as well as list of the events that are scheduled for each room.
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6. Choose one or both of the following:

l Click Room Info to open the Room Info dialog box and view information about the room prop-
erties, notes, Room URL, Building URL, setup type and capacity, and features. Click Close.

l Click Building Hours to open the Building Hours dialog box which displays the hours that the
selected room/building is open on the reserved date. Click Close.

7. Choose one of the following:

l If one is available, select the single room that is available for all the requested dates, and then
click theMove button (>) to move the room to the Event Dates list.

l If a single room is not available, select a room that is available for some of your requested
dates, and then click theMove button (>) to move the room to the Event Dates list. Repeat this
step as needed to fulfill all the event dates.

8. Click Next to specify the event information.

III. Search for a Specific Room
You can use the Specific Room search to book a standard EMS room or a room or area that is not
managed in EMS. An override room, or “override description,” is used to book an event in a space that has
not been configured in your EMS system. For example, your EMS administrator might have configured an
override room named “Other Area” in the Engineering building. To book an event in Dr. Wilson's office,
which is a room that is not defined in EMS, in the Engineering building, you can select the “Other Area”
room and specify “Dr. Wilson's Office” for the location. EMS does not track availability for events booked in
override rooms; however, EMS reports on events that are scheduled in an override room just like any
other event scheduled for any other room.

1. Select Specific Room. The Room Selector dialog box opens. By default, (all) buildings is selected.

2. Do one of the following:

l To select a room from a list of all rooms in all available buildings:

o Leave (all) selected on the Buildings dropdown list.

o Click the Add icon next to a room to select it.

o If the room is configured as an override room, continue to the next step.

l To select a room from a list of rooms in a specific building, area, or view:

o Select a specific building, area, or view.

o Click the Add icon next to a room to select it.

o If the room is configured as an override room, continue to the next step:

n In the Location field, enter the location of the override room, and then
click Next. Two results are possible:
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n If the event is scheduled for a single date and the room is available, then con-
tinue to the next step. 

n In all other cases, (for example, the event is scheduled for a single date but
the room is not available or it is a multiple date event), the Available tab
opens. This tab lists all the event dates for which the specific room is available. 

3. Optionally, before you move a date to the Selected list, click Building Hours to open the Building
Hours dialog box which displays the hours that the selected room/building is open on the selected
date. 

4. Optionally, before you move a date to the Selected list, do one or both of the following:

l Click Room Info to open the Room Info dialog box and view information about the room prop-
erties, setup type, features, and pricing.

l Click Building Hours to open the Building Hours dialog box which displays the hours that the
selected room/building is open on the reserved date.

5. Do one of the following:

l If the specific room is available for all the event dates, then click the Move All button (>>) to
schedule the room for all the event dates.

l If the specific room is not available, try another approach, such as reserving a different specific
room, or try using the Standard or Best Fit search method.

6. Click Next.

Specify the Event Information
After you select an event location(s), you must specify other information for the event.

1. Enter the event information.

Field Description

Event

Event Name A name or description for the event.

Event Type The classification for the event.

VIP Event Select this option to mark the event as a Very Important event.

Source The reservation source.

Video
Conference

Select this option for a video conference event.
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Field Description

Employee/Contact 

Employee Click the Search icon to open an Employees dialog box in which you search for and
select a specific employee from a list all employees that are available in your system for
hosting/sponsoring an event.

l To search a list of all employees, leave the Find field in the Lookup dialog box
blank, and then click the Search icon

l To search for a specific employee, enter a search string in the Find field, and then
click Search icon. Your search is limited to the exact order of the characters in the
string, but the string can appear anywhere in the search results and it is not case-
sensitive. For example, the search string sim returns Paske, Simon and Siming-
ton, Chance.

l To select an employee, click the Add icon next to the employee.

l If the employee that you want to select for the reservation is not available on the
pre-configured list, then you can click the Employee icon to open the Employee
dialog box and add the employee.

Note:
After you select an employee, you can click Employee Info at the
bottom of the Reservation Wizard page to open a dialog box that
displays the properties for the employee, any user-defined fields
for the employee, and any comments that are associated with the
employee.

1st Contact
Temp
Contact

When you select a group, if a default contact has been defined for the group, then this
field is automatically populated with the name of the contact; otherwise, the field is
blank. You have several options for defining the 1st Contact for a reservation:

l If the field is blank, but contacts have been configured for the group, you can
select a contact from the pre-configured list.

l If the field is populated with a default value, but other contacts have been con-
figured for the group, you can select a different contact from the pre-configured
list.

l If you want to create a temporary contact just for this event, then select (tem-
porary contact), and in the Temp Contact field, enter the name for the temporary
contact.
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Field Description

Note:
If a default contact has been configured for the employee, then
any modifications that you make for the contact apply to this
reservation only. The next time you or anyone else creates a
reservation for this group, the 1st Contact field is again
automatically populated with the name of the default contact.

2nd Contact
Temp
Contact

Define if necessary for the event.

Phone
Fax
Email
Address

Onemore of these fields might be automatically populated depending on how a
selected contact has been configured. You can manually edit these values if needed.

Note:
The Phone and Fax fields have a dropdown list available on which
you can select a different value (Cellular, Fax, Office, Other,
Primary) for the field label, or you can enter a user-defined value.
To enter a user-defined value, double-click the current field label
to select it, and then enter the user-defined value over the
selected label.

Note:
If default values have been configured for a selected contact, then
any modifications that you make apply to this reservation only.
The next time you or anyone else creates a reservation for the
same contact, these fields are again automatically populated with
the default information.

Room Setup Tab

Setup Type If you selected a specific value for the setup type when searching for an event location,
this value is carried forward to this field; otherwise, the field is blank. You can select a
setup type for this field, or if the field is already populated, you can select a different
setup type.

Setup If you entered a specific value for the setup type when searching for an event location,
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Field Description

Count this value is carried forward to this field; otherwise, the field is blank. You can enter a
value in this field, or if the field is populated, modify the value.

Billing Tab

Note: Depending on the group that you select, one or
more of these fields might be automatically populated
with default values. You can edit these default values but
any modifications that you make apply to this reser-
vation only. The next time you or anyone else creates a
reservation for the same group, these fields are again
automatically populated with the default billing inform-
ation.

Pricing Plan Indicates what type of pricing is to be used for the event.

Cost Center
Number

The internal alphanumeric billing code that is associated with the group. You can
manually enter a value in this field, or if a master list of billing reference numbers has
been configured for the group, you can click the Search icon to open a Cost Center
Numbers dialog box, and select the appropriate value from this list.

Note:
To search for a specific cost center number, enter a search string
in the Find field, and then click the Search icon. The string is not
case-sensitive, but your search is limited to the exact order of
characters in the string and it must begin with the information for
which you are searching. For example, a string of co returns CO-
123, but not 123-CO.

Sales
Category

How the group is sorted for purposes of tracking sales figures (e.g., local, regional,
national, etc.).

Payment
Type

Indicates how the group paid for the event (cash, check, charged, and so on).

Dept.
Code/PO
Number

The internal alphanumeric purchase order number that is associated with the group.
You can manually enter a value in this field, or if a master list of purchase order
numbers has been configured for the group, you can click the Search icon to open a
Purchase Order Numbers dialog box, and select the appropriate value from this list.
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Field Description

Note:
To search for a specific purchase number, enter a search string in
the Find field, and then click the Search icon. The string is not case
sensitive, but your search is limited to the exact order of
characters in the string and it must begin with the information for
which you are searching. For example, a string of co returns CO-
123, but not 123-CO.

Salesperson The user who “sold” the event.

Other Tab

Event
Coordinator

The Event Coordinator assigned to the event.

Estimated
Event
Attendance

The estimated number of people who are expected to attend the event.

Calendar
Style

Drop-down list of all the available formats for printing this event on the Event Calendar
and Event Schedule reports.

URL The event URL.

Virtual Tab

Everyday
User

l To specify the everyday users who can view/manage this reservation in VEMS,
click the Search icon to open the Everyday Users search dialog box and search
from a list of registered everyday users.

l You can search by User Name or Email Address

l To search a list of all available everyday users, leave the Find field in the Lookup
dialog box blank, and then click the Search icon

l To search for a specific everyday user, enter a search string in the Find field, and
then click Search icon
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Field Description

Note:
The string is not case-sensitive, but your search is limited to
the exact order of characters in the string and it must begin
with the information for which you are searching. For
example, if searching by Email Address, a search string
of 
bb
 returns bbosworth@dea.com but not dbobbett@dea.com.

l To select an everyday user, click the Add icon next to the user.

Note:
To return this field to the (no change) value at any time,
click Reset.

Process
Template

The process template that defines the functions that are available for the selected
everyday user.

Note:
An Everyday User might be assigned to more than one process
template, so make sure to select the template that is applicable
for this reservation.

User Defined Fields Tab

User-defined fields are additional fields that store custom data for a reservation. Your
EMS administrator configures the types of fields that are available as well as the allowed
values for these fields.

l To enter or modify a value for a field, select the field, and then click Set Value.

l To clear a value for a field, select the field, and then click Clear Value.

Note:
If a user-defined field is not required here, you can always supply
a value for it at a later date in the Navigator.
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2. Click Finish. Two results are possible:

a. If you did not enter information into required fields, then these fields are outlined in red. You
must enter values into these fields and then click Finish again to open the Navigator page.

b. The Navigator opens. The reservation information is displayed in the Navigator. You use the
Navigator to add booking details and to make any needed modifications to the reservation and
its bookings. 

Important!
A reservation is not complete and rooms are not removed from the Available list until
you click Finish. Although unlikely, it is possible for another user to select and reserve a
room during the time period after you have selected the room but before you have
finalized the reservation. If this occurs, after you click Finish, a message opens stating
that your reservation conflicts with an existing reservation.

View and Edit Reservations in the Reservation Book
The Reservation Book provides a graphical view of all the confirmed reservations (the reserved time as well
as the room for which the reservation is scheduled) for your organization. (Canceled bookings are not
shown.) You use the Reservation Book to the view information for a reservation, to edit an existing
reservation, and to make a new reservation. In addition, when the Reservation Book first opens, before
you edit or make a reservation, you can change the Reservation Book view so that it better suits your
working needs.

This section will provide information on the following topics:

l Open the Reservation Book

l Change the Reservation Book Display

l View Reservation Information

l Make a NewReservation

l Edit an Existing Reservation

Open the Reservation Book

1. From the toolbar, click the Book icon. The first time that you open the Reservation Book for your
EMS implementation, by default, the Filter dialog box opens on top of a blank Reservation Book. You
can leave the room filtering criteria set to their default values, or you can select different values as
needed, and then click OK. All reservations that meet the filtering criteria and that are scheduled for
the current day’s date are displayed in the book in the Daily view.
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Note:
You might need to use the book’s scroll features to scroll through all the
reservations that are scheduled for the current day’s date.

l If an event is scheduled for a room that is a component of a combination room, then the reser-
vation text is displayed in black. A duplicate reservation is also shown for the combination
room; however, the reservation text is displayed in gray to indicate that a component of the
combination room is currently booked for the indicated time and therefore, the combination
room is not available

l Conversely, if an event is scheduled for a combination room, then the reservation text for the
combination room is displayed in black and the reservation text for each component is dis-
played in gray. This reversed color coding indicates that the component room is currently
booked for the selected time and that none of the components is available.

Note:
The Reservation Book has the following appearance:

o Minimum and maximum capacities are displayed next to room
descriptions

o The current time is shown by a vertical line in the grid, called the Cur-
rent Time Indicator

o If building hours have been configured for a building, then this inform-
ation is displayed for the building

The reservations are displayed with three components:

o A left bar that indicates the setup time

o Amiddle bar that indicates, by default, the event name

o A right bar that indicates the teardown time

Change the Reservation Book Display

1. On the EMS Web Client toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. You can change the Reservation Book display in the following ways:

l Change the list of rooms that are displayed in the Reservation Book based on room
properties.

l Change the list of rooms that are displayed in the Reservation Book based on a specific room
(s).
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l Change the Reservation Book view.

l Changemultiple display options for a reservation.

l Select which items to include in the tooltip that opens when you place the cursor over an event
in the Reservation Book.

l Change the display date using the calendar.

l Change the display date using the Reservation Book scroll features.

3. To change the list of rooms based on room properties:

a. Click Filter if the Filter dialog box is not already open.

b. Select Room Properties and customize one or more of the following:

l Leave the Building dropdown list set to the default value of (all) buildings, or select a spe-
cific building, area, or view.

l Select a specific floor.

l Select a specific room type.

l Select Capacity and then enter a capacity.

l Select Academic to limit the search to academic rooms.

l Select a Room Availability option.

c. Click OK. The Filter Rooms dialog box closes. The room display in the Reservation Book is
changed accordingly.

4. To change the list of rooms that are displayed in the Reservation Book based on a specific room or
rooms:

a. If the Filter Rooms dialog box is not already open, then above the Rooms list, click Filter to
open the dialog box and select Specific Room.

b. Select the room, or CTRL-click to select multiple rooms on the Available list.

c. Click the Move (>) button to move the selected rooms to the Selected list. The Reservation
Book is updated to show bookings only for the selected rooms.

5. To change the Reservation Book view, from the View dropdown list, select Daily, Weekly, or Monthly.

6. To changemultiple display options for a reservation:

a. Click Options (upper right hand corner of Reservation Book) to open the Book Options dialog
box (the General tab is the active tab).

b. Changemultiple display options not only for the Reservation Book, but also a reservation in the
book.
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Option Description

Start Hour The daily start time for the Reservation Book display.

Display The information that is displayed in themiddle bar for a reservation.

Time
Display
Interval

Changes the granularity of the time display interval.

Maximum
Number
of Rooms

Themaximum number of rooms to display in the Reservation Book.

Booking
Colors
Based On

The color of the bookings in the reservation. Select one: Status, Event Type, or Check-in
Status (for EMS Workplace only.)

Rooms
Without
Bookings

Whether to highlight rooms without bookings and if so, the highlight color. If both
Highlight Rooms and Booked Space Status Only are selected, then only those rooms that
do not have a Booked Space status are highlighted.

Room
Display

Display the room code or the room name for a reservation.

Building
Display

Display the building code or the building name for a reservation.

Go To
Today on
Startup

If selected, the Reservation Book opens to the current day’s date; otherwise, it opens to
the last date viewed.

Always
Prompt
for Room
Filter on
Startup

If Show ‘(all)’ in Building List is also selected, then when you open the Reservation Book,
the Filter dialog box opens on top of the Reservation Book. You can select different
options on this dialog box to display only specific reservations in the book, for example,
bookings only for selected rooms. If you do not select any options on this dialog box, but
instead simply close it, then all reservations for all rooms in all buildings are displayed in
the book.

Hide
Current
Time
Indicator

Show or hide the vertical bar that indicates the current time for current day.
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Option Description

Note:
The Current Time indicator is displayed only if the view is the Daily
or Weekly view and the view includes the current day’s date.

Show
‘(all)’ in
Building
List

Show the “all” option on the Building dropdown list; otherwise, a user must select a
specific building. If this option is selected in conjunction with Always Prompt for Room
Filter on Startup, then when you open the Reservation Book, then the Filter dialog box
always opens on top of the Reservation Book. If you are setting your Reservation Book
options, and you do not want to the Filter dialog box to open on top of the Reservation
Book when you open the book, then do the following:

l Clear Always Prompt for Room Filter on Startup.

l Clear Show (‘all’) in Building List.

l On the Building dropdown list in the Reservation Book, select any building, area, or
view.

Note:
The building, area, or view that you select is not important. This last
step just clears the “all” building option from the Reservation Book
cache and ensures that the Filter dialog box does not open on top
of the Reservation Book. Going forward, you can always select all
buildings, or any specific building, area, or view as needed when
you are working in the Reservation Book.

Show
Capacity

Show theminimum and maximum capacities next to the room description.

Hide
Booking
Shadow

Hide the vertical shadow bar that highlights the reserved and/or event start times and
end times when a user moves a booking in the Reservation Book.

7. To select which items to include in the tooltip that opens when you place the cursor over an event in
the Reservation Book:

a. Click Options (upper-right corner of Reservation Book) to open the Book Options dialog box. 

b. Open the Tooltip Display tab and select which items to include in the tooltip that opens when
you rest themouse pointer on an event in the Reservation Book.
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8. To change the display date using the calendar: 

a. From the Date field, click the dropdown arrow to open the Calendar.

b. Use the (< and >) scroll features at the top of the calendar to change themonth or use the (>)
scroll features at the top of the calendar to change the year.

c. To select a different date for a month, click the date.

9. To change the display date using the Reservation Book scroll features:

a. Use the scroll features at the top of the reservation book display to scroll to a different day,
week, month, or any different combination of these.

b. To reset the display immediately to the current day’s date, click Today.

View Reservation Information

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. To view the reservation in the Navigator, double-click themiddle bar for the reservation entry or
right-click the reservation entry and on the context menu that opens, click Open.

3. You can view the reservation information in the following ways:

l View the bookings for a room

l View the properties for a room

l View the pricing for a booked room

l View the setup information, event information, or teardown information for a reservation

4. To view the bookings for a room:

a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dia-
log box. The tab on this dialog box lists all the bookings for the selected room based on the cur-
rent view (Daily, Weekly, Monthly) and on the date that is shown in the Date field.

b. To view a booking in the Navigator, select the booking, and then click Open.

5. To view room properties:

a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dia-
log box.

b. Open the Room tab. The tab on this dialog box lists all the properties for the room, such as the
room code, the room name, the room classification, etc. It also lists the setup type and capacity
for the room, and any notes that have been entered for the room.
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6. To view the pricing for a booked room:

a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dia-
log box.

b. Open the Pricing tab. This tab displays any pricing information that was defined for the room.

7. To view the room setup information, event information, or teardown information for a reservation:

a. Rest themouse pointer on the left bar, middle bar, or right bar for the reservation entry. A tool-
tip showing the respective setup, event, or teardown information opens.

b. If buildings that are located in multiple time zones are currently displayed, you can specify the
time zone in which to view all of your bookings.

Make a New Reservation

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. Change the display to show the room for which you aremaking the reservation.

3. Select the date for which you aremaking the reservation.

4. In the Time Grid for the room, click and hold the left mouse button, drag themouse to schedule the
room and time, and then release themouse button to open the Reservation Wizard. See Also: Make
a Reservation Using the Reservation Wizard. 

Edit an Existing Reservation

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. Optionally, you can do one or more of the following to edit an existing reservation:

Step Action

Change the setup time for a
reservation

l Drag the left bar horizontally to a new time.

l Click Yes in the Confirm Change dialog box.

Change the event time l Drag themiddle bar horizontally to a new time.

l Click Yes in the Confirm Change dialog box.

Change the teardown time
for a reservation

l Drag the right bar horizontally to a new time.

l Click Yes in the Confirm Change dialog box.

Edit the reservation
building, room, time, or

l Drag and drop the reservation to a new room that is the same
building or in a different building, and/or to a new time.
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Step Action

both l Click Yes in the Confirm Change dialog box.

3. Optionally, you can right-click on a reservation in the Reservation Book, and on the context menu
that opens, select one of the following:

Option Description

Open Opens a reservation in the EMS Navigator.

Move Forward Move the reservation date forward by one day or one week.

Move Backward Move the reservation date backward by one day or one week.

Move to a Specific
Date

Move the reservation to a specific date.

Change Status Change the status of the reservation.

Copy Bookings N/A

Note:
Although this option is available on the context menu for
a reservation, its associated functionality is currently
under development.

Swap Rooms With
Another Booking

Swap the room assignments of two events. The swap option is applicable only
for two events that have identical meeting patterns.

Highlight Related
Reservations

Highlights the bookings that belong to the same reservation.
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CHAPTER 94: Troubleshoot an Internal Server Error When View-
ing My Events in EMS Web App
If you are getting an internal server error when trying to view existing bookings through the “My Events”
page in EMS Web App and there are a large amount of bookings under your name, this is because the
number of records returned exceeds the number allowed by the IIS web app configuration. Themaximum
is set to 50,000 by default.

Workaround: You or your System Administrator can increase this limit by editing the web.config file. The
configuration attribute to look for is the following:

<add key="aspnet:MaxJsonDeserializerMembers" value="50000" />

Change the value to themaximum number of bookings you expect users to have.

Note:
EMS Cloud Customers:Modifications to the web.config file must be performed by EMS
Cloud Operations. To request these changes, please contact EMS Support.

Accruent Confidential and Proprietary © 2019 Page | 306

CHAPTER 94: Troubleshoot an Internal Server Error When Viewing My Events in EMS Web App



CHAPTER 95: Understand Everyday User Templates

Why Are Some Features in EMS Unavailable to Me? Why Can't I Book a
Room? 
Your Administrator controls what you are able to do and view in EMS using "everyday user templates"
based on your user profile. The options and information you can see in EMS depends on your security
access, user type, and many other administrative controls. 

Additionally, your capabilities are also controlled by your "booking templates" and permissions. To learn
more about these settings, see Create a Reservation in the EMS Web App.

Note:
If you have previously used older versions of EMS, you may know these templates as
"Web Process Templates." These templates are now called "Everyday User Process
Templates."

See Also: Configure Everyday User Templates.

Accruent Confidential and Proprietary © 2019 Page | 307

CHAPTER 95: Understand Everyday User Templates



CHAPTER 96: Skype for Business in the EMS Web App
Everyday Users can now integrate audio/video conferencing tools with EMS applications, starting with
Skype for Business. The EMS integration of Skype for Business allows users to easily integrate instant
messaging and audio/video conferencing to their meetings without the need for A/V support. 

Important!
When considering using the Skype for Business Integration, keep in mind the following: 

l Skype for Business is ONLY available on Exchange-enabled templates.

l Users cannot edit or remove Skype for Business meetings from their reser-
vations. Users can delete the link, but the Join link will remain enabled. 

For more information about Configuring Skype for Business, see Configure Skype for
Business.

This topic provides information about the following:

l Add Skype for Business to Your Reservation

l Join a Skype for Business Meeting from the EMS Web App

Add Skype for Business to Your Reservation
There aremultiple ways to add or remove Skype for Business to your reservation. 

1. Open and log into the EMS Web App. 

2. Begin creating your reservation. 

3. You will see an Add Skype to Reservation toggle on both the Room & Attendees and Reservation
Details tabs. From either of these tabs, click the Add Skype to Reservation toggle to add Skype for
Business to your reservation.  

4. If this is your first time adding a Skype for Business meeting in theWeb App, a Skype authentication
dialog box will appear. Click Continue to Login.
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Skype Authentication Dialog

5. In the new browser window, enter your email address and password to authenticate your Skype for
Business account.

l  If your Skype account is authenticated, you can continue creating your reservation.

l  If your Skype account is not authenticated, an authentication modal will appear.

l  If you fail to authenticate your Skype account, the Skype toggle will be disabled.

6. Once the Add Skype to Reservation toggle is set to On, a confirmation will appear at the top of the
screen indicating that Skype information will be added once you've completed your reservation.
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Skype Confirmation Message

Note:
The user who created themeeting will be able to view the Skype for Business
meeting details (including Skypemeeting link and call-in information) from the
Browse Events, Browse Locations, and Browse People screens.

Once you have added Skype to your reservation, themeeting attendees will
receive an email notification including the Join Skype link and call-in information.

7. To remove Skype for Business from your meeting, set the Add Skype to Reservation toggle to Off
from either the Room & Attendees tab or Reservation Details tab. Amessage will appear at the top of
the screen, confirming that Skype information has been removed from your reservation.

Join a Skype for Business Meeting from the EMS Web App

Note:
You can join a Skype for Business meeting that has been added to your reservation
from multiple places in the EMS Web App:

l View Reservation

l My Booking Details page
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1. FromMy Events, navigate to the Reservation Tasks column on the Reservation Details tab. Click the
Join Skype icon to launch your Skype for Business meeting.

Join Skype from Reservation Details Tab

2. From the Booking Details page, navigate to the Event Details tab. At the bottom of the Event Details
tab, click the Join Skype button to instantly launch your Skype for Business meeting.
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Join Skype from Event Details Tab

For more information regarding using Skype for Business in other EMS access points, see also: 

l Skype for Business in EMS Mobile App

l Skype for Business in EMS for Microsoft Outlook

For more information regarding features of Skype for Business, refer to theMicrosoft Skype for Business
User Guide.
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